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Chapter 1 Introduction

1.1  About the Taurus
The Taurus Portable Seismograph is a compact, self-contained digitizer and data logger 
that combines exceptional performance with versatility and low power consumption. 
The Taurus can be used either as a stand-alone time-series data logger or as a compo-
nent in a data acquisition network. Taurus incorporates a three-channel 24-bit Digitizer, 
GPS receiver and System Clock, removable data storage, and remote communication 
options. Taurus is configurable locally using the colour display screen and integrated 
browser or remotely using any web browser over a TCP/IP connection.

Taurus is equipped with three 24-bit data channels. Time-series data are stored in Steim 
(1) format, and can be extracted to MiniSEED, Seisan, or ASCII format, and streamed 
in Nanometrics NP format. Taurus supports 10/100Base-T Ethernet and serial inter-
faces. Communication protocols include UDP/IP, TCP/IP, SLIP, PPP, and HTTP.

As a portable unit, Taurus can be deployed to record continuous data for extended peri-
ods of time. For example, when recording 3 channels at 100sps, up to 600 days of data 
can be recorded using a 40GB 1.8” hard disk drive. A CompactFlash card may also be 
used as an alternative to a hard drive, for example to use at more extreme temperatures 
or altitudes, or to realize optimal power consumption. Media are removable for easy 
data retrieval from the field. The extensive storage combined with low power consump-
tion make the Taurus ideal for long term unattended data acquisition.

1.2  About this User Guide
Note Please refer also to the release notes for the version of firmware you have 

installed on your Taurus.

This User Guide provides quick setup and installation information, procedures for 
operating and configuring the Taurus, and reference information:

Part 1 “Getting Started” provides an overview of setting up the Taurus, and general pro-
cedures for operating the Taurus:

Chapter 1 “Introduction”
Chapter 2 “Quick Start” – An overview of basic procedures and installation.
Chapter 3 “Operating and Maintaining Taurus” – General instructions for operat-
ing the Taurus.
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Chapter 1: Introduction
Part 2 “Using the Taurus” provides detailed procedures:
Chapter 4 “Powering the Taurus” – Grounding considerations, and procedures for 
properly powering and shutting down the Taurus and for setting power manager 
parameters.
Chapter 5 “Changing a Taurus Configuration” – An overview of how to work with 
the Taurus configuration, and procedures for changing a configuration.
Chapter 6 “Configuring Taurus User Access” – An overview of user access mod-
els, and procedures for logging in to the Taurus.
Chapter 7 “Configuring Taurus Communications” – Procedures for configuring 
the Taurus for Ethernet or serial networking.
Chapter 8 “Configuring the Digitizer and Timing” – Overview information and 
procedures for configuring the Digitizer and system timing.
Chapter 9 “Controlling and Configuring Sensors” – Procedures for sending com-
mands to a sensor, and for configuring the Taurus to work with sensors either by 
manually editing settings or by uploading predefined configurations.
Chapter 10 “Recording Data” – Overview information and procedures for working 
with the recording media (IDE hard drive or CompactFlash card) and with Taurus 
data Stores.
Chapter 11 “Accessing Data” – Overview information and procedures for extract-
ing data from Taurus Stores and for streaming data to a central server.

Part 3 “Appendices” contain reference information:
Appendix A “Specifications” – Taurus specifications
Appendix B “Connector Pinouts” – Connector pinouts diagrams and descriptions.
Appendix C “Sensor-Digitizer Interconnection” – An overview of principles for 
connecting sensors and digitizers, and recommended wiring lists for various sen-
sors.
Appendix D “Filter Response” – Digitizer filter response.
Appendix E “Open Source/Free Software Information” – Open Source/Freeware 
license information.
Appendix F “Apollo Light Utility” – Procedures for using the Apollo Light utility 
to view and extract data from Stores on your file system.
Appendix G “Taurus Firmware Upgrade Procedures” – Procedures for upgrading 
from Taurus software version 1.x to 2.x, and from 2.x to 2.x and higher.
Appendix H “UI Pages and Parameters” – A listing of each UI page and brief 
descriptions of the parameters on each page, including valid value ranges.

1.3  Unpacking the shipment
Note The information in this section should be used in conjunction with product 

warranty information.

Open the shipment and check the contents for completeness against the packing slip. 
There is a configuration sheet containing specific configuration information for each 
Taurus Portable Seismograph included in the shipment. This configuration sheet lists 
information such as the serial numbers of the parts shipped.
Taurus Portable Seismograph
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Chapter 1: Introduction
Visually inspect the equipment for any damage that may have occurred in transit. If 
there are any problems with the shipment, please contact Nanometrics Support.

1.4  Technical support
Read the appropriate sections of this user guide and related documents such as 
firmware release notes before installing or operating the Taurus Portable Seismograph.

Taurus features as identified in this manual have been tested and are supported by Nan-
ometrics. Use of other capabilities on the Taurus (for example, SSH, general Linux 
resources) is not supported by Nanometrics Technical Support or Warranty. Use such 
additional capabilities at your discretion.

If you need technical support, please submit your request via the Nanometrics customer 
support site, or by email or fax. Include a full explanation of the problem and support-
ing data (for example, relevant log and SOH files). Before returning a unit for repair, 
request an RMA number.

Customer support site: http://support.nanometrics.ca/
Email: techsupport@nanometrics.ca
Fax: To: Support, at +1 613-592-5929
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Chapter 2 Quick Start

This chapter provides an overview of basic setup procedures. Refer to the relevant 
chapters for more detailed information.

2.1  Taurus basic elements
Figure 2-1 shows the location and function of basic Taurus physical features, and Fig-
ure 2-2 gives an overview of the Taurus subsystems.

Figure 2-1  Taurus physical features

Media door (see also Section 10.3.1 “Insert 
and remove recording media” on page 99)

Colour display screen (display)

Keypad (see also Section 3.4 “Using the 
Taurus keypad” on page 22)

Press and hold the centre key for about 
1 second to start the Taurus (see also 
Section 3.3 “Starting up and shutting 
down the Taurus” on page 19)

SuperLED (indicates Taurus unit status)

Connectors (see Appendix B “Connector 
Pinouts”)
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Chapter 2: Quick Start
2.2  Verify operation of a Taurus
To check basic operation of a Taurus:

1. Connect the GPS antenna.
a) Place the GPS antenna where it has a good view of the sky (ideally, an unob-

structed view of the sky above 30° elevation angle).
b) Connect the cable to the Taurus GPS connector.

If you have the optional metal dust caps installed (Nanometrics part number 
15762), ensure that none of the dust caps are touching the GPS connector as 
this will create a ground loop.

2. If you wish to use a web browser on a PC to configure the Taurus, connect the Tau-
rus to your LAN using the supplied Ethernet cable (15228) or equivalent.

3. Insert recording media (see Section 10.3.1 “Insert and remove recording media” 
on page 99).
Recording media supplied with your order from Nanometrics is already formatted 
to Ext3. For Ext3 formatted media, the Taurus will automatically create a data 
Store on startup, using the current Store configuration. (The Store is the set of files 
that contains time-series and other types of data; see also Section 10.2 “Data 
Stores” on page 95.)

For other formatting options, see Section 10.3.2 “Format recording media” on 
page 101.

4. Power up the Taurus:
a) Build a power cable using a power connector from the optional Taurus Connec-

tor Kit (part number 15170) or equivalent (see also Appendix B “Connector 
Pinouts”).

b) Connect the Taurus to an appropriate 9 to 36V DC power supply (see also 
Chapter 4 “Powering the Taurus”). The Taurus will start booting up; it will take 

Figure 2-2  Taurus subsystems block diagram*

* See also Section A.13 “Power” on page 127 for typical power consumption specifications, 
Section 3.1 “About the Taurus operating modes” on page 17, and Section 8.2.1 “GPS 
receiver duty cycle” on page 79.
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Chapter 2: Quick Start
2 to 3 minutes for the Taurus to finish booting. Progress is indicated by the 
LED colour and blink patterns (see Section 3.8.2 “Status LEDs” on page 26) 
and the boot progress screen (see Section 3.3.1 “Start the Taurus” on page 19).

c) About 2 minutes after connecting the power, you can start the Taurus display. 
Press and hold the centre key on the keypad for about 1 second to turn on the 
display (see Figure 3-2 “Taurus keypad functions” on page 22). It will take 
about 10 to 15 seconds for the display to start. It will open to the Status page.

5. View the Status page to check basic operation.
a) Verify that the status bars are all green (Figure 2-3).

For an initial startup in a new location it may take the GPS receiver a few 
minutes to lock. Until then, the GPS/timing status bar will be red or yellow.
The Sensor status bar may be red, depending on the Sensor settings.

See Table H-1 “Status page options” on page 177 for information on interpret-
ing the status bars.

b) Verify that waveform images are displayed and that the value for Packets is 
incrementing; this indicates that data are being recorded to the Store.

6. Note the Taurus current Ethernet IP address. Use this address to connect to the 
Taurus, for example if you will use a web browser for configuration (http://Tau-
rusIPAddress/). (See Chapter 7 “Configuring Taurus Communications” for infor-
mation on how the IP address is obtained.)

2.3  View or change configuration settings
You can view and change configuration settings via either the display and keypad, or 
via a browser over an IP connection.

Figure 2-3  Taurus Status page

Status bars

Waveform images
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Chapter 2: Quick Start
2.3.1   Making configuration changes

The Configuration and Advanced Configuration pages are available from the Taurus 
UI main menu, on either the display or a browser. You must be logged in as tech or 
central to change the configuration. See also Section 3.6 “Navigating the Taurus UI 
pages” on page 23, Chapter 5 “Changing a Taurus Configuration”, and Chapter 6 
“Configuring Taurus User Access”.

Note the functions of the Apply, Commit, Reset, and Previous buttons:
• Apply will save configuration changes to volatile memory until the next restart 

of the associated Taurus subsystem (see Section 5.1 “Configuration format and 
storage” on page 43). In most cases you can use Apply to test your changes 
before you commit the changes.

• Commit will save the applied changes to non-volatile memory as the new con-
figuration. The Commit function includes Apply. In most cases, configuration 
changes are active as soon as you commit them.

• Reset will clear all changes that have not yet been applied. Reset has no effect 
once you have clicked either Apply or Commit.

• Apply, Commit, and Reset work independently of the current UI page you are 
on. They always affect the entire configuration (the entire configuration is the 
collection of all Taurus parameters which you can modify). For example, if you 
make a change in one configuration page, go to another page and make a sec-
ond change, and then click Reset, both changes are cleared from volatile mem-
ory.
Some configuration changes require a Restart before they take effect (for 
example, changes to Communications and Security settings). The UI will pro-
vide a message when this is the case, instructing you that a commit followed by 
a restart is required. In these cases, you cannot use Apply to test the changes 
before committing them.

• Previous returns you to a configuration page one up in the hierarchy without 
losing unapplied changes.

When using a browser, always use the Previous button, not the browser’s 
Back button, to preserve unapplied changes when navigating back through 
configuration pages.

2.3.2   Basic configuration settings

There are some basic settings you may want to check before proceeding to other con-
figuration changes.

You can make all of the configuration changes, then do a single Apply and Com-
mit.

2.3.2.1    Running mode

There are two basic running modes—Buffered and Communications—as well as an 
Interactive mode, which is on only while the display is active. Once the display shuts 
down the Taurus operates in the configured running mode. Buffered mode is the most 
Taurus Portable Seismograph
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Chapter 2: Quick Start
power-efficient, whereas Communications mode allows continuous access via an IP 
connection. See also Section 3.1 “About the Taurus operating modes” on page 17.

Choose the Running mode from either the Configuration page or the Advanced 
Configuration > General page. (The change will be permanent after a Commit.)

2.3.2.2    Number of channels
Choose the number of channels from either the Configuration page or the 
Advanced Configuration > General page. (The change will be permanent after a 
Commit.)

2.3.2.3    Digitizer sample rate
Choose the Digitizer sample rate from either the Configuration page or the 
Advanced Configuration > Digitizer > Main page. (The change will be permanent 
after a Commit.)

2.3.2.4    Playback settings

Downloaded data files will use the network and station definitions as entered on the 
Advanced Configuration > Playback page.

Enter appropriate values on the Advanced Configuration > Playback page. (The 
change will be permanent after a Commit.)

2.4  Install recording media (IDE hard drive or CF card)
Taurus can record to a CompactFlash card (CF) or a 1.8" ATA hard drive (IDE hard 
drive) formatted to a Linux Ext3 file system. For recording media specifications, see 
Section A.6 on page 125.

See Chapter 10 “Recording Data”, in particular Section 10.3.1 “Insert and remove 
recording media” on page 99, for more detailed information.

Warning You could damage the Store or the recording media if you remove the 
media while the Controller is running. Do not remove or insert media 
if the MediaLED is red. Wait until the Controller has shut down and 
the MediaLED is green.

1. The Controller must be shut down before you remove or insert recording media. 
To shut down the Controller if it is running:

In the Shutdown page, choose Shutdown.

2. Open the media door (Figure 10-4 on page 100).

3. Do not remove or insert media if the MediaLED is red. Wait until the Controller 
has shut down and the MediaLED is green (Figure 10-5 on page 100).

4. Remove or insert recording media as required.
Taurus Portable Seismograph
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Chapter 2: Quick Start
5. Close the media door. Closing the media door will start the Controller.
If you want to start the display, press the centre key for about 1 second. The dis-
play will start up once the Controller has finished booting.

Once you have inserted media you may be prompted to choose setup options, depend-
ing on factors such as whether the media are already formatted. If you have inserted a 
formatted medium of the same type that previously contained the active Store, the Tau-
rus will continue to record to that medium automatically. Two possibilities exist:

If the medium does not yet contain a Store, the Taurus will create a new Store 
using the last configured Store size setting.
If the medium already has a Store created by a Taurus, the Taurus will automati-
cally start appending data to the existing Store (see also Section 10.2.1.1 “About 
appended Stores” on page 96).

If you do not want to have the new data appended to an existing Store (for 
example, if it was created on a different Taurus), you can either reformat the 
medium or delete the existing Store. You can then create a new Store.

2.5  Format recording media
You can use the Taurus to format recording media to the Linux Ext3 file system. For a 
description of formatting options and procedures, see Section 10.3.2 “Format recording 
media” on page 101.

2.6  Retrieve data from a Taurus
Time-series data, state of health (SOH) data, log information, and system configuration 
information are recorded in the Nanometrics Store. There are various methods for 
accessing these data, listed below. Refer to the sections indicated for more information.

Retrieve data from the Store to files on your network using options in an external 
web browser over an IP connection.
• Time-series data may be extracted in any of MiniSEED, Seisan (version 8.0 or 

higher), or ASCII formats (Section 11.2 on page 109).
• Other information, such as SOH data, logs, and configuration information can 

be downloaded as described in Section 11.3 on page 116.

Access data on removed recording media (Section 11.1.4 on page 109).

Stream time-series data from a Taurus to a Nanometrics acquisition system (for 
example, a server running NAQS) over an IP connection (Section 11.2.3 on page 
115).

2.7  Install a Taurus
Taurus can be installed as a stand-alone unit to record continuous data on removable 
media for extended periods of time, or as a network component that allows data down-
loads, data streaming, and remote configuration changes while also recording to the 
storage medium.
Taurus Portable Seismograph
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Chapter 2: Quick Start
2.7.1   Deployment options

The Taurus may be deployed as either a stand-alone data recorder or as a network com-
ponent.

For stand-alone recording where network access is not required, typically you 
would configure the Taurus to run in Buffered mode. It consumes less power in 
this mode as the Controller only runs when the Taurus is recording buffered data to 
the Store.
For networked operation you must configure the Taurus to run in Communications 
mode and configure the appropriate network options. In this mode, the Controller 
is running continuously. It consumes more power than Buffered mode but allows 
continuous access via an IP connection.

In either case, installation requires these general steps:

1. Plan the physical installation (for example the power system, proper equipment 
grounding, and location of the GPS antenna).

2. Configure Taurus for your application. The as-shipped configuration of a Taurus 
includes various default settings, but setup of the Taurus will include changing 
some of these settings as appropriate (see Section 2.3 on page 9 for an overview, 
and relevant chapters in Part 2 for detailed information).
Typically you would do most of the configuration before field deployment, using a 
web browser on a PC over a network connection. You can also use the Taurus dis-
play and keypad to change the configuration in the field.

3. Install the hardware at the site (power supply, sensor, GPS antenna, Taurus).

2.7.2   Powering and grounding considerations
See Section A.13 “Power” on page 127 for power specifications and Chapter 4 
“Powering the Taurus” for information on powering the Taurus.

See Section 4.2 “Grounding a Taurus installation” on page 35 and Appendix C 
“Sensor-Digitizer Interconnection” for guidelines on equipment and signal 
grounding.

It is recommended that you use Shutdown to power down the Controller before 
disconnecting the power from the Taurus. If you disconnect the power while the 
Controller is running, you may lose data presently cached in the buffer. This can be 
about 15 seconds of data if the Taurus is running in Communications mode, and up 
to several hours of data if the Taurus is running in Buffered mode, depending on 
the sample rate, seismic signal and noise, and number of channels configured (for 
example, typically about 30 minutes of data for 3 channels at 100sps). Also, if the 
Store is not closed down properly, it may need to perform a lengthy reindexing on 
the next startup (see Section 10.2.3 “Reindex a Store” on page 98).

On the Shutdown page, choose Shutdown. Shutdown has completed when the 
SuperLED switches to a slow blinking pattern; note that this is about 10 sec-
onds after the Taurus display has turned off. See also Section 3.3.3 “Shut down 
the Controller” on page 20 and Section 3.8.2 “Status LEDs” on page 26.

Do not press and hold the centre key for more than 4 seconds as this will cause a 
hard shutdown of the Taurus Controller. A hard shutdown immediately terminates 
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Chapter 2: Quick Start
various processes and may cause detrimental effects, such as causing the Store to 
require reindexing.

2.7.3   Sensor configuration considerations

2.7.3.1    Mass auto-centre and mass locks
Disable the setting Advanced Configuration > Sensor Details > Mass Auto-
Centering – Auto-Center on Red before you connect a sensor that has masses 
locked. Once you unlock the masses, you may enable Auto-Center on Red.

2.7.3.2    Calibration

Before a sensor can be calibrated, the Taurus must be properly configured for the 
installed sensor. Configure Taurus to operate with your sensor, and then calibrate the 
sensor. See Section H.13.7 “Sensor Details” on page 199 for descriptions of the con-
figuration parameters.

1. Configure Taurus for the installed sensor, either by uploading a preset configura-
tion file or by manually editing settings:

Some sensor configurations (Sensor Details, Sensor Control Lines, and Mass 
Auto-Centering settings) are included with this software release, in the 
/sensors directory. You may upload one of these configurations at a time to 
the Taurus using the Advanced Configuration page options (Section 9.2.2 
“Using predefined sensor configurations” on page 90).

For passive sensor configurations, in the Sensor Details page you must also 
enter the appropriate sensitivity.

Uploading a sensor configuration file will replace all existing sensor configura-
tions on the Taurus with the uploaded configuration.
If you are entering the sensor configuration manually, in the Advanced Config-
uration > Sensor Details > Sensor Control Lines page, configure the control 
line parameters as appropriate for the installed sensor:

The assert and deassert levels.
The control pulse duration.
The default function of each line.
Which lines are to be asserted during the calibration.

2. In the Advanced Configuration > Calibration page, configure the type of calibra-
tion, the channels to calibrate, and the calibration waveform parameters.

3. To start the calibration, go to the Sensor page and click Start.

2.7.4   Environmental seals

Taurus can be sealed against dust and moisture. Before leaving a Taurus installation, 
confirm the following:

The media door is closed, with the door knob locked and the black plastic lever in 
the down position.
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All Taurus connectors are either occupied by the appropriate cable connector or 
are sealed with the optional factory-installed dust caps (Nanometrics part number 
15762) or equivalent.
The self-sealing pressure relief screw is torqued to hand-tight (Figure 2-4). This 
screw is a slot head on older models and is a 2.5mm hex Allen key on newer mod-
els.

2.7.5   Installation

This example provides an overview of installing a Taurus. See the appropriate sections 
of the manual for more information.

1. Choose a deployment option appropriate for your project, for example:
Install Taurus as a stand-alone data recorder (you would likely use Buffered 
mode for this).
Install Taurus in a network, for example to stream data to a central acquisition 
server such as a Nanometrics NAQS Server, or if continuous IP access is 
required (requires the Taurus to be in Communications mode).

2. In the lab, configure the Taurus as appropriate (see also Section 2.3 “View or 
change configuration settings” on page 9). For example:
• Running mode
• Sample rate
• Sensor configuration (see also Section 2.7.3 “Sensor configuration considera-

tions” on page 14)
• Playback settings

3. Install and level the sensor.

4. Mount the GPS antenna with a good view of the sky, and ensure that the antenna 
cable is installed with sufficient strain relief (for example, Figure 2-5).

Figure 2-4  Pressure relief screw location

Pressure relief screw
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Chapter 2: Quick Start
5. Ensure that the system is properly grounded.

6. Ensure that a supported recording medium is installed in the Taurus media slot.

7. Connect the sensor to the Taurus.

8. If you will be accessing the Taurus over a network, connect the Taurus Ethernet 
cable or a serial cable (see also Chapter 7 “Configuring Taurus Communications”).

9. Power up the Taurus:
Connect the power cable to start the Taurus up in the mode it was in before the 
last shutdown. It will take the Taurus a minute or two to boot. While the unit is 
booting, the display will be off, and the LEDs will indicate status (Section 3.8.2 
“Status LEDs” on page 26). About 2 minutes after connecting power, you can 
start the display:

Press and hold the centre key for about 1 second. It may take a minute for 
the display to start up.

10. In the Sensor page, turn on the sensor power (for an active sensor), and unlock the 
masses if required. If you disabled Auto Mass Center on Red, you may now enable 
that option.

11. If the Taurus is to operate in Buffered mode, ensure that Running Mode is config-
ured to Buffered before you leave the unit.

12. Ensure that the Taurus is sealed environmentally (Section 2.7.4 on page 14).

13. Ensure before you leave the Taurus installation that the SuperLED is blinking 
green. The SuperLED blinking green indicates that all systems are operating as 
configured and no problems are detected.

If the SuperLED is blinking yellow or red, use the Status page indicators to 
assist with finding the problem (step 5. on page 9). If the display is off, press 
the centre key for about 1 second and wait for the display to start up. It will 
open to the Status page.

Figure 2-5  Mount the GPS antenna (shows optional bullet antenna)
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Chapter 3 Operating and 
Maintaining Taurus

This chapter provides an overview of the Taurus operating modes and describes the 
basics of how to operate and maintain the Taurus.

3.1  About the Taurus operating modes
The Taurus has three operating modes, including an Interactive mode and two running 
modes.

Interactive mode is a temporary state invoked automatically while the display is 
active. Use this mode for managing the Taurus via the display and keypad, and for 
allowing IP access while the Taurus is running in Buffered mode. (See Section 
3.1.2.)
The configured running mode (Buffered or Communications) determines how the 
Taurus will operate once Interactive mode is off. (See Section 3.1.3 and Section 
3.1.4.)

3.1.1   Configure the running mode (Buffered or Communications)
1. Log in as tech or central (Section 6.1.1 “Logging in to the Taurus” on 

page 48).

2. Go to either the Configuration page or the Advanced Configuration > General 
page, and then choose an option from the Running Mode drop-down list. Options 
are Buffered and Communications. For a description of each of the running modes 
see Section 3.1.3 and Section 3.1.4.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

3.1.2   Interactive mode

Interactive mode is on only while the display is active (that is, until the configured UI 
timeout expires or you click Turn Off Display in the Shutdown page). The Controller 
is on continuously in this mode and allows access over an IP connection. Once Inter-
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active mode ends, the Taurus operates in the configured running mode (Buffered or 
Communications). See also Section 3.3.5 “Set the UI timeout (display timeout)” on 
page 21.

Interactive mode will be on until the configured UI timeout expires, with these excep-
tions:

Each time you make a selection (change a setting, click a button, choose a page 
from the main menu, or click a hyperlink), the UI timeout will start counting again 
from that operation. This applies to selections made either by pressing the centre 
key on the Taurus keypad or by using a browser.
If you have started a data download in Buffered mode, the Controller will run long 
enough to complete the download and will override the configured UI timeout if 
necessary.
If you click Turn Off Display in the Shutdown page, Interactive mode will end 
immediately. The Taurus will then operate in the configured running mode.
• In Buffered mode, if a data download is in progress Turn Off Display will ter-

minate the download.

3.1.3   Buffered mode

If the Taurus is configured to Buffered mode, Buffered mode starts automatically when 
Interactive mode ends. Buffered mode consumes the least power of the 3 operating 
modes (see Section A.13 “Power” on page 127 for specifications). Running in this 
mode, the Taurus continues to buffer data, and wakes the Controller only to write data 
to the Store when the buffer is full. The time it takes for the buffer to fill ranges from a 
few minutes to several hours, depending on the number of active channels, input signal 
activity, the sample rate, and the size of the buffer in your Taurus (2MB on units with 
serial number 0353, 0375, 0379 and higher, 1MB on all other units); for example, about 
30 minutes for 3 channels at 100sps and 2MB RAM.

There is no IP access to the Taurus once it is running in Buffered mode.

If the Taurus is configured to Buffered mode, you can start a data download if it is oper-
ating in Interactive mode (see also Section 3.1.2).

You cannot stream data if the running mode is Buffered, whether or not the Taurus is 
currently in Interactive mode.

3.1.4   Communications mode

If the Taurus is configured to Communications mode, Communications mode starts 
automatically when Interactive mode ends. Running in Communications mode, the 
Controller is on continuously. This mode consumes more power than Buffered mode 
because the Controller is always on, but it allows you to communicate with the Taurus 
continuously via an IP connection.

You can download data and stream data in Communications mode. (Shutdown page 
options Restart and Shutdown will terminate a download in progress, and will inter-
rupt data streaming until the Controller is restarted.)
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3.2  About the Controller
The Taurus Controller manages operations such as communications and networking, 
the display and UI, and the recording media. The Taurus Digitizer operates continu-
ously whether or not the Controller is running. Whether or not the Controller is running 
is determined by the operating mode you have selected (see Section 3.1). Options in the 
Shutdown page (such as Restart) and hard shutdown with the centre key apply only to 
the Controller, they do not affect the Digitizer.

While the Controller is running you have access to the Taurus over an IP connection, 
and applied configuration changes are held in volatile memory. Once the Controller 
shuts down, you no longer have IP access to the Taurus, and any uncommitted changes 
in the volatile memory for Controller-based functions will be lost.

The Taurus Digitizer runs as long as the Taurus has power connected. Therefore, there 
is a practical distinction between references to running the Controller, which may be 
running or not depending on the configuration, and powering the Taurus, which 
depends only on whether power is connected continuously.

3.3  Starting up and shutting down the Taurus
This section lists procedures for starting up and shutting down the Taurus.

3.3.1   Start the Taurus

The Taurus Digitizer, Controller, and timing are started up as soon as you connect 
power to the Taurus. Typically it takes about 3 minutes for these Taurus systems to fin-
ish booting when power is first connected. About 2 minutes after connecting power to 
the Taurus, you can start the display (press and hold the centre key for 1 second; the 
display will start in about 10 to 15 seconds). You may see the initial splash screen indi-
cating boot progress (Figure 3-1).

If the supply voltage exceeds either of the configured voltage disconnect settings (that 
is, it is either lower than the Battery Low value or higher than the Battery High level), 
the Taurus will not power up. See Section 4.3.3.2 “Bypass the Battery Low/High volt-
age disconnect settings on startup” on page 39.

Figure 3-1  Taurus boot progress screen
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3.3.2   Start the Controller

The Controller will start up following any of these actions:
When you connect power to the Taurus (see also Section 3.3.1 on page 19)
When you press the centre key for 1 second
When you close the media door
When the buffer fills in Buffered mode or when the buffer fills after a Shutdown in 
Communications mode, if the media door is closed and the configured media type 
is installed.

The Controller will run continuously while the Taurus is in either of Interactive or 
Communications mode (unless you shut down or restart the Controller). In Buffered 
mode the Controller runs only long enough to write data to the Store when the buffer 
is full. See also Section 3.1 “About the Taurus operating modes” on page 17.

If the Store is reindexing while the Taurus is in Buffered mode, you will see a yellow 
blinking SuperLED and the display may take a long time to start up after you press the 
centre key. This should be a very rare scenario. See Section 10.2.3 “Reindex a Store” 
on page 98.

3.3.3   Shut down the Controller

The Shutdown option powers down the Controller gracefully.

Always ensure the Controller is shut down before removing or inserting recording 
media. (This does not turn off the Digitizer, which continues to collect and buffer 
data.) See also Section 10.3.1 “Insert and remove recording media” on page 99.
The Controller will remain shut down if the media door is left open and you do not 
restart it by pressing the centre key. If the media door is left open for longer than it 
takes for the buffer to fill, data in the buffer will start to be overwritten starting 
with the oldest data. The time elapsed before the buffer fills depends on factors 
such as the number of active channels, sample rate, seismic signal and noise, and 
buffer size (2MB on units with serial number 0353, 0375, 0379 and higher, 1MB 
on all other units). This will range from a few minutes to several hours; for exam-
ple, about 30 minutes for 3 channels at 100sps and a 2MB buffer.

It is recommended that you use Shutdown to shut down the Controller before dis-
connecting the power. If you disconnect the power while the Controller is running, 
you may lose data presently cached in the buffer. This can be about 15 seconds of 
data if the Taurus is running in Communications mode, and up to several hours of 
data if the Taurus is running in Buffered mode, depending on factors such as the 
sample rate and number of channels configured. Also, if the Store is not closed 
down properly, it may need to perform a lengthy reindexing on the next startup 
(see Section 10.2.3 “Reindex a Store” on page 98).

To shut down the Controller:

In the Shutdown page, choose Shutdown. The LEDs indicate when shutdown has 
completed (see also Section 3.8.2 “Status LEDs” on page 26):
• The SuperLED has switched to a slow blinking pattern.
• The MediaLED is green.
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• The EtherLED is off.
This occurs about 10 seconds after the display has turned off.
If the Taurus is in Buffered mode the Controller will normally be shut down 
already. If the Controller is running, it is writing buffered data to the medium and 
will shut down automatically when it is finished writing the data.

To use Shutdown in Buffered mode, wake the display first (press the centre 
key for 1 second and wait for the display to start) so that you can access the 
Shutdown option. (See also Section 3.4 “Using the Taurus keypad” on 
page 22.) You may wish to do this to ensure any remaining buffered data are 
written to the recording medium before you remove media or power down the 
Taurus.

If you submit the Shutdown command from a browser, do not refresh the old 
browser window after the Controller has been restarted as this will resubmit the 
shutdown command.

It is possible to do a hard shutdown of the Controller by pressing the centre key for 
about 5 seconds, but this is not recommended. A hard shutdown will interrupt various 
processes and may cause detrimental effects, such as causing the Store to require rein-
dexing.

3.3.4   Restart the Controller

Use Restart to reboot the Taurus after committing configuration changes that require 
a Controller restart to become active (for example, Communications changes, Security 
changes). The Taurus continues to buffer data during a restart.

In the Shutdown page, click Restart.

If you submit the Restart command from a browser, do not refresh the old browser 
window after the Controller has been restarted as this will resubmit the restart 
command.

3.3.5   Set the UI timeout (display timeout)

If you have not made a selection in the UI within a configured period of time, the dis-
play will turn off and the Taurus will revert from Interactive mode to the configured 
running mode, either Buffered or Communications. (A selection is any of these actions: 
change a setting, click a button, choose a page from the main menu, click a hyperlink, 
or have a download of data in progress. This applies for selections made either by press-
ing the centre key on the Taurus keypad or by using a browser.)

1. Log in, then choose the number of minutes for the UI timeout in the Advanced 
Configuration > General page (UI TimeOut [min]).

2. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).
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3.3.6   Turn off the display

You can turn off the display and end Interactive mode before the configured UI timeout 
expires. This immediately shuts down the display and switches the Taurus to its con-
figured running mode (either Buffered or Communications).

In the Shutdown page, click Turn Off Display.
A browser will show the message “Turning off display... Please wait...”.

If you submit the Turn Off Display command from a browser, do not refresh the 
old browser window after the Controller has been restarted as this will resubmit 
the Turn Off Display command.

3.4  Using the Taurus keypad
Taurus has a 5-key keypad for Taurus startup and for navigating the UI pages on the 
display (Figure 3-2). The Taurus key functions equate to these standard keyboard func-
tions:

Centre key = Enter
Top key = Up arrow
Bottom key = Down arrow
Left key = Shift-Tab
Right key = Tab

3.5  Accessing the Taurus from a remote browser
You can access the Taurus from a browser over an IP connection. The Taurus must be 
in either Communications mode or Interactive mode, and the network cable must be 
connected before the Taurus is powered. See also Chapter 7 “Configuring Taurus Com-
munications”.

1. Connect to the Taurus using any of these methods:
Use the Ethernet cable (15228) to connect the Taurus to your LAN, or to con-
nect your computer directly to the Taurus.

Figure 3-2  Taurus keypad functions

Centre key: Select the option/link 
(Enter). Press and hold 1s to 

“wake” the Taurus.
(Also, press and hold for 5s will do 
a Controller hard shutdown, but this 

is not recommended.)

Top key: Move up through 
options in a field (Up arrow)

Left key: Move back through 
fields/links on the page (Shift-Tab)

Right key: Move forward through 
fields/links on the page (Tab)

Bottom key: Move down through 
options in a field (Down arrow)
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Connect to the Taurus via a serial (SLIP or PPP) connection.

2. Power up the Taurus.

3. If you do not know the IP address of the Taurus, start the display. The IP address of 
the unit is shown on the Status page.

4. Open a browser and go to a Taurus URL. For example, the Status page is http://
TaurusIPAddress.

3.5.1   Using the web interface over slow links

The Taurus web interface normally refreshes every 5 seconds. Taurus will detect if a 
communications link is slow, and will reduce the interface refresh rate to attempt to 
compensate for the link speed.

3.6  Navigating the Taurus UI pages
The Taurus UI web pages show real-time status information, and provide configura-
tion, data download, and firmware upgrade options. You can use the UI pages via the 
Taurus display and keypad, and on any web browser with IP access to the Taurus. (See 
Appendix H for a summary of the UI pages and options.) You must have cookies ena-
bled in your browser.

3.6.1   Choose a main page

Main pages are available from the drop-down menu in the title bar. Some main pages 
have hyperlinked sub-pages. From any page on the Taurus UI, you can choose a main 
page from the menu.

In a browser, click to open the menu and then click to choose the highlighted page 
(Figure 3-3). You can bookmark the page (http://TaurusIPAddress/pages/taurus/
pagename.page).

Optionally, you can use the Taurus icon  to return to the Status page.

In the display, the menu is active when the text is white on a blue background. 
Press the centre key to open the menu and use the top or bottom key to scroll 
through the list of main pages. Press the centre key to open the highlighted page.

Do not use the main menu or Taurus icon if you want to preserve changes in the 
Advanced Configuration sub-pages and the Data Retrieval pages. If you want to pre-
serve changes, use the page navigation options as described in Section 3.6.3.

Figure 3-3  Taurus main menu
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3.6.2   Browser navigation
On a browser you can use the Back and Forward buttons to navigate unless there 
are changes that you want to preserve. Navigating with the browser buttons will 
discard any unapplied changes in the Advanced Configuration sub-pages and any 
changes in the Data Retrieval pages. If you want to preserve changes, use the page 
navigation options as described in Section 3.6.3.

3.6.3   Preserve configuration changes or data retrieval settings

Use these methods for page navigation if you want to preserve changes to configuration 
and data retrieval settings during a session:

On Advanced Configuration sub-pages, navigate with the Previous button and the 
sub-page hyperlinks to preserve changes that have not yet been applied. (See also 
Table H-12 “Advanced Configuration page options” on page 191).

On Data Retrieval pages, use the Next button to preserve changes. (See also Sec-
tion 11.1.3.1 “Navigate Data Retrieval pages” on page 106.)

3.6.4   Select an active field or a hyperlink
In a browser, either use the mouse or the Tab and Enter keys to select a field or 
open a hyperlink.

In the display, use the left and right keys to tab the focus through the active fields 
and links on a page. A link with focus will have a dotted outline. An active field 
with focus will have white text on a blue background (Figure 3-4).
Once you have tabbed to a link or an active field, you can go to the linked page or 
choose an option in the active field (press the centre key).

3.7  Using the virtual keyboard
Taurus provides a virtual keyboard that you can use to enter text in the display using 
the Taurus keypad (Figure 3-5).

1. Click the Keys link beside the text field into which you want to enter a value.

2. Navigate the virtual keyboard using the Taurus keypad left/right/top/bottom keys, 
and use the centre key to choose the currently-selected virtual key. Alphanumeric 
selections will be entered in the field at the top of the screen.

Figure 3-4  Examples of link and field with focus

The Main link has focus.

The Running Mode field has focus.
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3. Once you have finished entering the value, click the Done button to exit the keys 
page. This enters the value in the original page.

3.8  Monitoring Taurus operation
Taurus includes these methods for monitoring operation:

The LEDs provide a quick view of current Taurus status (Section 3.8.2 on page 
26).
The Status page includes status bars to assist with interpreting the LEDs (Section 
3.8.3 on page 29).
Various pages show the current state of subsystems, such as SOH, Sensor, and 
Timing pages (Section 3.8.4 on page 29).
SOH data are recorded for the external SOH channels and for internal SOH (Sec-
tion 3.8.5 on page 30).
The system logs provide detailed operation history (Section 3.8.6 on page 30).
Alert messages can be used to narrow down a search through system logs (Section 
3.8.7 on page 30).
The Data Availability pages show a summary of data availability and any gaps 
(Section 3.8.8 on page 31).
System configuration information includes current version information for Taurus 
hardware and software, and a configuration audit trail with a record of all configu-
ration changes since the Store was created (Section 3.8.9 on page 31).

3.8.1   About the Taurus status colours

The Taurus LEDs and status bars use the same colour scheme (Table 3-1).

Figure 3-5  Virtual keyboard for text field entries on the display

Table 3-1  Status colours

Colour Status

Green Indicates that everything is working properly.
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3.8.2   Status LEDs

Taurus includes 4 status indicator LEDs:
SuperLEDs to indicate overall unit status (two LEDs, one on the top panel and one 
on the connectors panel). They indicate the same thing. The top panel LED is visi-
ble when you are using the keypad, the side panel LED is useful for monitoring 
stacked Tauruses.
An EtherLED to indicate Ethernet connection status.
A MediaLED to indicate whether it is safe to remove or insert recording media.

3.8.2.1    About LED blink patterns

Immediately after you connect power to the Taurus, the SuperLED will be on solid for 
about 5 seconds. Depending on configuration and status, during operation the LEDs 
will either be off, or blinking with a status colour. There are two blink rates: slow (0.5s 
on, 5s off), and fast (0.5s on, 0.5s off).

3.8.2.2    Unit status LEDs (SuperLEDs)

The SuperLEDs—the LED on the top panel and the LED beside the power connector 
(Figure 3-6)—indicate overall unit status. The top LED is not visible when Tauruses 
are stacked (Figure 3-7); in that case, view the LED on the connectors panel. Table 3-
2 describes the Taurus unit status indicated by the various SuperLED states.

The SuperLED colour is synchronized with the status bar colours on the Status page 
(see also Table 3-1 on page 25, and Section H.2 “Status” on page 177). It uses infor-
mation from these 6 subsystems as inputs:

Timing status
Media door status
Store status
Sensor status
Power Manager status
Ethernet networking status

Yellow Indicates a temporary situation that will resolve either to ok (Green) or to an error 
state (Red).

You should not leave a Taurus that is in a Yellow state, on the chance that it 
resolves to Red. You can check the relevant status and configuration pages to 
identify the problem, and the log files if more detail is required.

Red Indicates that a problem exists that must be investigated and fixed.
You can check the relevant status and configuration pages to identify the prob-
lem, and the log files if more detail is required.

Table 3-1  Status colours (Continued)

Colour Status
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Table 3-2  SuperLED states

LED state Unit status

Off The Taurus has no power.

Slow blink The Controller is shut down (Buffered mode, or Communications mode 
after you choose Shutdown on the Shutdown page).

Fast blink Any of these conditions:
• The Taurus is booting (if the power was just connected).
• The Controller is booting (for example, after a restart).
• The Controller is running (Communications mode or Interactive mode).
• The Controller is writing data to the media in Buffered mode.
The LED colour will vary as Taurus initializes its status information during 
bootup.

Red (solid, ~5s) The Taurus is starting to boot immediately after power is connected.

Blinking green The unit meets all the conditions to capture data successfully. (For 
example, the Taurus is digitizing, has recording media, is able to record to 
media and/or transmit data if in Communications or Interactive mode, has 
good power, has good timing, and the media door is closed.)

Blinking yellow The Taurus is initializing status of one or more subsystems. This is a 
temporary state that will resolve to either blinking green or blinking red.

You should not leave a Taurus that is in a Yellow state, on the chance 
that it resolves to Red (an error state). You can check the relevant sta-
tus and configuration pages to identify the problem, and the log files if 
more detail is required.

If the Store is reindexing, the SuperLED will be blinking yellow and some 
UI pages will not be available until reindexing is complete. Reindexing 
may take a long time, depending on how much data are in the Store.

Blinking red There is a fault or condition that prevents the unit from operating properly. 
(For example, GPS/Timing status is not good, missing recording media, a 
hardware or software problem, no Ethernet connection if in Interactive 
mode or Communications mode.) Investigate the problem, using the UI to 
check status if necessary and if possible.

Figure 3-6  SuperLED locations
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Chapter 3: Operating and Maintaining Taurus
3.8.2.3    Ethernet status LED (EtherLED)

The EtherLED on the back panel (Figure 3-8) indicates the status of the Taurus Ether-
net connection. Table 3-3 describes the status indicated by the various LED states.

3.8.2.4    Media status LED (MediaLED)

The LED inside the media door (Figure 3-9) indicates whether it is safe to remove or 
insert recording media (either an IDE hard drive or a CF card; see also Section 10.3.1 
“Insert and remove recording media” on page 99). Table 3-4 describes the status indi-
cated by the various LED states.

Figure 3-7  Stack of Tauruses

Table 3-3  EtherLED states

LED state Ethernet status

Off • The Taurus has no power.
• The Controller is shut down (Buffered mode, or Communications 

mode after you choose Shutdown on the Shutdown page).

Yellow (solid, ~8s) The Taurus is starting to boot immediately after power is connected, 
or the Controller is starting.

Fast blinking green Networking is enabled and a link is established.

Slow blinking green Networking is not enabled.

Blinking yellow Initial power up, diagnostics.

Blinking red Networking is configured but there is no link.

Figure 3-8  EtherLED location

Ethernet status LED
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Chapter 3: Operating and Maintaining Taurus
3.8.3   Status bars

The status bars on the Status page are to help with interpreting the LEDs; the colour 
will match the relevant LED and a brief text label will summarize the problem. In gen-
eral (see also the relevant entries in Table H-1 on page 177 for details on each status 
bar):

A bar with a green background indicates good status.
A bar with a yellow background and with text followed by a question mark indi-
cates Taurus is acquiring status information.
A status bar with a red background indicates an error condition.

Some of the status bars also have links to additional pages (such as Timing, Sensor, 
Store Tools) which show additional configuration or status information that may help 
with identifying any problems.

3.8.4   Pages showing current status information

Various pages show current status information. See these sections in Appendix H “UI 
Pages and Parameters” on page 175 for an overview of the information shown on each 
page:

Section H.2 “Status” on page 177
Section H.4 “SOH” on page 181
Section H.8 “Timing” on page 187
Section H.9 “Sensor” on page 189

The SOH information shown on these pages is updated every 5s, independent of the 
SOH sample rate setting (see also Section 3.8.5).

Table 3-4  MediaLED states

LED state Media status

Red It is not safe to insert or remove recording media, as the Controller is running.
Shut down the Controller before removing or inserting recording media. 
(This does not stop the Digitizer or cause data gaps.)

Green It is safe to remove or insert recording media, as the Controller is shut down.

Figure 3-9  MediaLED location

Media status LED
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3.8.5   SOH data

SOH data are recorded to the Store for the 4 External SOH channels and for internal 
SOH.

You can download SOH data to .csv files. See Section 11.3.1 on page 116 for 
information on downloading SOH information.

3.8.5.1    Set the SOH sample rate

You can set the SOH sample rate. This setting applies to the 4 External SOH channels 
and some of the internal SOH. The internal SOH using this setting include the types 
listed in Table 11-1 on page 117, except for the types in the row labelled PowerPC, 
which are not configurable.

1. Log in and go to the Advanced Configuration > General page.

2. Use the Soh Report Interval [s] parameter to set the SOH sample rate in seconds. 
Enter a number between 5 and 3600. Factory default is 60.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

The SOH information shown on the UI pages is updated every 5s, independent of the 
Soh Report Interval setting.

3.8.6   System logs

The Taurus system logs provide operation messages to the configured levels of detail. 
System logs are recorded to the Store.

You can download the system logs to a file and then view the information in any 
text editor. See Section 11.3.2 on page 119 for information on downloading the 
system logs.

3.8.6.1    Set the log verbosity

You can set the level of detail for the Apollo and ARM system logs (the DSP log ver-
bosity is not configurable).

1. Log in and go to the Advanced Configuration > General page.

2. Use the logType Log Verbosity parameters to set the level of detail in the Apollo 
and ARM logs. Options are Info, Verbose, and Debug. Factory default is Info.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

3.8.7   Alert messages

The Alerts pages show a list of occurrences such as startups, shutdowns, and major 
errors. Alert messages include the timestamp and a brief description (Figure 3-10). You 
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Chapter 3: Operating and Maintaining Taurus
can use these message timestamps as reference points for searching through system 
logs for occurrences that generated an Alert.

Use the links at the bottom of the page to navigate through the list of Alerts: New-
est, PrevPg (previous page), NextPg (next page), and Oldest. (In a browser you 
can jump to a specific Alert page using its URL, for example http://TaurusIPAd-
dress/pages/taurus/alerts.page?pageToShow=12 would open Page 11; page num-
bering starts at page 0, the Newest page.)

3.8.8   Data availability information

The Data Availability pages provide an overview of availability including information 
about gaps. See Section H.6 “Data Availability” on page 181 for an overview of what 
information is shown, and Chapter 11 for the data download procedures.

3.8.9   System configuration information

The Taurus maintains an audit trail of configuration changes made since the Store was 
created. See also Section 5.3 “Configuration audit trail” on page 44.

You can download the audit trail to a text file to view as a reference. See Section 
11.3.3 on page 119.

Version information of Taurus hardware and software components is shown in the Sys-
tem Info page.

You can download the version information to a text file. See Section 11.3.4 on 
page 120.

3.9  Maintaining the Taurus
The Taurus hardware does not require scheduled maintenance. Use the current status 
information and the system logs to assist with troubleshooting.

Figure 3-10  Alerts page example
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Chapter 3: Operating and Maintaining Taurus
If after troubleshooting it is determined that the Taurus requires repair, or if you 
have any questions, contact Nanometrics support (see Section 1.4 “Technical sup-
port” on page 5).

Before returning a unit to Nanometrics for repair, contact Nanometrics Support to 
obtain an RMA number.

New firmware uploads may be available periodically. See also Appendix G “Taurus 
Firmware Upgrade Procedures”.
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Chapter 4 Powering the Taurus

This chapter provides overview information for planning Taurus grounding and power, 
and procedures for configuring power manager settings.

4.1  Taurus power consumption
Power consumption of the Taurus varies with factors such as the operating mode and 
GPS receiver duty cycle. (See also Section 3.1 “About the Taurus operating modes” on 
page 17, and Section A.13 “Power” on page 127 for specifications).

In Buffered running mode, Taurus will write data to the Store on the recording 
media at approximately 30 minute intervals (for 3 channels at 100sps). The aver-
age power consumption will typically be 750mW when using CompactFlash and 
with the GPS Duty Cycle mode configured to Automatic. Instantaneous power 
consumption is higher than 750mW for the minute or two when the data in the 
Digitizer buffer are being written to the Store. Power consumption will be higher 
with a higher sample rate since the buffer fills more frequently. Power consump-
tion will be correspondingly lower for lower sample rates.
In Communications running mode, the Controller is running continuously. This 
consumes more power (about 2.3W when CompactFlash is used) than Buffered 
mode.
In Interactive mode all systems are running, including the display, so this con-
sumes the most power (about 3.3W). This operating mode is not a running mode, 
it is on only temporarily while the display is on. 

Power consumption as discussed above refers to the Taurus only. Power consumption 
of peripheral devices, such as the sensor, or devices connected to the NMXbus, serial 
port, or the External SOH, is in addition to these stated averages.

4.2  Grounding a Taurus installation
The most appropriate grounding plan will depend on your application and the installa-
tion environment. This section outlines some general information you may take into 
account when planning grounding for a Taurus installation. See also Appendix C “Sen-
sor-Digitizer Interconnection”.

Figure 4-1 shows the Taurus ground architecture, and Figure 4-2 shows where to con-
nect an earth lug to the Taurus (use an M4 x 5 screw).
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Figure 4-1  Taurus ground distribution and architecture
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Chapter 4: Powering the Taurus
The Taurus has chassis ground, analog ground, digital ground, and primary (input 
power) return. Primary power return is completely isolated from chassis, analog, and 
digital ground. Sensor power is connected directly to the input power and is thus iso-
lated from digital and analog ground. Chassis (case) ground is connected to the analog 
ground of the Digitizer subsystem. There is a single point connection from analog 
ground to the Digitizer subsystem digital ground. The Taurus Controller subsystem is 
isolated from the Digitizer and has its own Controller ground, which is used for the 
Serial and USB interfaces. For sensor cables, the chassis ground should be connected 
to the outer shield of the cable which is connected to the chassis of the sensor. The 
channel grounds are connected to the channel twisted pair shield. The control lines use 
digital ground, and there must be a digital ground connection to the sensor. Sensor 
power return is connected to primary ground.

General considerations:
Power – The Taurus power connector has 3 pins to allow the Taurus to conform to 
the site grounding system. You can connect the power return pin and ground, but 
combining grounding and power return in the same conductor limits the site 
grounding options. Our preferred practice is to establish a single ground point for 
the station and ground everything to that point, which minimizes the chances of 
ground loops and signal noise created by the power system.
Peripheral power – The Taurus provides primary power to attached peripheral 
devices via the Sensor, Serial, and NMX Bus connectors. This power is switched 
to allow devices to be controlled by the user through the Taurus. The Taurus mon-
itors for over-current conditions and will automatically switch off power to a 
peripheral if excessive current or a short is detected. See Section A.13 “Power” on 
page 127 for the typical current limit threshold of each peripheral power. Periph-
eral power is otherwise unregulated; the voltage provided to the Taurus is passed 
on to the attached peripherals. The current demand of each attached peripheral and 
the consequent voltage drop through the Taurus and peripheral cables should be 
taken into consideration when designing the power system to ensure that sufficient 
voltage is supplied to each peripheral.
• Sensor – The voltage drop through the Taurus in a typical 12V system is (1.0 * 

peak current draw of the sensor) + 100mV. Add to that the voltage drop in the 
Taurus power cable (power cable resistance in ohms * peak current of the Tau-
rus and all peripherals) and the sensor cable (sensor cable resistance in ohms * 
peak current of the sensor) to ensure that the total voltage drop between the 
Taurus power supply and the sensor does not cause the voltage at the sensor to 
fall below its required operating voltage. Solutions to problems of excessive 
voltage drop include heavier gauge cables, shorter cables, and higher voltage 
power supplies (which lowers the current consumption).
For example, a 12V system designed to operate down to 10.8V, with a short 
heavy gauge power cable and a 10m 24 gauge sensor cable (1.75Ω) operating a 
sensor with a peak current draw of 500mA, could see a voltage drop of 1.0 * 
0.500 + 0.100 + 1.75 * 0.500 = 1.425V. When the battery dips to 10.8V, peak 
current could cause the voltage at the sensor to drop to 10.8 – 1.425 = 9.375V.

• Serial – Similar considerations apply, except that the calculation for net voltage 
drop in the Taurus is (0.5 * peak current draw of the peripheral) + 100 mV.
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• NMXbus – Similar considerations apply, except that the calculation for net 
voltage drop in the Taurus is (0.5 * peak current draw of the peripheral) + 
100mV.

External SOH – When there is a negative input voltage across External SOH val-
ues (pins A-G, for example), if ground is connected to negative on the voltage sup-
ply then an incorrect value appears for SOH. Ensure ground is floating from 
negative to prevent this error.
GPS antenna – Do not short the GPS connector to the Taurus chassis as this may 
introduce a ground loop (for example, if the optional metal dust caps are installed, 
keep any loose caps away from the GPS connector).
The GPS antenna is on digital ground which has a single point connection to ana-
log ground, and analog ground is connected to chassis ground. The GPS TNC con-
nector is fully isolated from the chassis and therefore is isolated from chassis 
ground. The purpose of this scheme is to avoid a ground loop from digital ground 
to chassis to analog ground. Accidental momentary connection to the chassis is not 
a problem, but a permanent connection may create ground loops. Ideally, the GPS 
antenna is isolated from ground and in most cases this is fine since the antenna 
cable is short.
In configurations that have long GPS cables and lightning protection, an overall 
system design approach must be taken which balances the grounding requirements 
with the protection requirements. This approach requires an understanding of the 
Taurus grounding, the sensor grounding, power supply grounding, and local site 
grounding.

4.3  Powering the Taurus
See these sections for related information:

Section A.13 on page 127 for Taurus power specifications.
Section 4.2 and Appendix C for grounding information.
Section 3.3 on page 19 for Taurus startup definitions and options.
Section 4.4.1 on page 40 for power manager configuration options.
Section 9.1.2 on page 84 for turning sensor power on and off via the Taurus UI.

Note It is recommended that you use Shutdown to power down the Controller 
before disconnecting the power. This will preserve data presently cached 
in the buffer and will allow the data Store to close gracefully. See also 
Section 3.3.3 “Shut down the Controller” on page 20.

4.3.1   Choose a power supply and cable
Choose an appropriate power supply for your application. See Section A.13 on 
page 127 for the Taurus power specifications.

Build a power cable using a power connector from the optional Taurus Connector 
Kit (part number 15170) or equivalent (see also Appendix B “Connector 
Pinouts”).
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4.3.2   Power up the Taurus
1. Connect the Taurus to an appropriate power supply. The Taurus will start booting 

up in the currently configured running mode, either Buffered or Communications 
mode (Communications mode is the shipping default). It will take the Taurus a 
minute or two to boot.
While the unit is booting, the display will be off, and the SuperLEDs and Ether-
LED will indicate status (see Section 3.8.2 “Status LEDs” on page 26).

2. If you want to start the display, once the Taurus has finished booting press the cen-
tre key on the keypad for about 1 second. It may take a minute for the display to 
start.

Note If the Store is reindexing while the Taurus is in Buffered mode, the Taurus 
will not respond to a key press until the reindexing is complete. In this 
case you will see a yellow SuperLED, and the display may take a very 
long time to start up after you press the centre key. This should be a very 
rare scenario.

4.3.3   Specialized power-up procedures

There are two modified power-up procedures for specific purposes.

4.3.3.1    Power up the Taurus in factory test mode

When upgrading from version 1.x firmware to version 2.x or higher, you must start the 
Taurus in factory test mode.

1. Shut down the Taurus: Go to the Shutdown page and click Shutdown.

2. Once the LED below the Ethernet connector is off, disconnect the power cable.

3. Press and hold the centre key down while you connect the power cable and wait 
for the LED on the top of the Taurus to start blinking, then release the centre key.

4.3.3.2    Bypass the Battery Low/High voltage disconnect settings on startup

If the supply voltage exceeds either of the configured voltage disconnect settings (that 
is, it is either lower than the Battery Low value or higher than the Battery High level), 
the Taurus will not power up. You must use this method to power up the Taurus.

Connect the power while the media door is open. Having the media door open 
when power is first applied disables the battery voltage level checks and forces the 
Taurus to start up.
Once the Taurus has started, you can reconfigure the Battery Low/High disconnect 
to the appropriate values for your power supply (see also Section 4.4).

4.3.4   Power cycle the Taurus

Shutdown page options apply only to the Controller subsystem. If you need to power 
cycle other subsystems, for example to undo an applied configuration (Section 5.4.2 on 
page 45), use one of these methods:
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If you have physical access to the Taurus:

1. In the Shutdown page, click Shutdown.

2. Wait until the SuperLED switches to a slow blink pattern (0.5s on, 5s off), then 
disconnect the power cable.

3. Reconnect the power cable.

If you must power cycle the Taurus remotely:

Go to the URL http://TaurusIPAddress:8080/firmware/, and then click Reboot.

4.4  Configuring power manager settings
The Advanced Configuration > Power page provides options to configure power sup-
ply parameters such as disconnect levels and delays (Figure 4-3).

When the external supply voltage falls below the Battery Low threshold and remains 
below this threshold for Delay Low period, the Taurus powers off immediately. When 
the external supply voltage rises above the Hysteresis Low threshold (a low voltage 
reconnect value) the Taurus powers up, but not before 10 seconds has elapsed since the 
last shutdown. Set the low voltage disconnect values so as to properly protect the bat-
tery chemistry for your power supply, and set the reconnect value high enough to pre-
vent the unit from prematurely turning on due to battery rebound. Voltage drops in long 
power supply cables should also be considered in determining these values.

If the supply voltage is lower than the configured Battery Low value or higher than the 
Battery High value, the Taurus will not power up. You can bypass these voltage dis-
connect settings on power-up; see Section 4.3.3.2.

When the external supply voltage rises above the Battery High threshold and remains 
above this threshold for Delay High period, the Taurus powers off immediately. When 
the external supply voltage drops below the Hysteresis High threshold (a high voltage 
reconnect value), the Taurus powers up, but not before 10 seconds has elapsed since 
the last shutdown.

4.4.1   Configure power manager settings
1. Log in to the Taurus as tech or central.

2. Open the Advanced Configuration > Power page and enter the appropriate values 
for your system. See Table H-35 on page 206 for valid parameter values.

Factory default values are for 12V lead-acid batteries and assume short power 
cables. To protect your equipment, confirm the appropriate values for your 
power system and the maximum voltage tolerance of your sensor before setting 
these parameters.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).
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Figure 4-3  Power manager configuration page
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Chapter 5 Changing a Taurus 
Configuration

This chapter provides overview information about Taurus configuration storage and 
management, and basic procedures for changing a configuration parameter.

5.1  Configuration format and storage
Configuration changes that have not yet been applied are stored in a temporary cache 
associated with the browser session. If the browser session is closed, any changes that 
are not yet applied are discarded. Use the Previous button to move back through con-
figuration pages to preserve unapplied changes during a session (see also Table H-12 
“Advanced Configuration page options” on page 191).

Applied changes to a configuration are stored in volatile memory on the Taurus. 
Restarting the subsystem where the changes have been applied will erase the applied 
changes. You must commit applied changes to make them permanent.

The committed configuration is stored in the internal non-volatile memory on the Tau-
rus, as well as in the Store on the removable recording media. The internal non-volatile 
memory is used so that when the recording media are removed or the Taurus is power-
cycled, the configuration is not lost. The Store also holds a configuration audit trail of 
all changes since that Store was created.

The configuration may be downloaded from the Taurus, and uploaded to a differ-
ent Taurus.
The configuration audit trail may be downloaded for reference, but it is not a valid 
configuration for upload.

The downloaded Taurus configuration is in RDF Turtle format. For information on 
Turtle, see http://www.ilrt.bris.ac.uk/discovery/2004/01/turtle/. For information on 
RDF in general, see http://www.w3.org/RDF/.

5.2  Configuration pages
See Appendix H “UI Pages and Parameters” for a description of configuration param-
eters and permitted values on each configuration page. See also the specific configura-
tion procedures in the appropriate chapters.
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Chapter 5: Changing a Taurus Configuration
See Table H-12 “Advanced Configuration page options” for a description of configu-
ration page controls (hyperlinks, and the Apply, Commit, Reset, Previous, Browse, 
Upload, and Download buttons).

5.3  Configuration audit trail
Taurus maintains an audit trail of all configuration changes since the Store was created. 
You can download this information to a text file (see Section 11.3.3 on page 119). You 
can view the text file to determine the exact state of the configuration for the Taurus at 
any point since the Store was created.

It contains the configuration data and metadata, and an audit trail event trigger. The 
audit trail event triggers that create an entry are:

The Store is opened (which includes Taurus start up)
Any change that is applied to the configuration
The configuration is committed

5.4  Changing the configuration
The configuration parameters have default values as indicated in the relevant tables in 
Appendix H “UI Pages and Parameters”. You will likely need to change some of these 
values for your system. Basic options are in the Configuration page; all options are in 
the Advanced Configuration pages.

The Apply, Reset, and Commit functions affect all configuration pages, not just the 
page on which the Apply, Reset, or Commit was executed.

Note It is recommended that you have only one browser session at a time being 
used for configuration changes. For example, if you are running two 
browsers simultaneously (external and internal) and performing configu-
ration changes via both, you must click the Reset button on the configu-
ration page each time you switch from one browser to the other.

5.4.1   Change the configuration
1. Log in with the appropriate level of access. (See Chapter 6 for information on user 

permissions and logging in.)

2. Change the configuration parameter to the new value. You may make multiple 
changes in different configuration pages. These changes will be included in the 
same transaction (for example, if you click Apply in any page, all changes made in 
all pages will be applied).
The Advanced Configuration sub-pages have a Previous button for moving back 
up the hierarchy of pages while caching any unapplied changes.

In a browser use the Previous button, not the browser’s Back button, to ensure 
that unapplied changes are preserved.
Taurus Portable Seismograph
User Guide44 15148R5

2007-02-09



Chapter 5: Changing a Taurus Configuration
3. Once you have changed the values you can test them, discard them, or make them 
permanent.

You can apply the changes to test the new configuration without making it per-
manent. Click Apply, and then wait for the message Changes Applied to be 
shown at the top of the page.
If you want to undo applied changes, see Section 5.4.2.
Once you are satisfied that you want to make the changes permanent, click 
Commit to save the new configuration. Wait for the message “Changes 
Applied. Successful Commit.” (Commit includes Apply, so you may commit 
changes without having to apply them first.)

Some configuration changes require a Controller restart after Commit, to 
activate the saved changes. There will be a message shown in the UI if a 
restart is required. In the Shutdown page, click Restart.

5.4.2   Undo applied changes

To undo applied changes you must restart the subsystem where the applied changes are 
stored.

Use Shutdown – Restart to undo applied changes made in these Advanced Con-
figuration pages: Playback, Communications, Security, and the parameters UI 
TimeOut and Apollo Log Verbosity in the General page.

You must power-cycle the Taurus to undo applied changes made in the Configura-
tion page and in these Advanced Configuration pages: Timing, Calibration, Sensor 
Details, Digitizer, Power, and the last 4 parameters in the General page. See Sec-
tion 4.3.4 “Power cycle the Taurus” on page 39.

5.5  Downloading and uploading configurations
The complete configuration can be downloaded from the Taurus to an external file sys-
tem. Valid configuration files can be uploaded to the Taurus to replace the existing con-
figuration (for example, a configuration downloaded from another Taurus), or some 
part of the configuration (for example, a predefined seismometer configuration). The 
configuration is applied automatically on upload, so Reset will not have an effect. The 
configuration file is plain text in RDF Turtle format, so you can edit it with a text editor 
(ensure that you do not introduce errors).

Use the options on the Advanced Configuration main page to download and upload 
configurations (Figure 5-1; shows all options for a user logged in as central).

You must have the configured recording medium installed in the Taurus before you can 
upload a configuration.
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5.5.1   Download a configuration from the Taurus
Go to the Advanced Configuration page and click Download, then select a desti-
nation for the file.

5.5.2   Upload a configuration file to the Taurus
1. Go to the Advanced Configuration page and browse for a configuration file on an 

external file system, then click Upload. If you get an error during the upload no 
changes are made.

The configuration is applied automatically on upload. See Section 5.4.2 if you 
want to revert to the previous configuration.

2. If you want to make the uploaded configuration permanent, click Commit.

3. If the uploaded configuration contains changes to parameters that normally require 
a restart to become active, then restart the Taurus (Shutdown – Restart). (This 
would always be the case for a complete configuration.)

5.6  Saving default configurations
You can save whole or partial default configurations that you can later upload to any 
Taurus. (Partial default configurations are useful if you do not want to overwrite other 
parameters on upload.) For example:

Download and save the entire factory default configuration from a new Taurus.
Download and save an entire changed configuration as a customized default.
Copy a predefined seismometer configuration file, edit, and save the file for a dif-
ferent seismometer configuration (see also Section 9.2.2 “Using predefined sensor 
configurations” on page 90).

Figure 5-1  Advanced Configuration main page options
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Chapter 6 Configuring Taurus 
User Access

This chapter provides an overview and procedures for user access via the Taurus UI, 
and basic information for using other protocols such as SSH.

6.1  User access via the Taurus UI
To prevent unauthorized users from changing a Taurus configuration, there is a user 
authentication system (user name and password) and authorization model (the access 
level associated with the authenticated user). Access to configuration pages requires 
user authentication; which pages you can access depends on the authorization level of 
the user ID. HTTP requests must be via a browser. Authentication for browserless 
HTTP requests is planned for a future release.

The Taurus authorization model contains users, roles, and permissions, and their rela-
tionships as shown in Table 6-1. In this release, the authorization model is not editable. 
That is, you cannot reassign permissions or roles, and you cannot create or delete users. 
You can change the passwords.

Table 6-1  User permissions

User Default 
password Role Permissions

factory The factory account is not available for 
general use.

central central securityAdmin Configure security
Configure system
Manage data Store and recording media
Command sensor
Download all data types
Restart
Shutdown
Upgrade
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6.1.1   Logging in to the Taurus

Use the Log In/Log Off page to log in to one of the user accounts on the Taurus, to 
access the Change Password page, and to log out of the current session.

A logged-in session is specific to the browser session. That is, the session will log off 
automatically when you close the browser (for a browser session) or when the display 
shuts down (for a session on the Taurus display). If you encounter an error page in the 
browser session, you will still be logged in if you reopen the Taurus from a bookmark 
in the same browser session.

6.1.1.1    Standard login
1. Choose Log In from the Taurus menu.

2. Enter the UserID and Password. UserID and Password are both case-sensitive.
In a browser, type in the UserID and Password for the account you wish to use.
In the display, choose the UserID from the drop-down list and use the virtual 
keyboard to enter the Password (see Section 3.7 “Using the virtual keyboard” 
on page 24).

3. Click Log In.
If authentication is successful, the Status page will open with the message Login 
Successful and the menu will now show items you are authorized to access. If 
authentication is not successful, the Status page message will be Login Failed. You 
can go back to the Log In page and try again. There is no limit on the number of 
login attempts.

tech tech maintenance Configure system
Manage data Store and recording media
Command sensor
Download all data types
Restart
Shutdown

user user operator Manage data Store and recording media
Command sensor
Download all data types
Restart
Shutdown

[not logged in] [not defined] If active medium unformatted, format 
active medium/switch media on startup
Command sensor
Download all data types
Restart
Shutdown

Table 6-1  User permissions (Continued)

User Default 
password Role Permissions
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6.1.1.2    Quick login

There are two ways to log in using the display: Standard, and Quick Login. You can 
configure Taurus to use Quick Login for local authentication. It allows logging in with-
out having to enter or know the password for the account; for example, if a local user 
only needs to log in to swap media. Quick Login is available on the display only. 
Browser access to accounts always requires that you enter the UserID and Password, 
whether or not Quick Login is configured.

Once Quick Login is configured, the display Log In page will show an additional but-
ton, Log In as configuredUserID.

Choose the correct UserID from the drop-down list if it is not already selected, 
then click the Log In as configuredUserID button.

To configure Quick Login (or change back to Standard login):

1. Log in as central and open the Advanced Configuration > Security page.

2. Choose Quick Login from the Local Authentication drop-down list, and then 
choose the appropriate account from the Login Account drop-down list (Figure 6-
2)

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

Similarly, you can change the configuration back to Standard, which will disable Quick 
Login access on the display.

Figure 6-1  Open the Log In page

Figure 6-2  Configure Quick Login
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6.1.2   Logging off of the Taurus

If you are currently logged in to the Taurus, the page option in the main menu is Log 
Off. You will be prompted for confirmation before you are logged off.

To exit this page without logging off, choose any other page option from the main 
menu. You can continue working in the current session.

A session will log off automatically when you close the browser (for a browser session) 
or when the display shuts down (for a session on the Taurus display).

6.1.3   Changing passwords
1. Log off if you are currently logged in, as the Change Password page is available 

from the Log In page.

2. Open the Log In page and click the Change Password page link.

3. Type in the current user ID and password, then type in the new password. It must 
be at least 4 alphanumeric characters long. It is case-sensitive.

4. Type the new password in the Verify New Password field.

5. If you want to clear all current field entries, for example to enter different values, 
click Reset (applicable only if you have not yet clicked Change Password).

6. To accept the new password, click Change Password. You will be logged in to that 
account automatically.

If you change and then forget your passwords, you can revert to the default set of pass-
words (listed in Table 6-1):

1. Access the Taurus via telnet or SSH and log in as root (user root, factory default 
password dolphin18).

2. Delete the file /home/taurus_x/users.txt.

3. In the UI, go to the Shutdown page and click Restart.

6.2  Other access protocols: FTP, telnet, and SSH
You can access the Taurus file system via File Transfer Protocol (FTP), telnet, and 
Secure Shell (SSH; Taurus supports SSH-1 and SSH-2). SSH is included as of Taurus 
firmware version 2.x. This section provides basic information for accessing the Taurus 
using these protocols. Nanometrics does not provide technical support for use of these 
protocols. Procedure details will depend on the operating system and client you are 
using, and your network setup.

FTP and telnet are both cleartext protocols, so it is risky to use them across an unsecure 
network. Where security is an issue it is better to use SSH, which encrypts the entire 
session. Most UNIX/Linux systems include an SSH client. On Windows, you can 
install a client such as PuTTY (http://www.chiark.greenend.org.uk/~sgtatham/putty/). 
PuTTY includes other utilities such as PSFTP (a secure FTP utility).

The Taurus server uses the standard port number for each protocol (FTP port 21, SSH 
port 22, and telnet port 23).
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Chapter 6: Configuring Taurus User Access
To log in as root, login or user is root. See Section 6.2.1 for information about the 
root password.

The Taurus SSH server does not support multiple login attempts if you enter the wrong 
user name. If you enter the user name incorrectly, close the current SSH session and try 
again with a new session.

6.2.1   Default passwords

This section lists Taurus default passwords by firmware version for access to the Tau-
rus using protocols other than HTTP via a browser. (For user names and passwords to 
access the Taurus using HTTP via a browser, see Section 6.1 “User access via the Tau-
rus UI” on page 47.)

During an upgrade of the Taurus firmware from version 1.x to version 2.x or higher, the 
default root password is changed automatically once the rootfs has uploaded.

Caution If you change the root password and then forget the password, there 
is no way to recover it. You will no longer be able to log in to the Taurus 
file system.

If you are logged in as user root, you can change the root password using the passwd 
command.

To connect to the Taurus via PPP, there is a fixed user name pppuser and password 
beaver16. This is planned to be configurable in a future release. (See Chapter 7 
“Configuring Taurus Communications” for information on using serial protocols.)

Table 6-2  Default root passwords

Taurus firmware version Default root password

1.x root

2.x dolphin18
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Chapter 7 Configuring Taurus 
Communications

This chapter provides an overview of Taurus communications options, and procedures 
for changing network settings.

7.1  Taurus networking
You can configure Taurus for network access via an IP connection over either Ethernet 
or serial (SLIP or PPP). The Taurus will be accessible while it is in either Communica-
tions mode or Interactive mode (see Section 3.1 “About the Taurus operating modes” 
on page 17). The network configuration options are in the Advanced Configuration > 
Communications pages. (See Section H.13.2 on page 193 for a description of all Com-
munications page parameters.)

You must be logged in as tech or central to change Communications settings (see 
Chapter 6). See also Chapter 5 “Changing a Taurus Configuration”.

7.1.1   Packet routing

When packets are destined to a location outside of the immediate subnet (more than a 
single hop) a routing gateway is required. The gateway is configured as an IP address 
of a machine. The Taurus may have multiple gateways configured, the Default Inter-
face parameter specifies which gateway is in effect, and all packets not on an immedi-
ate subnet will be sent to that gateway:

Ethernet – The gateway used is the one obtained from the settings specified in the 
Advanced Configuration > Communications > Ethernet page.
Serial Port 1 – The gateway used is the Remote IP Address configured in the 
Advanced Configuration > Communications > Serial Port 1 pages.

7.1.1.1    Set the packet routing default interface
1. Log in and go to the Advanced Configuration > Communications page (Figure 7-

1).

2. Choose the Default Interface option from the drop-down list as appropriate to the 
type of network connection (Ethernet or serial).
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3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

7.2  Communications over Ethernet
The Taurus provides standard modes for searching for an Ethernet LAN interface. 
These include DHCP, Link-Local, and Static IP. There is also an option for no Ethernet.

Use the supplied Ethernet cable (15228) or equivalent to connect the Taurus to 
your LAN. Make sure the Taurus is connected to your LAN before you power up 
the Taurus.

7.2.1   Configuring Ethernet settings
1. Log in and go to the Advanced Configuration > Communications page (Figure 7-

2).

Figure 7-1  Choose the packet routing default interface

Figure 7-2  Ethernet configuration pages
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2. Ensure the Default Interface is set to Ethernet (Section 7.1.1.1 on page 53).

3. Click the Ethernet hyperlink.

4. Choose a Mode for the Taurus to define its Ethernet interface:
• DHCP – The Taurus will search for a DHCP server to obtain a network 

address. If a DHCP server is not found, the Taurus will use Link-Local protocol 
to acquire an available IP address.

• Link-Local – The Taurus will use trial-and-error testing of the LAN for address 
conflicts to acquire an available IP address in the Link-Local address space of 
169.254/16.

• Static IP– The Taurus will use the specified Static IP Address, Static Subnet 
Mask and Static Default Gateway settings to define its Ethernet interface. 
Therefore, for this mode also set these parameters:

Static IP Address – The IP address for the Taurus in the selected network.
Static Subnet Mask – Identifies which portion of the IP address is the net-
work ID and which is the host ID.
Static Default Gateway – The IP address of the gateway device for remote 
network visibility.

• None – The Ethernet interface will be disabled. This will conserve some small 
amount of power, but will restrict access to the Taurus to be via the display and 
keypad. (This parameter is not associated with serial configuration in any way.)

5. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

7.3  Communications over serial
Taurus provides two serial ports. Serial Port 1 can be configured to use SLIP or PPP 
for link control and establishment, with a further option to use TDMA on a SLIP link. 
Serial Port 2 does not support networking. The shipping default configuration for both 
ports is Raw, 9600bps.

Serial Port 1 (PPP/SLIP/Raw/TDMA) – A full 9-pin RS232 serial port designed 
for communication with a PC via dial-up modem or a direct connection. Configu-
ration options are in the Advanced Configuration > Communications > Serial Port 
1 pages.
Serial Port 2 (Raw only) – A basic serial port that has transmit and receive lines for 
a character stream for connection to a serial device. Port speed is configured in the 
Advanced Configuration > Communications > Serial Port 2 page.

7.3.1   Protocols
Serial Line IP (SLIP) – A simple IP over serial protocol with very little overhead. 
The Taurus uses a 1500 byte frame size.
Compressed SLIP (CSLIP) – SLIP with TCP/IP header compression. This will 
decrease the TCP/IP header from 40 bytes to 7 bytes, but has no effect on the 28-
byte UDP/IP headers.
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Point to Point Protocol (PPP) – A more advanced IP over serial protocol that is 
used in modem communications. The Taurus supports two connection methods:
• Dial-in – The Taurus will accept dial-up connections from remote devices. This 

feature has been tested with USRobotics V.90 56K external Faxmodem.
• Direct – This mode may be used to test streaming over PPP by connecting 

directly from a PC. However, Taurus is only listening for connect requests, it 
does not attempt to connect to a PPP server. Typically, you would use SLIP for 
a direct connection.

The Taurus automatically provides a PPP client its local and remote IP addresses 
for the PPP connection, for both dial-in and direct.
Time Division Multiple Access (TDMA) – Static channel allocation for multiple 
Tauruses to communicate with a Nanometrics comms device, such as a Janus 
Communications Controller, over SLIP links.

7.3.2   Flow control

For Data Streaming, the Taurus will automatically reduce the rate at which NP packets 
are transmitted based on the configured speed of Serial Port 1. The throttle rate is set to 
also allow for other TCP traffic to get across the link, and to account for PPP overhead.

7.3.2.1    Bandwidth requirement for data streaming over a serial link

Even with flow control the serial link will have bandwidth limits which, if exceeded, 
may affect data availability. When data streaming over a serial port, the following con-
dition must be true. If it is momentarily violated, buffers will temporarily allow data 
streaming without data loss, but a data delay may be noticed:

Number_bytes_required_to_be_sent < Maximum_number_bytes_that_can_be_sent

Maximum_number_bytes_that_can_be_sent = Serial_Port_Speed · 0.90 / 10

Number_bytes_required_to_be_sent = Output_Channels · Sample_Rate_Hz · 
Bytes_per_sample · Packet_overhead

Packet_overhead = ( 51 + 64 · Frames_per_packet + 28 ) / ( 60 · Frames_per_packet 
– 8 )

The packet overhead is the combined overhead of the Steim (1), NP, and UDP/IP over-
heads.

If you are using TDMA over serial, take into account that the maximum number of 
bytes that can be sent will be limited additionally by the size of the Taurus TDMA slot.

7.3.3   Limitations

These limitations are planned to be addressed in a future release.
After a client PC disconnects from the Taurus in PPP direct mode, another client 
PC cannot connect to the Taurus until after the Taurus has been rebooted.
A normal disconnect works over PPP dial-up. However, when the link is physi-
cally disconnected the Taurus does not detect it, so a new connection cannot be 
started until after the Taurus has been rebooted.
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7.3.4   Configuring a SLIP direct connection

The Taurus supports direct SLIP connection via a serial communication cable or trans-
parent serial modem. This section provides the procedure for configuring the Taurus 
and an example configuration procedure for Windows XP.

7.3.4.1    Taurus configuration for SLIP connection
1. Log in and go to the Advanced Configuration > Communications page (Figure 7-

3).

2. Ensure the Default Interface is set to Serial Port 1 (Section 7.1.1.1 on page 53).

3. Click the Serial Port 1 link.

4. Choose SLIP from the Mode drop-down list.

5. Click the SLIP hyperlink.

6. Choose a link speed from the Speed drop-down list.

7. Choose SLIP from the Protocol drop-down list.

8. Set the Local IP to the IP address of the local SLIP interface.

9. Set Remote IP to the IP address of the remote SLIP interface.

Figure 7-3  SLIP configuration pages
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10. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

7.3.4.2    Windows XP configuration for SLIP connection

Note SLIP connections do not work on Windows XP Service Pack 1. In order 
to set serial direct connection on Windows XP you must upgrade to Win-
dow XP Version 5.1.2600 Service Pack 2 Build 2600, or higher.

This example procedure is for a direct cable connection.

1. Connect the hardware and remove potentially conflicting settings:
a) Build a serial cable and connect to your PCs working COM port (normally 

COM1). For example, use a DB-9 connector and the connector from the 
optional Taurus Connector Kit (part number 15170). See also Appendix B 
“Connector Pinouts”.

If your link drops frequently, use a serial cable having a PC serial connector 
(DB-9) with pins 7,8 (RTS, CTS) shorted and pins 1,4,6 (CD, DTR, DSR) 
shorted. Some motherboards (PC hardware) require a full loop back serial 
cable to maintain a connection.

b) Close all serial port applications (such as Hyper terminal, Teraterm).
c) Ensure all modems are removed from the Modems tab (Control Panel > Phone 

and Modem Options) before continuing. Other modem drivers may confuse XP 
enough to refuse connection.

2. Go to Start > Settings > Control Panel > Phone and Modem Options.

3. Click the Modems tab. If “Communications cable between two computers” is not 
in the list:
a) Click Add.
b) Choose “Don’t detect my modem”. Click Next.
c) Choose “Communications cable between two computers”. Click Next.
d) Choose COM Port. Click Next.
e) Click Finish.

4. Select “Communications cable between two computers”. Click Properties.

5. Click the Modem tab and the set maximum port speed to 57600.

6. Click the Advanced tab.

7. Click “Change Default Preferences” and use these settings:
a) Set port speed to 57600.
b) Set Flow control to none.
c) Click OK.

8. Click OK to return to the “Phone and Modem Options”.

9. Click OK to return to Control Panel.
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10. Create the new network connection:
a) Go to Start > Connect to > Show all connections and choose Make new connec-

tion (or Control Panel > Network Connections > Make new connection.
b) In the “Network Connection Wizard”, click Next.
c) Choose “Set up an advanced connection”. Click Next.
d) Choose “Connect directly to another computer”. Click Next.
e) Choose “Guest”. Click Next.
f) Type a name in the Computer Name box (for example, Taurus SLIP). Click 

Next.
g) Choose “Communications cable between two computers (COMx)”. Click 

Next.
h) Choose “Anyone’s use”. Click Next.
i) Click Finish.
j) In the “Connect ComputerName” dialog box, ignore User name and Password.
k) Click Properties.
l) For “Communications cable between two computers” click Configure and use 

these settings:
i. Set maximum speed to 57600.
ii. Ensure all check boxes are un-checked.
iii. Click OK.

m) Click the Options tab, and un-check “Prompt for name and password...”. 
n) Click the Networking tab and choose SLIP connection. Un-check all compo-

nents except TCP/IP, QoS Packet Scheduler. 
o) Double-click TCP/IP and choose “Use the following IP address”. Set the IP 

address to the Remote IP configured in the Taurus.
p) Click Advanced and use these settings:

i. Un-check “Use IP header compression”.
ii. Set frame size to 1500.
iii. Click OK.

q) Click OK on TCP/IP properties. Click OK on ComputerName Properties.
r) Ensure the Taurus has been powered up and Serial 1 is connected to the COM 

port.
If all is well, the message “All devices are connected” should appear briefly, 
and the connection icon will show up immediately in the task bar.

11. Test the connection by pinging the Local IP address configured on Taurus from a 
command prompt.

7.3.4.3    Using CSLIP

CSLIP provides minor amounts of compression to the link.
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7.3.4.3.1    Taurus configuration for CSLIP connection

To use CSLIP, follow the procedures for SLIP (Section 7.3.4.1 on page 57) with 
this change: For step 7, set protocol to CSLIP.

7.3.4.3.2    Windows XP configuration for CSLIP connection
1. Complete the procedure described in 7.3.4.2 on page 58.

2. Go to Control Panel > Network Connections and right-click on ComputerName 
connection.

3. Go to the Networking tab and double-click on “Internet Protocol (TCP/IP)” (or 
click on it and choose Properties).

4. Click Advanced.

5. Set “Use IP Header Compression” to enabled.

6. Click OK in each window until you exit.

7.3.5   Configuring TDMA over SLIP

You can configure Serial Port 1 for TDMA over a SLIP link. The link typically would 
use a pair of transparent serial radio modems to communicate with a shared Nanomet-
rics comms device, such as a Janus Communications Controller.

TDMA parameters are configured on both the Taurus and the Janus, therefore param-
eter values such as frame length must be set appropriately on both instruments for each 
Taurus-Janus link.

The Taurus and Janus use their GPS-derived system time to calculate TDMA slot tim-
ing. If the Taurus system timing status is not good (status is not Green), data streaming 
is disabled until timing status is good again. (See table row Timing status bar‚ on 
page 178, for a summary of timing statuses and indicators.) While data streaming is dis-
abled, HTTP access to the Taurus is still available. HTTP access may be erratic, 
depending on the number of collisions on the link due to any significant shift of the 
Taurus time slot. If the Janus system timing status is not good, it will not transmit over 
the serial ports until its timing status is good again. While the Janus is not transmitting 
over the serial ports, it will continue to receive data from connected Tauruses and for-
ward the data to the central site over Ethernet.
Taurus Portable Seismograph
User Guide60 15148R5

2007-02-09



Chapter 7: Configuring Taurus Communications
7.3.5.1    Taurus configuration for TDMA

Note For a network that uses a set of half-duplex links on different frequencies, 
it is recommended that you configure the radios for priority receive. In 
addition, for low bandwidth links you may balance transmission efficiency 
for data transmission and retransmission requests by setting the respec-
tive slot proportions to 90% and 10%.

1. Log in and go to the Advanced Configuration > Communications page (Figure 7-
4).

2. Ensure the Taurus is configured for a SLIP connection (see Section 7.3.4.1 on page 
57 for the procedure to configure Taurus for SLIP).

3. Go to the Advanced Configuration > Communications > Serial Port 1 > TDMA 
page.

4. Set Enable TDMA to enabled , and set the TDMA parameter values as appropri-
ate for your application:
• Frame Length [ms] – Set the TDMA frame length in milliseconds. The frame 

length must be set to the same value for all devices sharing the link; for exam-
ple, for each Janus Port n-Taurus pair. This value should be compatible with the 
minimum slot size for this connection (Section 7.3.5.1.1). Enter a number from 
1000 to 10000. Factory default is 4000.

• Slot Start [%] – Set the Taurus TDMA slot start position as a percentage of the 
entire frame. This value should be compatible with the corresponding Janus 
port setting. Slot Start plus Slot Duration must be less than or equal to 100. 
Enter a number from 0 to 99. Factory default is 0.

Figure 7-4  TDMA configuration pages
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• Slot Duration [%] – Set the Taurus TDMA slot duration as a percentage of the 
entire frame. This value should be compatible with the corresponding Janus 
port setting, and the minimum slot size limit for this connection (Section 
7.3.5.1.1). Slot Duration plus Slot Start must be less than or equal to 100. Enter 
a number from 1 to 99. Factory default is 80.

5. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

7.3.5.1.1    Minimum slot size

The minimum slot size is determined by the largest frame that may be transmitted over 
the serial link. The minimum slot size in milliseconds is defined as follows:

minSlotSize = guardTime + (( MTU · bitsPerCharacter · paddingMargin / dataRate ) 1000 )

For example, with 35ms slot guard time (not configurable to other values in this 
release), a 530 byte Maximum Transmission Unit (MTU), 10 bits per character (8 data 
bits, 1 start, 1 stop, no parity), 10% byte stuffing margin, and 9600 bps, the minimum 
slot size would be:

minimum slot size = 35 + 530 · 10 · 1.1 / 9600 · 1000 = 642ms

7.3.6   Configuring a PPP dial-in connection via dial-up modem

The Taurus will accept a PPP initialization request from a client using a dial-up mode. 
This section provides the procedure for configuring the Taurus for PPP dial-in and an 
example configuration procedure for Windows XP.

To connect to the Taurus via PPP, a fixed user name pppuser and password 
beaver16 is used to authenticate the PPP client, Taurus being the PPP server. This is 
planned to be configurable in a future release.
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7.3.6.1    Taurus configuration for PPP dial-in
1. Log in and go to the Advanced Configuration > Communications page (Figure 7-

5).

2. Ensure the Default Interface is set to Serial Port 1 (Section 7.1.1.1 on page 53).

3. Click the Serial Port 1 hyperlink.

4. Choose PPP from the Mode drop-down list.

5. Click the PPP hyperlink.

6. Choose a link speed from the Speed drop-down list.

7. Set the Local IP to the IP address of the local PPP interface.

8. Set Remote IP to the IP address of the remote PPP interface.

9. Choose dial-in from the Connection Type drop-down list.

Figure 7-5  PPP configuration pages
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10. Set the modem initialization string (the entry is split into two parts to reduce clut-
ter, but you may enter multiple commands in one field if you wish):
a) Set Modem init string to an appropriate modem initialization command string 

(for example, AT&F1 OK).
b) Set the Extra modem init string to an additional modem command string (for 

example, ATS0=0 OK).

11. Set Authentication to enabled .

12. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

7.3.6.2    Windows XP configuration for Taurus PPP dial-in connection

This procedure shows example settings based on a USRobotics 56K Faxmodem.

1. Build a cable to connect Taurus to your modem. Use the connector from the 
optional Taurus Connector Kit (part number 15170), or equivalent. See also 
Appendix B “Connector Pinouts”.

2. Install the modem driver for USRobotics 56K Faxmodem (for example, find the 
driver mdmusr01.inf, right-click on the filename, and choose Install).

3. Create a cable connection modem:
a) Go to Start > Control Panel > Phone and Modem Options.
b) Click the Modems tab. If U.S. Robotics 56K FAX EXT is not in the list:

i. Click Add.
ii. Choose “Don't detect my modem”. Click Next.
iii. Choose “3Com Corporation” in the Manufacturer list.
iv. Choose “U.S. Robotics 56K FAX EXT”. Click Next.
v. Choose COM port. Click Next.
vi. In the Hardware Installation warning popup, click Continue Anyway.
vii. Click Finish to close the Add Hardware Wizard dialog.

c) Click OK to close the Phone and Modem Options dialog.

4. Create a PPP connection:
a) Go to Start > Control Panel > Network Connections.
b) Click Create a new connection.
c) In the New Connection Wizard, click Next.
d) Choose “Connect to the Internet”. Click Next.
e) Choose “Set up my connection manually”. Click Next.
f) Choose “Connect using a dial-up modem”. Click Next.
g) Type a name in the “Computer Name” box (for example, Taurus PPP Dialup). 

Click Next.
h) Type in the phone extension. Click Next.
i) Choose “Anyone’s use”. Click Next.
j) In the Internet Account Information page, enter these settings:
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i. Type pppuser in the User name box.
ii. Type beaver16 in the Password box.
iii. Type beaver16 in the Password box.
iv. Set “Use this account name and password when...” to enabled.
v. Set “Make this the default Internet connection” to not enabled.
vi. Set “Turn on Internet connection Firewall...” to not enabled.
vii. Click Next.

k) Click Finish. A “Connect ComputerName” dialog box will pop up.
l) Click Dial. If it succeeds a connection icon will appear in the Windows notifi-

cation area with the message “ComputerName is now connected”.
m) Test the connection by pinging the Local IP address configured on the Taurus 

from a command prompt.

7.3.6.3    Viewing modem logs on Windows XP
1. Go to Start > Control Panel > Phone and Modem Options.

2. Click on the Modems tab.

3. Click Properties.

4. Click on the Diagnostics tab.

5. Set Append to Log to enabled.

6. Click View log to see an updated log at any time.

7.3.6.4    Viewing modem logs on Linux

Note This does not take effect until after a reboot. View the log in /var/log/
ppp.

This information is copied from http://axion.physics.ubc.ca/ppp-linux.html#Logging:
Message Logging
In order to figure out what is happening while you are trying to log on to your ISP, 
you must turn on debugging and log the debug messages to some file. The key pro-
grams are pppd, and a program it uses, called chat. We will store those debug-
ging messages in a file called /var/log/ppp. (You can use any file you wish, 
including /var/log/messages. Some distributions are now installing a direc-
tory called /var/log/ppp (Eg, The Corel distribution does this). If yours does, 
you must use a different name, eg, /var/log/ppplog. Use that name instead 
everywhere this document talks about /var/log/ppp.)
In order that your system will record the debugging information from both these 
programs, do the following:
cp /etc/syslog.conf /etc/syslog.conf.orig
to make sure you have a copy of a good version in case you mess up the next com-
mand. If you have trouble, copy back the original version.
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Edit /etc/syslog.conf and add the lines

(Some versions of syslogd (eg on SunOS) demand that those be tabs not spaces 
between the two parts on each line. Some editors refuse to insert tabs and convert 
them to spaces. The syslogd shipped with most recent distributions of Linux do 
not seem to care, but Be warned.)
Then, to tell syslogd to actually log the information, do
killall -1 syslogd

7.3.7   Configuring a PPP direct cable connection

The Taurus supports a mode to test streaming over PPP by connecting directly from a 
PC. However, the Taurus is only listening for connect requests, it does not attempt to 
connect to a PPP server. This section provides the procedure for configuring the Taurus 
for PPP direct connection, and an example configuration procedure for Windows XP. 
Typically, you would use SLIP for a direct connection (Section 7.3.4 on page 57).

7.3.7.1    Taurus configuration for PPP direct connection
1. Connect the hardware and remove potentially conflicting settings:

a) Build a serial cable and connect to your PCs working COM port (normally 
COM1). For example, use a DB-9 connector and the connector from the 
optional Taurus Connector Kit (part number 15170). See also Appendix B 
“Connector Pinouts”.

If your link drops frequently, use a serial cable having a PC serial connector 
(DB-9) with pins 7,8 (RTS, CTS) shorted and pins 1,4,6 (CD, DTR, DSR) 
shorted. Some motherboards (PC hardware) require a full loop back serial 
cable to maintain a connection.

b) Close all serial port applications (such as Hyper terminal, Teraterm).
c) Ensure all modems are removed from the Modems tab (Control Panel > Phone 

and Modem Options) before continuing. Other modem drivers may confuse XP 
enough to refuse connection.

2. Log in and go to the Advanced Configuration > Communications page (Figure 7-5 
on page 63).

3. Ensure the Default Interface is set to Serial Port 1 (Section 7.1.1.1 on page 53).

4. Click the Serial Port 1 hyperlink.

5. Choose PPP from the Mode drop-down list.

6. Click the PPP hyperlink.

7. Choose a link speed from the Speed drop-down list.

8. Set the Local IP to the IP address of the local PPP interface.

9. Set Remote IP to the IP address of the remote PPP interface.

10. Choose direct from the Connection Type drop-down list.

local2.* /var/log/ppp

daemon.* /var/log/ppp
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11. Leave the Modem init string empty.

12. Leave the Extra modem init string empty.

13. Set Authentication to enabled .

14. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

7.3.7.2    Windows XP configuration for Taurus PPP direct connection
1. Create cable connection modem 

a) Go to Start > Control Panel > Phone and Modem Options.
b) Click the Modems tab. If “Communications cable between two computers” is 

not in the list:
i. Click Add.
ii. Choose “Don't detect my modem”. Click Next.
iii. Choose “Communications cable between two computers”. Click Next.
iv. Choose COM Port. Click Next.
v. Click Finish to close the Add Hardware Wizard dialog.

c) Choose “Communications cable between two computers and then click Prop-
erties.

d) Click the Modem tab.
Set Maximum Port Speed to 57600.

e) Click the Advanced tab.
f) Click Change Default Preferences and use these settings:

i. Set Port speed to 57600.
ii. Set Flow control to None.
iii. Click OK.

g) Click OK to close the “Communications cable between two computers Proper-
ties” dialog.

h) Click OK to close the “Phone and Modem Options” dialog.

2. Create a PPP connection:
a) Go to Start > Control Panel > Network Connections.
b) Click Create a new connection.
c) In the New Connection Wizard, click Next.
d) Choose “Set up an advanced connection” Click Next.
e) Choose “Connect directly to another computer. Click Next.
f) Choose “Guest”. Click Next.
g) Type a name in the “Computer Name” box (for example, Taurus PPP). Click 

Next.
h) Choose “Communications cable between two computers (COMx)”. Click 

Next.
i) Select “Anyone’s use”. Click Next.
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j) Click Finish. A “Connect ComputerName” dialog box will pop up.
k) Click Properties.
l) Choose “Communications cable between two computers (COMx)”.
m) Click Configure and use these settings:

i. Set “Maximum speed (bps)” to 57600.
ii. Ensure all check boxes are un-checked.
iii. Click OK to close the Modem Configuration dialog.

n) Click the Networking tab.
i. Choose “PPP: Windows 95/98/NT4/2000, Internet” connection (default).
ii. Un-check all items except “Internet Protocol (TCP/IP)” and “QoS Packet 

Scheduler”.
o) Choose “Internet Protocol (TCP/IP)” and then click Properties.
p) Choose “Use the following IP address” and set it to the Remote IP address con-

figured on the Taurus.
q) Click Advanced and use these settings:

i. Set “Use default gateway on remote network” to enabled.
ii. Set “Use IP header compression” to not enabled.
iii. Click OK to close the Advanced TCP/IP Settings dialog.

r) Click OK to close the Internet Protocol (TCP/IP) Properties dialog.
s) Click OK to close the ComputerName Properties dialog.

3. Connect using a PPP connection:
a) Ensure the Taurus has been powered up and Serial Port 1 is connected to the 

appropriate Windows COM port.
b) Open Start > Control Panel > Network Connections, and choose Computer-

Name (for example, Taurus PPP).
c) In the Connect Taurus PPP dialog box use these settings:

i. Type pppuser in the User name box.
ii. Type beaver16 in the Password box.

d) Click Connect. If it succeeds a connection icon will appear in the Windows 
notification area with the message “Taurus PPP is now connected”. 

e) Test the connection by pinging the Local IP address configured on Taurus from 
a command prompt.

7.4  Data Streaming
You can stream time-series data over either an Ethernet or Serial Port 1 (SLIP/PPP) 
connection to a destination such as a NAQS server. See Section 11.2.3 “Stream time-
series data to a central acquisition server” on page 115.
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7.5  Discovery
The Taurus can be configured to send out brief UDP messages that allow other pro-
grams, including Apollo, to discover other devices running Apollo on the local area 
network. This feature will have more application once Apollo Central is released.

The Taurus shipping default is to have Discovery enabled. You may wish to change this 
setting to disabled, for example to eliminate possible associated Alert messages:

1. In the Advanced Configuration > Discovery > page, disable the option Enable Dis-
covery .

2. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).
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Chapter 8 Configuring the 
Digitizer and Timing

This chapter provides overviews of Digitizer and Timing system settings, and proce-
dures for changing these settings.

8.1  Configuring the Digitizer
Digitizer settings are grouped on two pages under Advanced Configuration > Digitizer; 
(Main, and Front End; Figure 8-1). There is also a set of pages to define trigger detec-
tion (Triggers; Figure 8-2 on page 77).

8.1.1   Main settings
1. Log in as tech or central.

Figure 8-1  Digitizer configuration pages
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2. In the Advanced Configuration > Digitizer > Main page, set parameter values as 
appropriate for your application:
• Sample Rate – The sample rate in hertz (samples per second) on the sensor sig-

nal. Choose an option from the Sample Rate drop-down list. Options are 10, 20, 
40, 50, 80, 100, 120, 200, 250, 500 (500sps is not supported in Buffered mode). 
Factory default is 100.
Note that valid value ranges for some of the trigger parameters depend on the 
sample rate, therefore some sample rates may be incompatible with your cur-
rent trigger settings. See also Section 8.1.3 “Triggers settings” on page 75, 
Table H-33 “Input Filter page options” on page 204, and Table H-34 “Detector 
page options” on page 205.

• Output Channels – The number of output channels. Choose an option from the 
Output Channels drop-down list. Options are 0, 1, 2, 3. Factory default is 3. If 
you choose 0 channels, no time-series data are written to the Store.

• Enable DC Removal – Set whether the DC removal filter is used on data. This 
enables a high pass filter with a configurable low corner frequency. Options are 
enabled , not enabled . Factory default is not enabled.

• DC Removal Cutoff – The DC Removal cutoff refers to the corner frequency of 
the high pass filter in hertz used in the Enable DC Removal parameter. All sig-
nal frequencies below this are removed. Enter a number between 0.001 and 1.0. 
Factory default is 0.001.

• Frames Per Packet – The number of standard SEED frames per packet for 
transmission of time-series data. Options are 3, 7. Factory default is 7.

• Sample Alignment – Sample alignment after a time error correction (see also 
Section 8.2.2 “System time correction” on page 80). Choose an option from the 
Sample Alignment drop-down list:

UTC – After a time error correction, the next sample is aligned to 0ns 
exactly. This is the factory default option.
None – After a time error correction, the next sample is aligned to some 
fraction of a second as determined by that correction.
HRD – After a time error correction, the next sample will have alignment 
based on the algorithm used in the HRD (a previous-generation Nanomet-
rics digitizer). You can use this option if you have Nanometrics HRDs in 
your network, so output samples from both Taurus and HRD instruments 
are synchronized in the same way.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

8.1.2   Front End settings

To choose Digitizer Front End settings:

1. Log in as tech or central.
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2. In the Advanced Configuration > Digitizer > Front End page, set parameter values 
as appropriate for your application (options are described briefly in the sections as 
indicated):
• Input Range – Choose an option from the Input Range drop-down list; units are 

volts. Options are 40, 16, 8, 4, 2. Factory default is 40. (See also Section 8.1.2.1 
“Input Range” on page 73.)

• Input Impedance – Choose an option from the Input Impedance drop-down list. 
Options are Low Impedance (43.07kΩ), High Impedance (>9MΩ), with High 
Impedance options (low power) or (high power). Low Impedance is the factory 
default. (See also Section 8.1.2.2 “Input Impedance and common mode range” 
on page 74.)

• Enable Dither – Set Enable Dither to enabled  or not enabled . Factory 
default is not enabled. (See also Section 8.1.2.3 “Enable Dither” on page 74.)

• Software Gain – Type in a value for Software Gain. Float number from 0.001 to 
100. Factory default is 1. (See also Section 8.1.2.4 “Software Gain” on 
page 75.)

• Enable Hard Clip – Set Enable Hard Clip to enabled  or not enabled . Fac-
tory default is not enabled. (See also Section 8.1.2.5 “Enable Hard Clip” on 
page 75.)

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

8.1.2.1    Input Range

The input voltage ranges represent the differential between the sensor positive and neg-
ative signal inputs, in volts peak-to-peak. The maximum input range is 40 volts peak-
to-peak. This represents the case of a differential input signal that at one peak has +10V 
on the positive input and –10V on the negative input (20V peak). At the negative-going 
peak, the differential input is –20V, for a peak-to-peak input range of 40V.

Choose settings as appropriate for your application. For example:
If you wish to accurately measure full-scale sensor activity, the Input Range of the 
sensor must be greater than the maximum output level of the sensor. However, if 
the sensor has a very large dynamic range and the Input Range is set to a large 
value (to capture full-scale movement), accuracy will be lost when measuring very 
weak seismic signals.
If you wish to accurately measure very weak seismic signals, the Input Range of 
the sensor must be set to a small enough value to accurately digitize weak signals. 
If strong seismic events occur that exceed the configured range, these signals will 
be clipped. Increased sensitivity (lower input ranges) also tend to increase overall 
data volume. For example, a 3-channel 100sps configuration might generate 
3000bps of sampled data. If the same system is reconfigured with much greater 
sensitivity, the increased signal activity may cause the average data throughput to 
rise to 6000bps or more.
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8.1.2.2    Input Impedance and common mode range

You may select between low and high input impedance:
Low Impedance (43.07kΩ) – This is the factory default.
High Impedance (>9MΩ)

Low impedance mode has the best immunity to noise pickup, and is the preferred mode 
when using active sensors. High impedance mode is provided for use with some pas-
sive sensors that require a damping load shunt resistor which is higher than the Taurus 
low input impedance. If the required load resistor is lower than the Taurus input imped-
ance, you can use the Taurus in low impedance mode by choosing a shunt resistor that 
in parallel with the Taurus input impedance achieves the desired load shunt value. 
Alternatively, you can put the Taurus in high impedance mode to use the load shunt 
resistor value specified by the passive sensor directly.

Note that in low impedance mode the Taurus input impedance forms a voltage divider 
with the output impedance of the source signal, so that for example a 436Ω source 
would result in a 1% decrease in signal amplitude at the digitizer. The exact signal 
amplitude is:

Taurus Input = Ri / (Rs + Ri) · Sensor Output
where Ri is the Taurus input impedance and Rs is the total source impedance (both 
sides of the differential source output plus both conductors of the sensor-to-digi-
tizer cable).

The voltage divider effect is negligible when using high impedance mode, where atten-
uation is less than 0.1% for source impedance up to 9kΩ.

When using High Impedance mode you can choose between two common mode signal 
ranges:

Low Power – The common mode rejection range is ±0.78V and the clip level for 
ground-referenced single-ended signals is ±1.56V. (Do not select the Low Power 
option with an Input Range of 40Vpp.)
High Power – The High Power mode increases the common mode rejection capa-
bility to ±1.8V, and raises the clip level for ground-referenced single-ended signals 
to ±3.6V. This is provided for use with sensors that have single-ended outputs ref-
erenced to ground, or where unusually high common mode signals must be 
rejected. This mode consumes approximately 40mW additional power.

Either Low Power or High Power mode can be used with High Impedance mode for all 
input ranges except 40Vpp, for which the Low Power setting is not applicable.

8.1.2.3    Enable Dither

Enable Dither adds a very small random signal to the input signal of the Digitizer, at an 
amplitude low enough so the dynamic range of the Digitizer is not reduced, to virtually 
eliminate so-called “idle tones”. Idle tones are a phenomenon which may occur only 
when the input is held to zero (or pure DC) so that the least significant bit of the Digi-
tizer output can “flip” around in a quasi-periodic pattern. Idle tones seen on Taurus 
even when dither is turned off have virtually no energy, are not indicative of a malfunc-
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tion, and are not present when recording real data. Setting Enable Dither to enabled 
costs an approximate 10mW power.

8.1.2.4    Software Gain

You can set the Digitizer gain to attenuate or amplify the sensor input signal to a level 
that will optimize use of the Digitizer dynamic range. After the Taurus digitizes the sig-
nal, it multiplies the amplitude by the software gain value. The factory default value is 
1.0 (that is, no change in amplitude).

This feature can be used to adjust the sensitivity of a station to match a desired value. 
For example, if a specific site has a sensitivity of 0.8cnt/(nm/s/s) and you want all sta-
tions in the network to have a sensitivity of 1cnt/(nm/s/s) you can set the Software Gain 
in this station to 1.25. You can “normalize” the sensitivity of each station by adjusting 
the Software Gain, or you can choose to create a different baseband response file (a 
seed.rsp file) for each station and use this file during data analysis at the central site.

8.1.2.5    Enable Hard Clip

A sigma-delta convertor output can transition sharply overscale if the input signal is 
near or exceeds the full scale input range, creating spikes in the output (that may also 
transition down into the range). The Enable Hard Clip feature cuts off the spikes that 
exceed the expected full scale limit, by replacing samples that are over-scale with the 
specified limit. The effect of the Digitizer output spiking at full scale may still be evi-
dent even with hard clipping on, as these spikes can also transition down within the nor-
mal operating range of the Digitizer even though the input is at or above full scale.

8.1.3   Triggers settings

The Taurus can be configured to detect events using a LTA/STA trigger algorithm on 
one or more of the 3 time-series data channels. You can define a trigger algorithm for 
each channel, and enable or disable trigger detection for any channel. Each time-series 
channel is associated with the same detector type identifier; that is, (channel 1, detector 
1), (channel 2, detector 2), (channel 3, detector 3). Each channel before passing data to 
the detector will band-pass the data using the trigger input filter.

You may enable triggers for inactive channels (as defined under Advanced Configura-
tion > Digitizer > Output Channels) although of course there will not be any associated 
data for any triggers that are detected. This could be used to define event information 
for a Time Series By Event retrieval on a different Taurus.

Set the detector and filter parameters as appropriate to your site and application, using 
options in the Advanced Configuration > Triggers pages (Figure 8-2). There are vari-
ous external sources of information on defining trigger parameters in general; for 
example the New Manual of Seismological Observatory Practice (IASPEI 2002) pro-
vides an excellent discussion of this topic (see the publisher’s site http://www.gfz-pots-
dam.de/pb2/pb21/ for information on the NMSOP).

Ensure that DC is filtered out for trigger detection. If you do not have the DC 
Removal filter enabled for your seismic channels (Advanced Configuration > Dig-
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itizer > Main page), you must include a high pass filter in the trigger input filter 
(Advanced Configuration > Digitizer > Triggers > Input Filter page).

Note that valid value ranges for some of the parameters depend on the sample rate 
(see Table H-33 “Input Filter page options” on page 204 and Table H-34 “Detector 
page options” on page 205).

Ensure that the Trigger On Ratio and channel gain are configured to values that are 
not so high that they will prevent events from ever triggering. (Trigger On Ratio is 
in the Advanced Configuration > Digitizer > Triggers > Detector n page, and chan-
nel gain is determined by the settings Input Range and Software Gain in the 
Advanced Configuration > Digitizer > Front End page.)

If you wish to simulate an amplitude threshold trigger, you can use a short STA 
time constant and a long LTA time constant.

To enable trigger detection:

1. Log in as tech or central.

2. In the Advanced Configuration > Digitizer > Triggers page, set one or more chan-
nels to use the configured trigger algorithm for that channel. Options are 
enabled , not enabled . Factory default is not enabled.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

The Taurus will create a trigger channel with a data packet for each trigger. You can 
extract the trigger data as SOH information to a .csv file (Section 11.3.1.1 on page 
118). A trigger packet contains the following information:

Trigger start time
Trigger duration
Channel and detector identification
STA at trigger detection
LTA at trigger detection
Taurus Portable Seismograph
User Guide76 15148R5

2007-02-09



Chapter 8: Configuring the Digitizer and Timing
8.1.3.1    Input filter parameters

See Table H-33 “Input Filter page options” on page 204 for parameter value ranges.

1. Log in as tech or central.

2. In the Advanced Configuration > Digitizer > Triggers > Input Filter page, choose 
input filter parameters as appropriate to your application (in general, to pass fre-
quencies of expected seismic events of interest while blocking seismic noise peak 
frequencies as much as possible):
• High Pass Order – The order of the high pass filter. Factory default is 0.
• High Pass Frequency [Hz] – The 3dB corner frequency in hertz of the high 

pass filter. Factory default is 0.001.
• Low Pass Order – The order of the low pass filter. Factory default is 0.
• Low Pass Frequency [Hz] – The 3dB corner frequency in hertz of the low pass 

filter. Factory default is 1.0.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

Figure 8-2  Trigger configuration pages
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8.1.3.2    Detector algorithm parameters

See Table H-34 “Detector page options” on page 205 for parameter value ranges.

1. Log in as tech or central.

2. In the Advanced Configuration > Digitizer > Triggers > Detector n page, choose 
detector algorithm parameters as appropriate to your application:
• STA Time constant [s] – The short term time constant in seconds. (In general, 

choose a value longer than a few periods of a typical expected seismic signal of 
interest, shorter than expected durations of events of interest, and not so short 
that excessive false triggers are generated by non-seismic noise spikes near the 
site.) Factory default is 1 second.

• LTA Time constant [s] – The long term time constant in seconds. (In general, 
choose a value long enough to encompass at least several cycles of typical non-
seismic, irregular noise for the site.) Factory default is 5 seconds.

• Trigger On Ratio – The STA/LTA threshold above which the associated chan-
nel is triggered. (In general, choose a value low enough to be sensitive to events 
of interest, but high enough to minimize false triggers.) Factory default is 5.

• Trigger Off Ratio – The STA/LTA threshold below which the associated chan-
nel trigger is switched off. (In general, choose a value low enough to encom-
pass the coda waves for events of interest, but high enough to terminate the 
trigger reasonably. The trigger will terminate either when the Trigger Off Ratio 
is achieved or when the Maximum Duration has expired.) Factory default is 1.

• Maximum Duration [s] – You can set the maximum duration of triggers for that 
channel, after which the trigger is ended even if the Trigger Off Ratio has not 
been achieved. Factory default is 3600 seconds.

• Latch LTA – If you set Latch LTA to enabled, the LTA is held at the value when 
the channel triggered, and therefore is not updated while the channel is trig-
gered. If you set the Latch LTA to not enabled, LTA continues to be calculated 
and updated while the channel is triggered. In either case, the trigger will termi-
nate either when the Trigger Off Ratio is achieved or when the Maximum 
Duration has expired. Options are enabled , not enabled . Factory default is 
not enabled.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

8.2  Configuring Taurus timing
The Taurus provides options for setting the GPS receiver duty cycle, for system clock 
corrections, and to set a requirement for GPS lock on startup before digitizing (Figure 
8-3).
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The Taurus derives its time frames from GPS time, as described in Table 8-1. The times 
shown on the various pages are updated whenever those page views refresh (typically 
every 5 seconds, unless the refresh rate is reduced to compensate for a slow network 
link when using a browser).

8.2.1   GPS receiver duty cycle

The Taurus has options to set when the GPS receiver switches on.

1. Log in and go to the Advanced Configuration > Timing page.

Caution The Always Off mode is used only for factory testing. Do not set the 
GPS Duty Cycle Mode to Always Off.

2. Choose a valid option from the GPS Duty Cycle Mode drop-down list:
• Automatic – Automatic is the most efficient setting for Taurus power consump-

tion. The duty cycling strategy is that the GPS receiver is switched on until fine 
lock is reached in the System Clock then switched off until the estimated time 
uncertainty reaches a predefined limit, such that the expected time error is still 

Figure 8-3  Timing configuration page

Table 8-1  Taurus time definitions

Type Description Shown on Taurus UI

GPS Time The GPS time provided by the GPS receiver. 
The Taurus has an algorithm that attempts to 
correct any time errors that the GPS receiver 
may have under certain conditions.

Not shown; used as the 
basis for the derived times 
described below.

System Time The current time according to the Taurus 
Digitizer subsystem. System Time is 
resynchronized to GPS Time when the GPS 
receiver is turned on. The timing module is 
sometimes referred to as the System Clock.

• Timing tab (Timing page) 
“System Time”

Controller 
Time 

The current time according to the Controller 
(see Section 3.2 on page 19 for a description 
of the Controller). The Controller 
resynchronizes its time to System Time once 
per minute when it is running.

• Status page “Time”
• SOH page “Time”

GPS Last 
Update Time

The System Time when the GPS data 
(including the GPS time) was last updated.

• GPS Map tab (Timing 
page) “Update Time”

Satellite Last 
Update Time

The System Time when the GPS receiver 
last updated the information for a specific 
satellite.

• GPS Satellites tab (Tim-
ing page) “Last Updated”
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Chapter 8: Configuring the Digitizer and Timing
less than the 100µs specification. The uncertainty estimate is based on clock 
drift and temperature measurements. This is the default setting.

• Every 10 minutes | Every 30 minutes – You can use a constant duty cycle, 
either Every 10 minutes or Every 30 minutes. It is recommended to verify that 
the time error does not exceed your requirements when the GPS receiver is 
switched back on after these time intervals. Use the GPS Time SOH file to 
inspect the time error.

• Always On – Always On will use approximately an additional 200mW, but 
will provide the most accurate timing. Since in this mode GPS time is always 
available, System Time can always be kept close to UTC such that the time 
error of the Taurus is typically not more than a few microseconds.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

8.2.2   System time correction

The System Time is kept close to GPS Time when GPS is available. Even when the 
GPS receiver is duty cycled and the System Clock is free-running for a while, the time 
error is regularly small enough so that it can be smoothly reduced to near-zero levels 
by running the clock slightly off-frequency until perfectly resynchronized. The time 
module is in Fine Lock if the time error (which is the difference between System Time 
and GPS Time) remains small. If a time error develops that is larger than a pre-set limit, 
the time module goes into Coarse Lock which steers the clock back faster.

Large time errors may develop if the System Clock is left free-running without the GPS 
receiver active for a prolonged period of time. The magnitude of the error is dependent 
on the length of time the GPS was unlocked (or otherwise unavailable) and the stability 
of the ambient temperature of the Taurus. In these cases the clock steering described 
above would take too long and a Time Error Reset is necessary. This eliminates a large 
part of the error instantly, after which the error can be driven small using the steering 
mechanism. The Time Error Reset introduces a discontinuity in the Taurus time frame 
because time appears to be “jumping” by a predefined amount.

8.2.2.1    Time error reset options

There are two modes for configuring how the Taurus will execute the Time Error Reset: 
Gradual Drift, and No Alignment. When Gradual Drift is selected, only time errors that 
are larger than 6.67ms are eliminated by a time jump that is a multiple of 10ms. After 
the reset the remaining time error is eliminated by the steering mechanism described 
above. This may take a while hence the name “Gradual Drift”. When No Alignment is 
selected, time errors as small as 66.6µs are corrected by the Time Error Reset with a 
size of a multiple of 100µs. The advantage of this is that the amount of error left for 
gradual steering is small and Fine Lock is achieved sooner. The disadvantage is that the 
time “jump” may cause the digitized samples to fall out of UTC alignment and re-align-
ment may be necessary, hence the name “No Alignment”.

To choose the time error reset method:

1. Log in as tech or central.
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2. In the Advanced Configuration > Timing page, choose an option from the Correc-
tion Mode drop-down list (options are discussed above):
• Gradual Drift
• No Alignment

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

8.2.3   Digitizing on startup with GPS lock

In order to correctly time stamp the digitized data, GPS lock is required on startup. It 
may be important that Taurus does not even start digitizing until good time quality (that 
is, GPS lock) is reached. However, there may be situations when digitized data are 
desired even if GPS reception is not available or not sufficient (for example, testing, 
setup, demonstration). Taurus has the ability to accommodate both situations. The 
“Digitizing Needs GPS Lock” option can be used to select one of these two modes. 
Note that once the Taurus has started digitizing it will continue to do so even if GPS 
loses lock later, regardless of this setting.

The factory default is to not require GPS lock on startup before digitizing. If you wish 
to change this setting:

1. Log in as tech or central.

2. Open the Advanced Configuration > Timing page.

3. Set Digitizing Needs GPS Lock to enabled .

4. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).
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Chapter 9 Controlling and 
Configuring Sensors

This chapter provides overviews of sensor control options and configuration settings, 
and procedures for changing the sensor configuration.

9.1  Sensor monitoring and control
The Sensor page provides options for you to monitor and control the operation of the 
sensor.

9.1.1   Monitoring sensor operation

The Sensor page shows the following near real-time information about your sensor 
(Figure 9-1):

The mass position of each component and the mass auto-centre voltage thresholds 
as configured in the Advanced Configuration > Sensor Details > Mass Auto-
Centering page. (This information can also be extracted to an Environment SOH 
file; see Section 11.3.1 “Extract State of Health data to a .csv file” on page 116).
For active sensors, an estimate of the sensor power consumption is shown beside 
the Sensor On | Off buttons. It is accurate to about ±15% for sensors drawing 
more than about 8mA. (Related items on the main Status page are the Sensor sta-
tus bar and the Power status bar; see the relevant entries in Table H-1 “Status page 
options” on page 177.)
System sensitivity, calculated using the sensor Sensitivity Value from the 
Advanced Configuration > Sensor Details page, and the Digitizer Input Range and 
Software Gain from the Advanced Configuration > Digitizer > Front End page. It 
is expressed in counts per unit of velocity or acceleration, based on the selected 
Sensitivity Units from the Advanced Configuration > Sensor Details page.
A waveform of the sensor output for each channel, with scaling options and wave-
form selection options as described in Table H-2 “Waveform page options” on 
page 180.
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9.1.2   Sending commands to the sensor

You can control some aspects of the sensor operation interactively with options in the 
Sensor page. You can configure the Taurus to perform mass auto-centring.

9.1.2.1    Manual sensor control

You can send commands to the sensor using these options in the Sensor page:
Mass Center – You can send a mass centre command for sensors that support 
remote (automatic) mass centring. It will centre all masses.
Mass Lock | Unlock – You can send mass lock and mass unlock commands.

It is recommended that you disable the mass auto-centring setting Auto-Center 
on Red before you connect a sensor that has masses locked. Once you unlock 
the masses, you may enable Auto-Center on Red. (See step 4. on page 87 in 
Section 9.2.1.1 “Edit an existing sensor configuration”.)

Sensor On | Off – Sensor On will pass the Taurus supply voltage through to the 
sensor power pin (see Appendix B “Connector Pinouts”).

Note For sensors that require regulated power, an appropriate DC/DC conver-
tor must be built into the sensor cable.

Calibration Start | Abort – You can start a sensor calibration, and abort a sensor 
calibration that is in progress. The process will use settings from the Calibration 
page (see Section 9.3 “Configuring calibration” on page 91).

It is recommended that you disable mass auto-centring during calibrations. 
Once the calibration has finished, you may enable mass auto-centring. (See 
step 4. on page 87 in Section 9.2.1.1 “Edit an existing sensor configuration”.)

Figure 9-1  Sensor page
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9.1.2.2    Mass auto-centring

You can configure the Mass Auto-Centering feature (Figure 9-2 on page 86) to initiate 
mass centring attempts when sensor mass positions reach off-centre thresholds. You 
can set thresholds for a delayed or an immediate recentring attempt (Yellow and Red 
thresholds respectively), and set the number of retries and retry intervals to achieve 
centred masses. You must have a control line configured for Mass Center, and have at 
least one of these thresholds enabled.

Auto-Center on Yellow – The Taurus will initiate mass centring when any axis has 
been above the Yellow Threshold for more than the Yellow Holdoff Time. If all 
axes drop below the Yellow threshold during holdoff time, then the holdoff time is 
cancelled.
Auto-Center on Red – The Taurus will initiate mass centring 1 minute after any 
axis exceeds the Red Threshold.

Each mass centring attempt is comprised of the configured number of retries at the con-
figured retry interval. That is, retries will be attempted until all axes are below the Yel-
low threshold, or until the number of Retries per Auto-Center have been executed.

9.2  Sensor configuration
Sensor configuration options are in the Advanced Configuration > Sensor Details pages 
(Figure 9-2).

You can edit, add, and delete sensor configurations manually (Section 9.2.1).
You can upload predefined sensor configurations using options in the Advanced 
Configuration page, and you can create new sensor configuration files by copying 
and editing existing files (Section 9.2.2 on page 90).
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9.2.1   Setting sensor configurations interactively

You can edit an existing sensor configuration, add a new configuration, or delete a con-
figuration.

9.2.1.1    Edit an existing sensor configuration
1. Log in as tech or central and go to the Advanced Configuration > Sensor 

Details page.

Figure 9-2  Sensor configuration pages
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Chapter 9: Controlling and Configuring Sensors
2. Choose the sensor from the Sensor drop-down list and configure the settings as 
appropriate for the sensor (factory defaults are for the Nanometrics Trillium 40).
• If the sensor has configurable operating modes, these two settings can be used 

to control the sensor operating mode(s). These mode selections will only take 
effect if the sensor control lines have been configured properly (see step 3).

SP/LP Mode – Choose the operating mode of the sensor, either short period 
(SP) or long period (LP). Factory default is LP.
XYZ/UVW Mode – The orientation of the sensor elements. Choose Set to 
UVW to indicate a triaxial seismometer (this will run the calibration on 
each channel separately). Options are XYZ, UVW. Factory default is XYZ.

• Calibration Mode – The calibration signal mode; refer to your sensor manual. 
Options are VOLTAGE, CURRENT. Factory default is VOLTAGE.

• Needs Power – Indicate whether your sensor needs power (active sensors) or 
not (passive sensors). It is used as an input for sensor status. (See Table H-1 
“Status page options” on page 177.) Options are enabled , not enabled .

• Detect Sensor Presence – When this feature is enabled, the Taurus will detect 
whether the sensor is drawing current (this feature works only for sensors 
drawing more than about 8mA). It is used as an input for sensor status. (See 
Table H-1 “Status page options” on page 177. This information is also availa-
ble as Instrument SOH; see Section 11.3.1 “Extract State of Health data to a 
.csv file” on page 116.) Options are enabled , not enabled .

• Sensitivity Units – Refer to your sensor manual for the appropriate value. 
Options are V/(m/s), V/(m/s/s).

• Sensitivity Value – Refer to your sensor manual for this value.

3. Click the Sensor Control Lines link and configure the settings as appropriate for 
the sensor (factory defaults are for the Trillium 40):
• Assert (On) Level – Assert line level; HIGH_Z, ZERO, POSITIVE.
• Deassert (Off) Level – Deassert line level; HIGH_Z, ZERO, POSITIVE.
• Positive Voltage Level – Positive voltage level; PLUS_5, PLUS_12.
• Pulse Duration [s] – Control pulse duration in seconds; 1, 3, 5, 7, 10, 15, 20.
• Ctrl Line n – Options for control line functionality include Unused Assert, 

Unused Deassert, Ch 1 Cal Enable, Ch 2 Cal Enable, Ch 3 Cal Enable, SP/LP 
On=SP, SP/LP On=LP, XYZ/UVW On=XYZ, XYZ/UVW On=UVW, Mass 
Center, Mass Lock, Mass Unlock.
If you have configured calibration for current mode (Calibration Mode on the 
Sensor Details page), control lines 4, 5, and 6 will not be available for any other 
configuration option. They will be reserved for calibration current return.

4. Optionally, configure mass auto-centring (Section 9.1.2.2 on page 85). On the Sen-
sor Details page, click the Mass Auto-Center link. Choose settings as appropriate 
to your application.
• Red Threshold [V] – The minimum mass position voltage level to indicate that 

the mass position is out of range. Mass centring is initiated one minute after 
this level is crossed for any channel. Threshold range is ±configured value. 
Minimum value is 0.001 and must be greater than Yellow Threshold (if used). 
Factory default is 1.000000.
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• Auto-Center on Red – Initiate mass centring if the Red Threshold is crossed. 
Options are enabled , not enabled . Factory default is not enabled.

• Yellow Threshold [V] – The minimum mass position voltage level to indicate 
that the mass position is marginal. After the Yellow Holdoff Time has expired, 
mass centring is initiated. Threshold range is ±configured value. Minimum 
value is 0.001 and must be lower than Red Threshold (if used). Factory default 
is 1.000000.

• Auto-Center on Yellow – Initiate mass centring when the Yellow Holdoff Time 
has expired. Options are enabled , not enabled . Factory default is not ena-
bled.

• Yellow Holdoff Time [h] – The number of hours to wait before initiating mass 
centring, while any mass position voltage is higher than the Yellow Threshold 
but lower than the Red Threshold. Value range is from 0.1 to 72.

• Retries per Auto-Center – The maximum number of attempts to make to center 
the masses. Integer from 0 to 20. Factory default is 0.

• Retry Interval [min] – The number of minutes to wait between auto-center 
retries. Integer from 1 to 20. Factory default is 1.

If you are using both the Red and the Yellow thresholds, ensure that you set the 
Yellow threshold as the lower mass position limit and the Red threshold as the 
higher mass position limit (Red >= Yellow). 

5. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

9.2.1.2    Add a new sensor configuration

You can save up to four sensor configurations on the Taurus. If you add them manually, 
in general it is easier to use the Sensor Details page, rather than the Add button on 
either of the sub-pages, as the sub-pages do not provide the option to edit the sensor 
name.

1. Log in as tech or central and go to the Advanced Configuration > Sensor 
Details page.

2. Click Add. This will create a new entry in the list and will create a temporary label 
using an existing sensor configuration New -> Existing Name (Figure 9-3).

3. Type a name for the sensor in the Sensor Name box to replace the temporary label.

4. Edit the configuration values for the new sensor configuration as appropriate (see 
Section 9.2.1.1 “Edit an existing sensor configuration”). If you want to clear all 
changes at this point, click Reset.

5. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).
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9.2.1.3    Delete a sensor configuration

You can delete a sensor configuration if there are more than one saved on the Taurus.

1. Log in as tech or central and go to the Advanced Configuration > Sensor 
Details page.

2. In the Sensor drop-down list, choose the sensor configuration that you want to 
delete (Figure 9-4).

3. Click Del to delete the configuration. If you want to restore the configuration at 
this point, click Reset.

Figure 9-3  Add a sensor configuration manually
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4. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

You can delete all saved sensor configurations at once by uploading a sensor con-
figuration file (see Section 9.2.2 on page 90).

9.2.2   Using predefined sensor configurations

You can upload predefined sensor configurations using the Advanced Configuration 
page, and you can create new sensor configuration files by copying and editing existing 
files. See also Chapter 5 “Changing a Taurus Configuration” for a general discussion 
of these options.

The Taurus software CD has a set of predefined sensor configurations as .cfg files in 
the /sensors directory. Configurations with the current release include:

Trillium40.cfg (this applies to the Nanometrics Trillium 40)
Trillium120.cfg (this applies to the Nanometrics Trillium 120P)
Trillium240.cfg (this applies to the Nanometrics Trillium 240 and Trillium 
240 OBS)
CMG-3.cfg (except for the sensitivity, this applies to the Guralp CMG-3ESP, 
CMG-3T, CMG-T3E, and CMG-V3E)
STS-2.cfg (this applies to the Streckeisen STS-2)
Passive.cfg (except for the sensitivity, this applies to all passive sensors)

9.2.2.1    Upload a predefined sensor configuration

An uploaded sensor configuration file will replace all sensor configurations in the Tau-
rus with the configurations in the uploaded file. For example, if the uploaded file con-
tains only one sensor configuration and the Taurus currently has four configurations, 
that one configuration will replace the entire list of four.

The new sensor configuration is applied automatically on upload, so Reset will not 
have an effect. You can undo the uploaded sensor configuration if you have not com-
mitted it yet; see Section 5.4.2 “Undo applied changes” on page 45.

Note The predefined configuration files set the control lines based on assumed 
sensor cable wiring for the sensor type. Before you use the configuration, 
check your sensor cable wiring and the control line assignments (in the 
Advanced Configuration > Sensor Details > Sensor Control Lines page).

Figure 9-4  Delete a sensor configuration
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1. Log in as tech or central.

2. In the Advanced Configuration page, browse for a sensor configuration file and 
then click Upload (Figure 9-5).

If required, edit the Sensitivity Value (for example, for passive sensors) or 
operating modes in the Advanced Configuration > Sensor Details page, and 
then click Apply.

3. You can test the changes (the configuration is applied automatically). To save the 
changes, click Commit. If indicated by a UI message, activate the new configura-
tion with a restart (Shutdown – Restart).

9.2.2.2    Create a new sensor configuration from an existing file

The predefined sensor configuration files are plain text in RDF format on the Taurus 
software CD, as /sensors/*.cfg.

To make a new file, copy an existing sensor configuration file and edit it with a 
text editor. You may include up to four sensor configurations in one file. (If errors 
are introduced as a result of the editing, on upload the configuration will be 
rejected in whole or in part.)

9.3  Configuring calibration
Calibration configuration options are in the Advanced Configuration > Calibration 
page (Figure 9-6).

Figure 9-5  Upload a sensor configuration
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Notes:
1) If you have configured your sensor for current mode calibration, con-

trol lines 4, 5, and 6 will not be available for any other configuration 
option. They will be reserved for calibration current return.

2) If a sensor has one calibration enable line and multiple calibration sig-
nal inputs (for example, STS-2), to calibrate a different channel you 
must reconfigure the calibration channel each time.

1. Log in as tech or central.

2. In the Advanced Configuration > Calibration page, set parameter values as appro-
priate for your application:
• Calibration Type – The type of calibration signal to use, either sine wave, pulse 

signal, or pseudo-random binary. Options are Sine, Pulse, PRB. Factory default 
is Sine.

• Channel n – Choose whether to enable this channel for calibration. Options are 
enabled , not enabled . Factory default is enabled.

• Attenuation – Use attenuation to select the range when lower amplitude signals 
are desired. A more accurate 5mV signal is generated when using attenuation 
of 1000 and amplitude 5V rather than attenuation of 1 and amplitude 0.005V. 
Options are 1, 10, 100, 1000. Factory default is 1.

• Amplitude – Set the calibration signal amplitude in the appropriate Calibration 
Mode units, volts or amperes. Float number. Factory default is 0.1. The Cali-
bration page will accept calibration signal amplitudes up to 5.0V or 60mA, 
depending on the Calibration Mode (VOLTAGE or CURRENT). If taken as a 
single-ended output (for example, between pin N (SEN_CAL1+) and pin V 
(DGND), the calibration circuit can provide a signal with a maximum ampli-
tude of 4.5V.
Ensure that you choose a value low enough that the signal will not clip. If you 
have configured calibration for voltage mode, ensure that you know the cali-
bration coil resistance.

Figure 9-6  Calibration page
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• Wait Time – The length of time in seconds after the calibration coil has been 
enabled before sending the calibration signal. Options are 0, 15, 30, 60, 120, 
300, 600, 1200. Factory default is 0.

• Ramp Duration – The length of time in seconds to bring the signal amplitude 
up to the configured amplitude and then down from the configured amplitude. 
Typically, only Sine calibrations are ramped. Options are 0, 10, 30, 60, 120, 
600, 1800, 3600. Factory default is 0.

• Duration – The length of time in seconds to generate the calibration signal at 
the configured amplitude between ramps. Options are 10, 60, 300, 600, 1800, 
3600, 7200, 18000, 36000, 72000. Factory default is 60. 

• Sine Frequency [Hz] – The sine signal frequency in hertz. Float number from 
0.01000 to 50.0000. Factory default is 1.0.

• Pulse Duration – The pulse signal segment width in milliseconds. Options are 
100, 1000, 10000. Factory default is 1000.

• PRB Pulse Width – The PRB signal unit pulse width in milliseconds. Options 
are 10, 20, 50, 100, 200, 500, 1000, 2000, 5000, 10000. Factory default is 1000.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

4. To start a calibration, go to the Sensor page and click Start. To stop a calibration in 
progress, click Abort. Ensure you have disabled mass auto-centring before you 
start a calibration (see step 4. on page 87 in Section 9.2.1.1 “Edit an existing sen-
sor configuration”).
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Chapter 10 Recording Data

This chapter provides an overview of Taurus data storage, and procedures for working 
with data Stores and the recording media. See also Chapter 11 “Accessing Data”.

10.1  Data flow
Data are put into Nanometrics Protocol packets (NP packets). The Taurus buffers the 
NP packets for all data types and writes them into the Store on the removable media (a 
CompactFlash card or an IDE hard drive). Time-series data are available for streaming 
to an external system if the Taurus is running in Communications mode.

10.2  Data Stores
The Store contains the time-series, state of health (SOH), and log data. The data are 
organized into “bands”, which are groups of data that may contain one or more chan-
nels. Bands contain data packets in multiple data blocks with a default size of 1MB.

The Store works as a ringbuffer. It will wrap around when it is full and record over the 
oldest data that may be overwritten while preserving all data types. That is, the Taurus 
will select the oldest data block to overwrite as long as that is not the only data block 
for that band. If it is the only data block for that band, it will search for the next avail-
able data block to overwrite.

A single Store may encompass many files, each being up to 1GB in size. This is trans-
parent when using the Store on the Taurus, but is relevant if you are planning to copy 
a Store to your PC because you must copy all files for that Store if you want to extract 
data later on.

A single recording medium may contain multiple Stores, although this is not recom-
mended; see Section 10.2.1.1 on page 96.

10.2.1   Create a Store

Creating a Store is not a separate option. The Taurus will either create a Store automat-
ically, or will prompt you to create a Store.

The Taurus will create a Store automatically after formatting a new medium in the 
active media slot (Section 10.3.2.1 on page 101).
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The Taurus will prompt you to create a new Store under either of these conditions:
• After deleting the currently active Store (Section 10.2.2 on page 97)
• On switching to the medium in the other media slot after formatting that 

medium (Section 10.3.3 on page 104)

If you insert a used medium that is already formatted to Ext3 but does not contain a 
Store, the Taurus will need at least 200MB of free space on the medium to create a 
Store. If the Taurus is creating a Store automatically, it will use the last Store capacity 
setting from the Taurus configuration when creating the new Store. It will set the Store 
capacity to the available space on the medium if the last Store configuration was set to 
Full (for example, Figure 10-2 on page 98). If the last Store configuration was for a spe-
cific capacity (for example, 800MB), the Taurus will create a Store of that capacity if 
there is sufficient space on the medium.

If the last configured Store size was 1GB (1000MB) on CF and the current medium is 
a 1GB CF, there still will not be sufficient space after deleting all files or formatting 
the medium, as the Taurus will require some of the space for other operations.

If there is insufficient space on the medium, the Status page will indicate Small Media 
and a Store Tools page message will provide some details (for example, Figure 10-1). 
In this case you have these options:

Switch to the other medium if it is available. You may then log in and Switch 
Media again, at which time you can create a Store with a capacity from the list of 
available options.
Delete files from the small medium to free up sufficient space.
Format the small medium. Formatting will destroy all data and partition informa-
tion on the medium.

10.2.1.1    About appended Stores

If you insert media containing a Store previously created on the same Taurus (the Store 
ID contains the Taurus serial number), the Taurus will append data to the existing 
Store. If there is more than one Store on the medium, the Taurus will append to the 
Store identified by its own serial number if it exists. Otherwise, it will append to any 
one of the existing Stores.

Figure 10-1  Small Media example
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If you insert media containing one or more Stores created on different Tauruses, the 
current Taurus will start appending data to one of the existing Stores.

It is recommended that you do not use existing Stores created on other Tauruses. 
You can insert media with existing Stores. You may then either delete the existing 
Store(s) or format the medium, and create a new Store to record data from the cur-
rent Taurus (Section 10.2.2 “Delete a Store” on page 97, Section 10.3.2.2 “Format 
previously formatted media” on page 102).

If you do use a combined Store, note the following:
A Store incorporates the serial number of the Taurus on which it was created, as a 
means of identifying that Store. The filenames will use the original Taurus serial 
number.
The original data channels in that Store remain intact until the Store wraps. When 
the Store wraps, oldest data are always removed first, regardless of which Taurus 
created those data.
All channels ever created in the Store will always have at least 2MB of data in the 
Store.
Apollo Light can be used to see what is actually in each Store, since the filename 
may not indicate the source of all data in that Store. See also Appendix F “Apollo 
Light Utility”.
The Data Availability pages behave as follows:
• The Month view will always calculate percentage of data available based on 

the (up to) 3 time-series channels of the current Taurus, ignoring other data in 
the Store. This is true both on the display and browsers.

• The Week and Day views have these characteristics:
On the display, it will show only (up to) 3 columns of data for the current 
Taurus Time Series channels.
On a browser, it will show a column for all time-series channels in the Store 
(numbered 1-3, with the corresponding Taurus serial number printed above 
the columns).
Text views behave as for a single-Taurus Store, showing all channels in the 
Store.

10.2.2   Delete a Store

You can delete the active Store (the Store that is currently in use) and create a new, 
empty Store. This will permanently delete all data in the old Store.

1. Log in and choose Store Tools from the menu.

2. Click Delete Store. This will open a page with options to set the new Store capac-
ity (Figure 10-2).

To exit the page without deleting the Store, either click the Store Tools Menu 
button or choose another page from the main menu.

3. Choose a Store capacity from the Store Size drop-down list. The list of options is 
based on the available space on the medium. The option Full will use all available 
space on the medium.
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Chapter 10: Recording Data
4. Click Destroy & Recreate Store to delete the current Store and create a new one 
of the configured capacity.

10.2.3   Reindex a Store

If the Store is not closed down properly, for example if Shutdown is not used before 
the power is disconnected, it may need to be reindexed. Generally the Taurus will ini-
tiate reindexing on startup if it is required.

You should not have to invoke reindexing manually. You may choose to reindex if, for 
example, you believe that the Store has recorded data but it does not appear in the Data 
Availability lists. It will recalculate the index within the Store, synchronizing the index 
with the actual data that are available.

Reindexing may take a long time, depending on how much data are in the Store. Data 
will continue to be generated during this task and will not be lost. You will not be able 
to do other operations that involve the Store at the same time.

1. Log in and go to the Store Tools page.

2. Click Reindex Store. You will be prompted for confirmation.
To exit the page without reindexing the Store, either click the Store Tools 
Menu button or choose another page from the main menu.

3. To proceed, click Yes, Reindex Store.

10.3  Recording media
Warning Hard drives may be damaged permanently if they are operated at alti-

tudes or temperatures beyond specified high and low limits. Do not 
operate the Taurus if it is at an altitude or unit temperature outside the 
specified ranges for the installed media type. (SanDisk Extreme Com-
pactFlash cards can be used across the full operating environmental 
range of the Taurus.) See Section A.14 “Environmental” on page 127 
for the operating range specifications.

Figure 10-2  Delete the Store and create a new one
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Taurus removable recording media options include a 1.8” ATA hard disk drive (IDE 
hard drive) and a CompactFlash card (CF). (See Section A.6 “Internal data storage” on 
page 125 for specifications.) These are accessible via the media door (Figure 10-5 on 
page 100).

10.3.1   Insert and remove recording media

Warning You may lose data or damage the media if you remove the IDE/CF 
while the Controller is running. Shut down the Controller and wait for 
the MediaLED to turn green before removing the IDE/CF (Figure 10-
5 on page 100).

The Taurus continues to collect and buffer data while the Controller is shut down. The 
Controller starts up again when you close the media door. If you want to preserve all 
of the buffered data, complete the procedure and close the media door before the data 
buffer fills. The time elapsed before the buffer fills will range from a few minutes to 
several hours, depending on factors including the number of active channels, sample 
rate, seismic signal and noise, and buffer size (2MB on units with serial number 0353, 
0375, 0379 and higher, 1MB on all other units). For example, for 3 channels at 100sps 
and 2MB RAM, typically you would have approximately 30 minutes to remove the 
current medium, insert the new medium, and close the media door before the buffer 
wraps and begins to overwrite the oldest data in the buffer.

1. Power down the Controller, using the Shutdown option on the Shutdown page 
(Figure 10-3).

2. Open the media door (Figure 10-4):
a) Lift the black plastic lever on the media door knob and twist the door knob 

counter-clockwise to the unlocked position (vertical).
b) The plastic lever has tabs that help remove the door. Push the lever flat against 

the door so these tabs push against the Taurus chassis. This will cause the door 
to pop free of the Taurus.
Air pressure differential inside versus outside the Taurus case (for example, if 
the Taurus was transported by air) may make the media door difficult to 
remove.

If this occurs, loosen (but do not remove) the pressure relief screw (Figure 
2-4 on page 15), allowing the pressure to equalize. Remove the media door, 
and then gently tighten the pressure relief screw (hand-tight is sufficient).

Figure 10-3  Shut down the Controller
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3. Check the MediaLED status to ensure it is safe to remove the IDE/CF—that is, 
ensure that the MediaLED is green (or off if the Taurus is not powered).

Do not remove the IDE/CF if the MediaLED is red.

4. Gently pull on the end of the IDE/CF to remove it.

5. Gently insert the replacement IDE/CF.

Note The media door is keyed such that it can be closed only if it is positioned 
correctly. Ensure the door is inserted right-side up before you try to close 
it.

6. Close the media door before the data buffer fills: Push the media door in place and 
twist the door knob clockwise to the locked position (horizontal). Rotate the black 
plastic lever down so that it lies flat against the door.
Closing the media door will start the Controller.

If you want to start the display, press the centre key for about 1 second. The dis-
play will start up once the Controller has finished booting.

The Store options for the replacement medium generally include the following:
If the active medium contains a Store, the Taurus will append data to that Store 
automatically. If the Store was created on a different Taurus, is recommended that 
you delete the existing Store and create a new one (Section 10.2.2 on page 97).
If the medium is not formatted to Ext3, you can format it and create a new Store 
(Section 10.3.2).
If the active medium is formatted to Ext3 but does not yet contain a Store, the Tau-
rus will create one automatically using the last Store configuration settings (see 
also Section 10.2.1 on page 95).

Figure 10-4  Open the media door

Figure 10-5  Replacing the recording media

Ensure that the MediaLED is green (or off), 
indicating that it is safe to remove or insert media.
Taurus Portable Seismograph
User Guide100 15148R5

2007-02-09



Chapter 10: Recording Data
10.3.2   Format recording media

Formatting is not necessary for media shipped from Nanometrics; these are preformat-
ted to Linux Ext3.

You can use the Taurus to format media from a different filesystem format to Ext3, and 
to reformat used media that are already formatted to Ext3. Which procedure you can 
use depends on whether one or both media types are inserted in the Taurus, which 
medium is the active one, and whether the media are already formatted to Ext3 (Table 
10-1). The active medium is the one the Taurus is currently configured to use for 
recording data.

Formatting will destroy all existing data and partition information on the medium. (The 
Taurus will create two directories on the medium immediately after completing the for-
matting: /mnt/mediaType/logs and /mnt/mediaType/store.)

10.3.2.1    Format unformatted media

For unformatted media, the Taurus will indicate that media are either not available or 
are not formatted, and will provide different options depending on media status (Figure 
10-6).

Table 10-1  Media formatting options

Media installed Options for formatting media on the Taurus

One formatted, 
active medium

You cannot format the active medium if it is already formatted. 
(Optionally, delete the active Store and create a new one if you want 
to reuse the medium; see Section 10-2 on page 98.)

One formatted, 
inactive medium

You can format the inactive medium whether or not it is already 
formatted.

Two formatted
(one active, one 
inactive)

You can format the inactive medium whether or not it is already 
formatted. You cannot format the active medium if it is already 
formatted. Therefore, to format the currently active medium, first 
Switch Media to the other medium (Section 10.3.3 on page 104).

Unformatted media If you click Format MediaType for an inserted medium, the Taurus 
will detect and then format it. If there are media inserted in both 
slots, the Taurus will format the MediaType you selected and leave 
the other medium unformatted.
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1. Shut down the Controller (Shutdown – Shutdown) and insert the media you want 
to format. See Section 10.3.1 “Insert and remove recording media” on page 99 for 
procedure details.

Do not remove or insert media if the MediaLED is red. Wait until the Control-
ler has shut down and the MediaLED is green.

After you have closed the media door the Controller will boot automatically.

2. Go to the Store Tools page and log in if required. The Taurus will indicate that 
unformatted media are either not available or are not formatted.
(Store tools to format and to switch media are available without logging in if the 
currently active media type is not present or not formatted—that is, Active Media 
is None. Once you have formatted or switched media, you will have to log in to 
access Store tools.)

3. Click Format MediaType for the medium you want to format.
• If this is the currently active media type, the Taurus will format the medium 

and create a Store using the last Store configuration settings (see also Section 
10.2.1 on page 95). The Taurus will start recording to it automatically.

• If this is the currently inactive media type, the Taurus leaves it as the inactive 
medium after formatting it.

If you want to record to the currently inactive medium, after formatting is 
complete click Switch Media and choose a Store Size.

10.3.2.2    Format previously formatted media

For formatted media in the active slot, the Taurus will show Store information. For for-
matted media in the inactive slot, the Taurus will indicate that the media are available. 
Different options will be available depending on media status (Figure 10-7).

Figure 10-6  Unformatted media options
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For media that are already formatted to Ext3, you can format the inactive medium only, 
If you want to reformat the active medium, you can install both media types, switch to 
the other medium, then format.

If you just want to reuse a medium with an old Store and do not need to reformat it, you 
can delete the Store and create a new one; see Section 10-2 on page 98.

1. If you need to insert the medium you want to format, first shut down the Controller 
(Shutdown – Shutdown). See Section 10.3.1 “Insert and remove recording media” 
on page 99 for procedure details.

Do not remove or insert media if the MediaLED is red. Wait until the Control-
ler has shut down and the MediaLED is green.

After you have closed the media door the Controller will boot automatically.

2. Log in and go to the Store Tools page.
If you want to reformat the currently active medium, first choose Switch 
Media.

3. Click Format MediaType. You will be prompted for confirmation.
To exit the page without formatting the medium, either click the Store Tools 
Menu button or choose another page from the main menu.

4. To format the medium, click Proceed.

If you choose Switch Media after formatting is completed (Section 10.3.3), you will 
be prompted to choose the new Store capacity from the list of available options.

Figure 10-7  Formatted media options
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10.3.3   Switch recording to the other medium

If you have media installed in both slots, you have the option to switch to the inactive 
medium if it is already formatted.

Note Switch Media will commit the new Store configuration (size, media type) 
and will also commit any other applied changes made in the Configuration 
or Advanced Configuration pages.

1. Log in and go to the Store Tools page.

2. Click Switch Media. (To exit the page without switching to the inactive medium, 
either click the Store Tools Menu button or choose another page from the main 
menu.)
There will be two options, depending on whether there is a Store on the medium:
• If there is no Store on the formatted inactive medium, you will be prompted to 

create one.
Choose a capacity for the new Store from the Store Size drop-down list.

• If a Store already exists on the inactive medium, you will be prompted to con-
firm whether you want to use that Store. The Taurus will append data to that 
Store (see also Section 10.2.1.1 “About appended Stores” on page 96).

If you do not want to append data to the existing Store you can either delete 
the Store after you have switched media, or format the inactive medium 
before you choose Switch Media. Formatting will destroy all data and par-
tition information on the medium.

3. Click Proceed.

Figure 10-8  Switch media and create a new Store
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Chapter 11 Accessing Data

This chapter provides an overview of general methods for accessing data from Taurus 
Stores, and procedures for retrieving specific types of data.

11.1  General options for accessing data
Time-series data, and SOH, system configuration, and log information are stored in the 
Nanometrics Store. You can extract data from the Store to various standard formats 
using the data retrieval options. Data can be extracted over an IP connection from the 
Taurus. With the Apollo Light utility, you can extract data from a Store copied to your 
PC or directly off media inserted in a media reader. Time-series data may also be 
streamed to an acquisition server while the Taurus is in Communications mode.

One data retrieval request can be run at a time. Any subsequent retrieval requests will 
be processed when the current download is finished. You can run a data retrieval 
request concurrent with data streaming to an acquisition server.

11.1.1   Viewing data in near-real time

If the Taurus is in Communications or Interactive mode, you can view time-series 
waveforms and some SOH information in near-real time. The lag is the page refresh 
rate (usually 5s) plus the Post Data Interval (factory default 2s).

Viewing waveforms – Waveforms in near-real time are shown on the Status page, 
Waveform page, and Sensor page.
You can select waveform scaling options on the Waveform and Sensor pages (see 
Table H-2 on page 180 for a description). On the Waveform page only, the scaling 
presently in use is shown on the upper right of the waveform. After about 1 minute 
from startup of the Controller or following a change in the sample rate, the wave-
form will show AC RMS and DC average. On a single-waveform display, the min-
imum and maximum values of the visible data are also shown as a numeric value.
• S = vertical scale of the channel window
• MIN = smallest sample value of the samples
• MAX = largest sample value of the samples
Viewing SOH status – Current state of health (SOH) information is shown in sev-
eral locations. See Section 3.8.4 “Pages showing current status information” on 
page 29.
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11.1.2   Checking availability of data

The Data Availability pages provide options for viewing summaries and details of 
availability ranges and any gaps.

See Section H.6 on page 181 for a description of the Data Availability page 
options.

11.1.3   Extracting data to files with the Data Retrieval pages

You can extract data from the Taurus via a browser over an IP connection. Use the Data 
Retrieval pages to set the data extraction options, described in the sections listed:

Time-series data to MiniSEED, Seisan, or ASCII, delimited by time selections 
(Section 11.2.1 on page 109).
Time-series data to MiniSEED, Seisan, or ASCII, delimited automatically using 
uploaded event information (Section 11.2.2 on page 111).
SOH data and triggers to .csv files (Section 11.3.1 on page 116).
System logs to a .log file (Section 11.3.2 on page 119).
Configuration audit trail to a .cfg file (Section 11.3.3 on page 119).

11.1.3.1    Navigate Data Retrieval pages

Options you have chosen on data retrieval pages are stored in a temporary cache. If you 
use browser options or main menu selections to navigate, your changes will be dis-
carded. Use these navigation options to preserve your changes:

Use the Next button to navigate away from a Data Retrieval page within a session. 
This is comparable to the Previous button for configuration sessions (see Table H-
12 “Advanced Configuration page options” on page 191).

The Current Choices hyperlinks will open other pages within a session, for exam-
ple if you want to go back to a page and edit a setting. If you make changes to the 
page always use the Next button to continue, not another Current Choices link, to 
ensure the new changes are preserved.

Figure 11-1  Data Retrieval main page
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11.1.3.2    Confirm Playback settings

Ensure that the network, station, and channel information is correct for the data you 
want to extract. Playback information is used in extracted time-series data file head-
ings, and in the default file names for all types of extracted data.

You can change the Playback information temporarily for the current data retrieval ses-
sion, or change the default for all downloads as a change to the Taurus configuration.

11.1.3.2.1    Change the Playback settings for the current data extraction

In a data retrieval page, click the Current Choices – Change Station Info link and 
edit the settings for downloads in the current session (Figure 11-4). Click Next.

11.1.3.2.2    Change the Playback configuration for the Taurus

1. Log in as tech or central.

Figure 11-2  Data Retrieval page navigation

Use the Next button and 
the Current Choices links 
to navigate in a session.

Figure 11-3  Edit Station Info for the current download session
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2. In the Advanced Configuration > Playback page (Figure 11-4), you can edit the 
default Playback settings for all data extract sessions.

3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

11.1.3.3    Initial setup for extracting to Seisan format

The first time you extract data using the Seisan format option on the Data Retrieval 
download page, you must install the storeDataToSeisan conversion program on 
your PC.

1. Ensure that you have Seisan installed on your PC, with these settings:
• The environment variable SEISAN_TOP must be set.
• For each station you will be decoding you must add to the 

DAT/SEISAN.DEF file two lines, a WAVEFORM_BASE and CONT_BASE. 
For example, for STN01:

2. On the Data Retrieval download page for Seisan format, click the “Download it” 
link and then save the file storeDataToSeisan.zip to your PC. It includes 
installation and usage instructions in the file 
install_storeDataToSeisan.txt.

3. Unzip the files to c:\nmx\bin or /nmx/bin (depending on platform).

4. The first time you download a Seisan file, in the browser download window 
choose Open, and choose the program to open it with as storeDataTo-
Seisan.bat or storeDataToSeisan.sh (depending on platform).

If running under Linux/Unix, you will have to use chmod to change the per-
missions of the .sh file to make it executable.

Subsequent downloads to Seisan format will run the conversion automatically if you 
choose Open it with the default application (or equivalent) in the browser download 
window. (Save will save the file with the extension .ms2seisan; you can run the 
conversion program on this file; for example, double-click on the file.)

The conversion logs are written to the file StoreDataToSeisan_yyyymmdd.log 
in C:\nmx\user or /nmx/user (depending on platform).

Figure 11-4  Playback configuration page

WAVEFORM_BASE Waveform base name STN01

CONT_BASE REA continuous base STN01
Taurus Portable Seismograph
User Guide108 15148R5

2007-02-09



Chapter 11: Accessing Data
11.1.4   Accessing Store files on the recording media with your PC

The Taurus media are formatted to use the Linux Ext3 file system. You can copy the 
files to your PC from the Taurus via a means such as FTP. You can access and copy the 
files on removed media with a media reader such as a Nanometrics Hard Drive Reader 
or a third-party CompactFlash reader.

All of the Store files must be present in the same directory if you want to view or 
extract data. (For example, on the Taurus media in a media reader connected to 
your PC, or copied to a directory on your PC).

If you want to extract data from a copied Store or from a Store on removed 
media, use Apollo Light (see Appendix F).

You can transfer the files from the Taurus to your PC via a means such as FTP. 
Ensure FTP is set to binary transfer.

If you are using a media reader on Linux, note that some Linux versions will not 
detect a removable hard drive or CompactFlash card if the PC was not booted with 
the device attached. After booting with the removable HD or CF, they can be 
removed and exchanged for other media which will be detected.

If you are using a media reader on Windows there are various third-party utilities 
available for you to access the files directly; for example, Ext2IFS and Explore2fs.

Ext2 Installable File System For Windows (Ext2IFS) provides a file system 
driver to include Ext3 volumes as fully accessible drives on Windows filesys-
tems, and a control panel item for assigning drive letters to Ext3 volumes 
(http://www.fs-driver.org/index.html).
Explore2fs provides an Explorer-type graphical user interface for reading files 
and for copying files from an Ext3 file system
(http://uranus.it.swin.edu.au/~jn/linux/explore2fs-old.htm for general informa-
tion, and http://www.chrysocome.net/explore2fs for software updates).

Caution As of Explore2fs version 1.07 do not drag and drop a 1GB file from the 
medium as this will allocate 1GB of shared memory on the PC. Use 
the File > Save As menu option instead. The Save As option supports 
saving of multiple files.

11.2  Retrieving time-series data
You can retrieve time-series data from a Store (either from the Taurus directly or from 
removed media) by extracting it to a file in MiniSEED, Seisan, or ASCII format. You 
can also stream time-series data from the Taurus to a central acquisition server, for 
example to write the data to NAQS ringbuffers.

Note Trigger information is available as an SOH download (Section 11.3.1.1 on 
page 118).

11.2.1   Extract time-series data to a file

You can extract time-series data from a Store to various formats. This procedure 
describes data extraction using the Data Retrieval > Time Series page options.
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1. On a browser over an IP connection, choose Data Retrieval from the menu.

2. Choose Time Series, then click Next. Available channels are listed with the data 
time ranges.

3. Click to select one or more channels, then click Next. This opens a page with 
options to select the start date and time, and duration of the data to download.

4. Set the time parameters, then click Next. This opens a page with options to select 
the data format.

5. You can extract the data to a file in any of 3 formats:
• MiniSEED – The extracted file uses a 512 byte Data Record Length.

The current version cannot download more than 488MB of data in Mini-
SEED format. Use multiple downloads for quantities of data that exceed 
488MB.

• Seisan – Extracted files have been tested with Seisan 8.0.
The current version cannot download more than 488MB of data in Seisan 
format. Use multiple downloads for quantities of data that exceed 488MB.
Seisan downloads use a conversion tool that you install on your PC from the 
Taurus on the initial download (see Section 11.1.3.3 “Initial setup for 
extracting to Seisan format” on page 108).
Subsequent downloads to Seisan format will run the conversion automati-
cally if you choose “Open it with the default application” (or equivalent) in 
the browser download window. (Save will save the file with the extension 
.ms2seisan; you can run the conversion program on this file; for exam-
ple, double-click on the file.)

• ASCII

6. Review the settings you have chosen and either download using these settings or 
change the settings:

Click Download to save the data to a file using the current settings:
For MiniSEED and ASCII formats, save the file to your PC.
For Seisan, open the file. This will run the conversion program and save the 
file to a Seisan REA subdirectory for that station (for example, 
C:\Seismo\REA\STN01\2005\10).

To change the settings, click the link to return to the appropriate settings page, 
change the settings, then click Next to proceed through the settings pages to the 
Download page. For time-series data, settings pages and the corresponding 
links include:

Change Data Type – Choose a different data type to download.
Change Channel – Choose one or more time-series channels.
Change Time – Choose a different start date, time, and duration. You can 
see available times under Show Available Times.
Change Format – Choose ASCII, Seisan, or MiniSEED format for the 
downloaded data.
Change Station Info – Edit station information that will be used in the 
downloaded data file headers. You can change Network Name, Station 
Name, and Channel Names.
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Use Clear All Choices if you want to deselect all of the current settings delimit-
ing the data, and return to the Data Retrieval main page.

11.2.2   Extract seismic data to a file by event from an event list

You can retrieve seismic data from a Taurus using information from an event list. This 
procedure describes data extraction using the Data Retrieval > Time Series By Event 
page options. The event list may be a file that you upload to the Taurus—for example, 
a list of events from third-party Internet sites—or information for a single event that 
you enter into a form.

The Taurus calculates arrival times for various phases that are applicable to the event 
selected. Supported phases include P, S, Pn, Sn, PKiKP, SKiKS, PcP, ScS, PKP, SKS, 
Pdiff, and Sdiff. Travel time tables are used to calculate the estimated time it takes a 
seismic wave to travel distance from a seismic event to a specified location. This is used 
to determine what data to download for a known teleseismic event. The travel time 
tables used in Taurus and Apollo are calculated using the Tau algorithm, using the 
TauP Java Package (http://www.seis.sc.edu). TauP outputs files for any velocity model 
the user wants. Taurus and Apollo use the IASPEI91 Default Model, which is com-
monly used for teleseismic events.

Note There are two potential issues with uploading NEIC Epic Search - Com-
pressed event files.

1) If you try to upload a very large file (containing hundreds of events) the 
browser may either take a very long time to load the file or may crash.

2) If the file contains any events that do not use the required date and 
time syntax, this will prevent the file from loading. (Only a small 
number of historic events might not use the required syntax.) Valid 
syntax options include the following, where the blocks of data are each 
separated by a single space:
YYYY
YYYY MM
YYYY MMDD
YYYY MMDD HH
YYYY MMDD HHmm

If you choose to edit the file, be careful to maintain the data column 
structure as validity is checked only for the date and time syntax.

1. On a browser over an IP connection, choose Data Retrieval from the menu.

2. Choose Time Series By Event, then click Next. Available channels are listed with 
the data time ranges.

3. Click to select one or more channels, then click Next. This opens a page with 
options to either upload an event list or enter information for an event manually 
into a form.

4. To upload an event list (Figure 11-5):
a) Choose the type of event list file to upload (click the radio button).
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b) Download the event list from the linked site and save it to your file system. 
Each link opens the relevant site search page in a new window. Options 
include:

IRIS Search - ASCII – The link opens http://www.iris.edu/quakes/event-
srch.htm. Do a search, then save using the ASCII Version link. Upload the 
ASCII version to Taurus.
NEIC Epic Search - Compressed – The link opens 
http://neic.usgs.gov/neis/epic/. Choose a search type (Global, Rectangular, 
or Circular), then choose option “2. Compressed File Format” for the output 
file type. Save and then upload the search to the Taurus as .html.
NEIC Finger – The link opens http://neic.usgs.gov/neis/finger/quake.asc. 
Save the document quake.asc and upload it to the Taurus.

c) Browse for the saved file and then click Upload to upload it to the Taurus.

d) Click Next to open the event list.
e) Choose an event of interest from the list (click the associated radio button), 

then click Next (Figure 11-6).

Figure 11-5  Download an event list file then Upload it to the Taurus
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5. To enter event information into the form:
a) Type the event information in the text fields:

Label – A name for the event, as an ASCII string of any length.
Time – Event time as an ASCII string of the format yyyy-MM-dd HH:mm:ss
Location/Depth(km) – The location of the event as a comma-separated list 
of the latitude, longitude, depth.

b) Click the radio button to select the event once you have filled in the event form 
fields, then click Next.

6. Select time by phase and related options (Figure 11-7):
• Pre Event Time – Number of seconds of data to download preceding the calcu-

lated start time.
• Start Phase – Available phases that you may choose to set a start time automat-

ically. Phase options are loaded according to what would be available for an 
event at that location relative to the Taurus location at the time the data were 
recorded.

• Post Event Time – Number of seconds of data to download following the calcu-
lated end time.

• End Phase – Available phases that you may choose to set an end time automat-
ically. Phase options are loaded according to what would be available for an 
event at that location relative to the Taurus location at the time the data were 
recorded.

Figure 11-6  Choose an event from an uploaded list
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7. Click Next to search the Taurus data for the event.
If there are no data for the selected event, you may choose to search for another 
event using the currently uploaded list. Under Current Choices, click the 
Change Event link to reopen the list.

8. If there are data for the event, you can extract it to a file of any of 3 formats:
• MiniSEED – The extracted file uses a 512 byte Data Record Length.

The current version cannot download more than 488MB of data in Mini-
SEED format. Use multiple downloads for quantities of data that exceed 
488MB.

• Seisan – Extracted files have been tested with Seisan 8.0.
The current version cannot download more than 488MB of data in Seisan 
format. Use multiple downloads for quantities of data that exceed 488MB.
Seisan downloads use a conversion tool that you install on your PC from the 
Taurus on the initial download (see Section 11.1.3.3 “Initial setup for 
extracting to Seisan format” on page 108).
Subsequent downloads to Seisan format will run the conversion automati-
cally if you choose “Open it with the default application” (or equivalent) in 
the browser download window. (Save will save the file with the extension 
.ms2seisan; you can run the conversion program on this file; for exam-
ple, double-click on the file.)

• ASCII

9. Review the settings you have chosen and either download using these settings or 
change the settings:

Click Download to save the data to a file using the current settings:
For MiniSEED and ASCII formats, save the file to your PC.
For Seisan, open the file. This will run the conversion program and save the 
file to a Seisan REA subdirectory for that station (for example, 
C:\Seismo\REA\STN01\2005\10).

To change the settings, click the link to return to the appropriate settings page, 
change the settings, then click Next to proceed through the settings pages to the 

Figure 11-7  Options to select time by phase for Taurus to search for the event
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Download page. For time series by event data, settings pages and the corre-
sponding links include:

Change Data Type – Choose a different data type to download.
Change Channel – Choose one or more time-series channels.
Change Time – Choose a different start date, time, and duration. (The initial 
time is set automatically on the Change Time By Phase page.) You can see 
available times under Show Available Times.
Change Time By Phase – Choose a start time and duration automatically 
using the available phase data uploaded with the event.
Change Format – Choose ASCII, Seisan, or MiniSEED format for the 
downloaded data.
Change Station Info – Edit station information that will be used in the 
downloaded data file headers. You can change Network Name, Station 
Name, and Channel Names.
Change Event – Choose a different event from the event list. (The page may 
take a minute to load if there is a large list of events.)

Use Clear All Choices if you want to deselect all of the current settings delimit-
ing the data, and return to the Data Retrieval main page. This will also delete 
the currently uploaded event file and event list.

11.2.3   Stream time-series data to a central acquisition server

You can stream time-series data from a Taurus to a central acquisition server, for exam-
ple to write the data to NAQS ringbuffers. To stream Taurus data to NAQS, the 
NpToNmxp utility must be running on the NAQS server.

Note If you have restarted NpToNmxp and you wish to ensure timely start of 
data packets from a Taurus running firmware version 2.x, then disable 
and enable streaming in the Taurus. (In the Advanced Configuration > 
Communications > Data Streaming page, disable Stream NP Packets , 
Apply the setting, enable Stream NP Packets , and Apply again.) Oth-
erwise it may take some time before the data begin streaming to NAQS, 
depending on how busy the Taurus Controller is processing queued 
requests.

1. Ensure that the Taurus is running in Communications mode (Section 3.1 on page 
17) and that the communications options are set as appropriate (Chapter 7 “Con-
figuring Taurus Communications”).

2. In the Advanced Configuration > Communications Data Streaming page, change 
these settings as appropriate:
• Stream NP Packets – Set Taurus to stream data to the specified destination; 

enabled , not enabled . Factory default is not enabled.
• IP Address – The address of the streaming destination (for example, a NAQS 

server); a valid IP address in dotted decimal format.
If you are streaming to NAQS you must have NpToNmxp running on the 
NAQS server. (See also the NpToNmxp User Guide, Nanometrics docu-
ment number 15648.)

• Port # – The port number used for NpToNmxp if the destination is a NAQS 
server. Factory default is 32004.
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3. To test the changes, click Apply. To make the changes permanent, click Commit. 
If so indicated by a UI message, activate the new configuration with a restart 
(Shutdown – Restart).

11.3  Retrieving other data
There are various other types of information besides time-series data that you can 
retrieve from the Taurus or a Store. Data that you can extract from the Store includes 
SOH, system logs, and configuration history. You can download additional informa-
tion from the Taurus, including system profile information and the current configura-
tion.

11.3.1   Extract State of Health data to a .csv file

You can extract various types of SOH data from a Store to .csv files. This procedure 
describes data extraction using the Data Retrieval page options.

Predefined sets of SOH data are provided in the drop-down list on the SOH Data page 
(Table 11-1 on page 117). Using the predefined SOH options rather than User Selected 
individual columns is the preferred method for those applicable SOH, as the predefined 
options in the list extract the relevant columns in context (for example, GPSTime 
parameters associated with Last update time). If you want to download an individual 
SOH data column, for example media door status, use the procedure as for Trigger data 
(Section 11.3.1.1 on page 118).

1. On a browser over an IP connection, choose Data Retrieval from the menu.

2. Choose State Of Health, then click Next.

3. Choose the SOH data set that you want to extract (Figure 11-8), then click Next.

4. Select the start date and time, and duration of the data to download, then click 
Next.

5. Review the settings you have chosen and either download using these settings or 
change the settings:

Click Download to save the data to a .csv file using the current settings.
To change the settings, click the link to return to the appropriate settings page, 
change the settings, then click Next to proceed through the settings pages to the 

Figure 11-8  Choose an SOH data set
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Download page. For SOH data, settings pages and the corresponding links 
include:

Change Data Type – Choose a different data type to download.
Change Time – Choose a different start date, time, and duration. You can 
see available times under Show Available Times.
Change SOH Data – Choose a different set of SOH data to download.

Use Clear All Choices if you want to deselect all of the current settings delimit-
ing the data, and return to the Data Retrieval main page.

Table 11-1  Predefined SOH downloads to .csv files

Predefined SOH download option SOH data

GPSTime • GPS receiver status
• Number of usable satellites
• PDOP
• TDOP
• System clock phase lock
• Time uncertainty
• DAC count
• Time error
• Last update time
The values for the 3 parameters Number of usable 
satellites, PDOP, and TDOP are provided by the GPS 
receiver at the Last update time. In order to see what 
time these 3 parameters correspond to, look at the 
Last update time. When GPS is off, these 3 parameters 
and Last update time are not updated. They show the 
last value continuously until the next update arrives 
(after the GPS is back on again).

GPSSatellites For each channel:
• Acquisition type
• Azimuth
• Elevation
• PRN
• Signal level
• Last update time

EnvironmentSOH • External SOH 1 (12-bit, voltage input)
• External SOH 2 (12-bit, voltage input)
• External SOH 3 (12-bit, voltage input)
• External SOH 4 (12-bit, voltage input)
• Sensor mass position channel 1
• Sensor mass position channel 2
• Sensor mass position channel 2

Instrument • Supply voltage
• Temperature
• NMXbus current (external connector)
• Sensor current
• Serial port current
• Controller current
• Digitizer current

PowerPC For each data band:
• Packet oldest sequence number
• Store space used
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11.3.1.1    Extract trigger data to a .csv file

Triggers are included as SOH data, which you can extract to a .csv file.

This procedure also applies to download of any individual columns of user-selected 
SOH, for example media door status. It is recommended that you use predefined down-
loads to extract certain SOH data in context as described in Section 11.3.1 on page 116.

1. On a browser over an IP connection, choose Data Retrieval from the menu.

2. Choose State Of Health, then click Next.

3. Leave the SOH type to download as User Selected(csv), and then choose Trigger 
from the Available Columns list (Figure 11-9). The Trigger option will be included 
in the SOH Available Columns list only if triggers have already been generated.

4. Click Add to add Trigger to the Selected Columns list (Figure 11-10). (Once an 
Available Column has been added to Selected Columns, additional options for 
moving selections is included.)

5. Click Next.

Figure 11-9  Choose Trigger as an individual SOH column

Figure 11-10  Selected Columns options
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6. Select the start date and time, and duration of the data to download, then click 
Next.

7. Review the settings you have chosen and either download using these settings or 
change the settings:

Click Download to save the data to a .csv file using the current settings.
To change the settings, click the link to return to the appropriate settings page, 
change the settings, then click Next to proceed through the settings pages to the 
Download page. For SOH data, settings pages and the corresponding links 
include:

Change Data Type – Choose a different data type to download.
Change Time – Choose a different start date, time, and duration. You can 
see available times under Show Available Times.
Change SOH Data – Choose a different set of SOH data to download.

Use Clear All Choices if you want to deselect all of the current settings delimit-
ing the data, and return to the Data Retrieval main page.

11.3.2   Extract system logs to a .log file

You can extract the system logs from a Store to a file in text format. The Apollo, DSP, 
and ARM logs are downloaded to one combined file. This procedure describes data 
extraction using the Data Retrieval page options.

1. On a browser over an IP connection, choose Data Retrieval from the menu.

2. Choose System Logs, then click Next. This opens a page with options to select the 
start date and time, and duration of the log information to download.

3. Set the time period parameters, then click Next. This opens a page listing the set-
tings you have chosen for this download.

4. Review the settings you have chosen and either download using these settings or 
change the settings:

Click Download to save the log information to a text file using the current set-
tings.
To change the settings, click the link to return to the appropriate settings page, 
change the settings, then click Next to proceed through the settings pages to the 
Download page. For system log information, settings pages and the corre-
sponding links include:

Change Data Type – Choose a different data type to download.
Change Time – Choose a different start date, time, and duration. You can 
see available times under Show Available Times.

Use Clear All Choices if you want to deselect all of the current settings delimit-
ing the data, and return to the Data Retrieval main page.

11.3.3   Download the configuration audit trail to a .cfg file

You can download the system configuration audit trail from a Store to a file in text for-
mat. The downloaded file is not a valid configuration for upload. This procedure 
describes data extraction using the Data Retrieval page options.
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1. On a browser over an IP connection, choose Data Retrieval from the menu.

2. Choose System Configuration, then click Next. This opens a page with options to 
select the start date and time, and duration of the log information to download.

3. Set the time period parameters, then click Next. This opens a page listing the set-
tings you have chosen for this download.

4. Review the settings you have chosen and either download using these settings or 
change the settings:

Click Download to save the log information to a text file using the current set-
tings.
To change the settings, click the link to return to the appropriate settings page, 
change the settings, then click Next to proceed through the settings pages to the 
Download page. For system configuration audit trail information, settings 
pages and the corresponding links include:

Change Data Type – Choose a different data type to download.
Change Time – Choose a different start date, time, and duration. You can 
see available times under Show Available Times.

Use Clear All Choices if you want to deselect all of the current settings delimit-
ing the data, and return to the Data Retrieval main page.

11.3.4   Download Taurus system information to a .id file

You can download system information, such as firmware and hardware version infor-
mation, from the Taurus to a text .id file.

In the System Info > Firmware page click the Download link, then select a destina-
tion and save the file.

11.3.5   Download the current configuration to a .cfg file

You can download the current configuration from the Taurus. The downloaded file is 
a valid configuration that can be uploaded to a Taurus. See Chapter 5 for general infor-
mation on working with the Taurus configuration.

Go to the Advanced Configuration page and click Download, then select a desti-
nation and save the file.
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Appendix A Specifications

A.1  Sensor inputs

A.2  Digitizer performance

Channels 3 standard (selectable 0, 1, 2, or 3 active)

Sampling Simultaneous

Hardware gain selection Software configurable 0.4, 1, 2, 4, 8
(peak-to-peak input range 40V, 16V, 8V, 4V, 2V)

Maximum input voltage range 40Vpp differential (at hardware gain = 0.4)

Maximum single-ended voltage ±1.56V, 3.12Vpp or ±3.6V, 7.2Vpp (selectable)
These limits apply to all gain settings.

Maximum common mode signal ±0.78V, 1.56Vpp or ±1.8V, 3.6Vpp (selectable)
These limits apply to all gain settings.

Nominal sensitivity 1 count/µV (at hardware gain = 1)

Input impedance Selectable low impedance (43.07kΩ ±0.2%) or high 
impedance (>9MΩ)

Type Proprietary high order sigma-delta

Digital filter 140dB attenuation at output Nyquist

Filter type Linear phase (consult factory for other options)

Dynamic range >141dB (maximum sine wave above shorted input level) at 100sps

Shorted input noise <1 counts RMS (of 24 bits) at 100sps

Sample rates 10, 20, 40, 50, 80, 100, 120, 200, 250, 500 sps

Software gain User configurable 0.001 to 100

High pass filter User configurable 0.001 to 1.0Hz
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A.3  Sensor support

A.4  Timing subsystem

A.5  State-Of-Health (SOH)

Sensor types Broadband active and short period passive

Control lines 6; typically used for Cal enable, mass centre, and mass lock/unlock. 
Logic level configurable:
• High: 5V, 12V, high impedance
• Low: 0V, high impedance

Mass position Mass position monitoring, ±10V range

Sensor power • Supply power pass-through to sensor (9V to 36V DC)
• Protected against short circuit
• Sensor power can be switched on/off from the user interface

Calibration signal • Ramped sine wave
• Pseudo-random binary
• Pulse signal

Calibration control User interface (local or remote)

Calibration mode Voltage or current

Serial interface Digital serial sensor managment interface for Nanometrics Trillium 
seismometers (feature planned for a future Taurus firmware release)

Timing system Internal VCXO clock disciplined to GPS

Timing accuracy <100µs

GPS receiver Internal 8 channel or 12 channel

GPS antenna External active antenna; 3.3V, 100mW

Duty cycle Software configurable

Continuously recorded SOH See also Table 11-1 on page 117
• Instrument
• Environment
• GPS and timing
• PowerPC

External SOH 4 analog SOH channels (12-bit, digitized), available for user-
defined purposes

Configuration Configuration audit trail

Log file All software-generated log messages are stored with the data
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A.6  Internal data storage

A.7  Data retrieval

A.8  Real-time data communication

A.9  Integrated UI

A.10  Software

Standard Removable, accessed via the media door
• CompactFlash – SanDisk Extreme Series; tested up to 4GB capacity 

with Taurus
• 1.8” IDE disk drive – 20GB to 60GB

Duration >600 days continuous recording, 3 channels @ 100sps on 40GB IDE 
drive (~30 days on 2GB CompactFlash)

Recording modes Continuous ringbuffer (overwrites oldest data)

File system Linux Ext3

Storage format Nanometrics Store. Streaming data output in Nanometrics NP format; 
extraction to MiniSEED, ASCII, Seisan

Media exchange Removable IDE hard drive or CompactFlash card

Download interfaces 10/100Base-T Ethernet, serial (SLIP or PPP)

Interfaces • 10/100Base-T Ethernet
• RS-232 serial. Port 1 has all RS-232 signals; Port 2 has Rx, Tx, RTS, CTS

Protocols • UDP/IP unicast/multicast
• HTTP (POST and GET)
• RS-232 serial with IP drivers

LEDs System status (tri-colour), Ethernet communication status, media write 
status

Colour display 240*320 colour graphics LCD display with backlight 3.5” diagonal

Input device 5-key navigation control for web interface

Operating system Embedded Linux

Applications software Nanometrics Apollo acquisition server with web interface
Taurus Portable Seismograph
User Guide

15148R5
2007-02-09 125



Appendix A: Specifications
A.11  Connectors
This section lists Taurus connector receptacle specifications and indicates appropriate 
mating plugs. See Appendix B for connector diagrams and pinout descriptions.

A.12  Ports

Sensor 26-socket, shell size 16, MIL-C-26482 Series 1
Mating connector MS3116J16-26P

GPS TNC female
Mating connector TNC male

Power 3-pin, shell size 8, MIL-C-26482 Series 1
Mating connector MS3116J8-3S

USB/Serial 19-socket, shell size 14, insert position W, MIL-C-26482 Series 1
Mating connector MS3116J14-19PW

Ethernet 4-socket, shell size 8, insert position W, MIL-C-26482 Series 1
Mating connector MS3116J8-4PW

SOH 7-socket, shell size 10, MIL-C-26482 Series 1
Mating connector MS3116J10-7P

NMXbus 4-pin, shell size 8, MIL-C-26482 Series 1
Mating connector MS3116J8-4S

USB Mini USB Type AB socket
Mating connector mini USB Type A or Type B plug

Ethernet 10/100Base-T port for remote configuration and IP packet 
forwarding

Serial • Serial Port 1: Rx, Tx, RTS, CTS, DTR, DSR, CD, RI
• Serial Port 2: Rx, Tx, RTS, CTS (data collection from serial 

devices)
• Serial device power (pass through supply voltage)

External state-of-health • 4 user-defined 12-bit channels
• Data rate: Configurable, options up to 1 sample per 5 seconds
• Input range for each channel: ±2.0V DC

• Uncalibrated accuracy: (Maximum offset error ±0.07V, maxi-
mum gain error 2%) or (Maximum error ±0.11V from –2V DC 
to +2V DC)

• SOH power: 3.3V DC regulated, 10mA maximum
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A.13  Power

A.14  Environmental

Supply input voltage 9V to 36V DC

Power consumption 
(average typical)

Typical configurations:
• Buffered mode; 12V, 3-channel @ 100sps, <100µsec timing 

precision:
• ~750mW recording to CF card
• ~800mW recording to IDE hard drive

• Communications mode; 12V, 3-channel @ 100sps, <100µsec 
timing precision, real-time Ethernet or serial communication:
• ~2.3W typical continuous recording to CF card

• Interactive mode; all systems operational including colour 
graphics display, continuous recording to hard drive
• ~3.3W

In any mode:
• For Input Impedance configured to High Impedance (high 

power), add 40mW
• For GPS configured to Always On, add 200mW

Protection Fuseless design with configurable low and high voltage 
disconnect, reverse protection, and short circuit protection

Isolation Supply power is isolated from signal ground

Earth Pre-drilled hole for M4 x 5 earth lug screw

Low/high voltage 
disconnect

Software configurable

Peripheral power output Typical over-current limit threshold
• Sensor (SEN_V+, SEN_RTN): 1000mA
• NMX Bus (NMXBUS, NMXBUS_RTN): 1000mA
• Serial (S_PWR+, S_PWR–): 750mA

Operating temperature For CompactFlash recording option:
• –20°C to 60°C
For IDE disk drive recording option:
• 5°C to 55°C

Storage temperature –40°C to 70°C

Humidity 0 to 100% non-condensing with media door closed, under 90% 
with media door open

Operating altitude For IDE hard drive, –60m to 3000m (–200 feet to 10000 feet). No 
limit for operating with CompactFlash card

Dimensions Width 147mm, Length 264mm, Depth 60mm

Weight 1.8kg

Construction Machined aluminum case

Weather resistance IP67 with media door closed, connectors occupied by the 
appropriate cable connector or sealed with the optional factory-
installed dust caps (Nanometrics part number 15762) or 
equivalent, and the self-sealing pressure relief screw torqued to 
hand-tight
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A.15  Regulatory compliance

Emissions EN55022:1998 / CISPR22:1997 (modified); FCC Part 15:2004, Subpart B, 
Class A

Immunity EN55024:1998 / CISPR24:1997 (modified)
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This appendix includes front face views of the Taurus connector receptacles and con-
nector pinout descriptions. See Section A.11 “Connectors” on page 126 for connector 
specifications.

Note The 4-pin connector above the IDE drive slot is for factory use only.
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B.1  Sensor

Figure B-1  Sensor connector receptacle
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Table B-1  Sensor connector pinout

Pin Name Function Details

U CH1+ Channel 1 input ±20V, differential

C CH1–

B CH1_GND Channel 1 ground/shield Connected to shield ground

A CH2+ Channel 2 input ±20V, differential

S CH2–

T CH2_GND Channel 2 ground/shield Connected to shield ground

a CH3+ Channel 3 input ±20V, differential

P CH3–

R CH3_GND Channel 3 ground/shield Connected to shield ground

K SEN_SOH1 Sensor state of health input 
signals

±10V, single-ended
Referenced to DGNDX SEN_SOH2

J SEN_SOH3

H SEN_CTRL1 Sensor control signal outputs 0V / 5V / 12V / high impedance
Referenced to DGNDW SEN_CTRL2

G SEN_CTRL3

N SEN_CAL1+ Sensor calibration signal outputs ±4.5V single ended
Referenced to DGND in voltage 
mode, and to CALn– in current 
mode

M SEN_CAL2+

L SEN_CAL3+

Z CAL1–/CTRL4 Sensor calibration signal return/ 
Sensor control signal outputs

Calibration signal return, or
0V / 5V / 12V / high impedance
Referenced to DGND

c CAL2–/CTRL5

Y CAL3–/CTRL6

V DGND Digital ground Digital ground

F SEN_V+ Sensor power supply Filtered, unregulated voltage

E SEN_V– Reserved for future use N/C

D SEN_RTN Sensor power return Switched, overcurrent protected

b CHGND Chassis
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B.2  GPS Antenna

B.3  Power

Figure B-2  GPS antenna connector receptacle

Table B-2  GPS antenna connector pinout

Pin Function

A GPS antenna signal and power

Shell GPS ground, isolated from Taurus chassis

Figure B-3  Power connector receptacle

Table B-3  Power connector pinout

Pin Function

A Raw (battery) power in (9V to 36V DC)

B Raw power supply earth

C Raw power return
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B.4  Serial/USB
Figure B-4  Serial/USB connector receptacle

Table B-4  Serial/USB connector pinout

Pin Name Function Details

P S1-RX Serial Port 1 receive RS-232

N S1-TX Serial Port 1 transmit RS-232

L S1-RTS Serial Port 1 RTS RS-232

D S1-CTS Serial Port 1 CTS RS-232

B S1-DTR Serial Port 1 DTR RS-232

C S1-DSR Serial Port 1 DSR RS-232

E S1-DCD Serial Port 1 carrier detect RS-232

R S1-RI Serial Port 1 ring indicator RS-232

V S_GND Serial Port ground

F S2-RX Serial Port 2 receive RS-232

G S2-TX Serial Port 2 transmit RS-232

H S2-CTS/GP_IN Serial Port 2 CTS /General purpose 
input

RS-232

S S2-RTS/GP_OUT Serial Port 2 RTS /General purpose 
output

RS-232

U USB_D+ Host USB data+

T USB_D- Host USB data –

K USB_VBUS USB power 5V, 100mA

J USB_GND USB ground

A S_PWR+ Power for serial devices Filtered, unregulated 
voltage, referenced to 
S_PWR–

M S_PWR– Power return Switched, overcurrent 
protected
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B.5  Ethernet

B.6  External SOH

Figure B-5  Ethernet connector receptacle

Table B-5  Ethernet connector pinout

Pin Function

A Ethernet MTL-3 Transmit +

B Ethernet MTL-3 Transmit –

C Ethernet MTL-3 Receive –

D Ethernet MTL-3 Receive +

Figure B-6  External SOH connector receptacle

Table B-6  External SOH connector pinout

Pin Function Details

A External SOH Port 1 ±2.5V DC, referenced to pin G (SOH_REF)

B External SOH Port 2

C External SOH Port 3

D External SOH Port 4

G External SOH reference Do not ground

E External SOH power 3.3V, 10mA

F External SOH power return
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B.7  NMXbus

B.8  USB
This refers to the mini USB connector socket in the media bay.

Figure B-7  NMXbus connector receptacle

Table B-7  NMXbus connector pinout

Pin Function

A NMXbus power and signal; filtered, unregulated voltage

B NMXbus power and signal return, switched, overcurrent protected

C NMXbus cable connection sense, referenced to NMXBUS_RTN

D NMXbus cable shield

Figure B-8  USB connector receptacle

Table B-8  USB connector pinout

Pin Function Details

1 Standard USB power +5V DC, 100mA

2 Data –

3 Data +

4 On-The-Go Sense

5 USB ground
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Appendix C Sensor-Digitizer 
Interconnection

This appendix describes considerations and requirements for connecting the Taurus to 
a seismometer, using the Nanometrics Trillium seismometers as an example. The prin-
ciples apply in general to connecting high-performance sensors to high-resolution dig-
itizers. Recommended sensor cable wiring for connecting the Taurus to various sensors 
is provided in Table C-3 on page 143.

Note The Taurus is designed for best dynamic range performance when used 
with sensors having differential outputs. See Section C.5 on page 142 for 
information on Digitizer operation with single-ended inputs.

C.1  Circuit description

C.1.1   Digitizer

High-resolution digitizers will always have differential input circuits, however they 
will differ in their input impedance, RF suppression and common-mode rejection. It is 
also important to determine whether or not the power supply is isolated.

The Nanometrics Taurus Digitizer input stage has an input impedance of 43.07kΩ (low 
impedance mode) or 9.4MΩ (high impedance mode). It has a typical common-mode 
range of approximately ±0.78V (low impedance mode) or ±1.8V (high impedance, 
high power mode) with respect to the case. The front end is designed with excellent RF 
suppression so that with properly designed cables, the Taurus can be operated in the 
presence of radios and cell phones. The Digitizer power supply is completely isolated 
from the rest of the electronics and the case.

The Digitizer also provides state-of-health inputs and control, calibration, and sensor 
power outputs.

C.1.2   Sensor

High-performance active seismometers will always have differential output stages. 
Other active sensors will sometimes have single-ended output stages. Passive seis-
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Appendix C: Sensor-Digitizer Interconnection
mometers have an isolated output coil. Active sensor power supplies may or may not 
be isolated.

The Trillium 240 output is a balanced differential output with a clip level of 16V peak-
to-peak and an output impedance of 300Ω (150Ω each output). The Trillium power 
supply is completely isolated from the rest of the electronics and the case.

The Trillium also provides mass position outputs and a calibration input. For the 
Trillium 40, active-low control inputs serve as calibration enables and to configure the 
output signals and short or long period frequency response. For the Trillium 120P and 
Trillium 240/240OBS models, these inputs are active-high.

C.2  Shielding
Sensor cables must be designed for good EMI shielding. This is most easily accom-
plished using double-shielded twisted-pair cable as shown in Figure C-1 and Figure C-
2.

The twisted pairs provide magnetic shielding, an inner shield grounded at the digitizer 
provides good electric field shielding, and a continuous outer shield provides good 
high-frequency RF shielding. The outer shield must be earthed for safety.

C.3  Grounding

C.3.1   General considerations

The digitizer and sensor cases must always have a low-resistance path to ground for 
safety. However, directly earthing both instruments will result in a ground loop. When 
the digitizer and sensor are far apart differences in ground potential will cause spurious 
signals to appear unless the loop is broken. The solution is therefore to either earth the 
digitizer case and isolate the sensor case or vice versa.

Usually the simplest solution is to earth the digitizer as shown in Figure C-1 and Figure 
C-2. A hole pre-drilled for an M4 x 5 screw is provided on the side of the Taurus case 
for this purpose (Figure 4-2 on page 36). Trillium has stainless steel adjustable feet 
which when mounted directly onto dry rock or concrete provide a high resistance to 
ground. In wet environments it may be necessary to mount the sensor on a plate of glass 
embedded in sand, or to choose to earth the sensor and isolate the digitizer case.

Some sensors may have no chassis connection at the connector. In this case the sensor 
and digitizer must be separately earthed.

In the wiring lists in this Appendix, P1 is the sensor connector and P2 is the digitizer 
connector. The “run” and “colour” columns are used to indicate which signals are 
paired together and how the shields are connected. In particular, “drain” means the 
drain wire of the shield of the twisted pair indicated in the run column and “braid” 
means the overall braided shield of the cable.
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Appendix C: Sensor-Digitizer Interconnection
C.3.2   Passive sensors

For a passive sensor connect the output and calibration coils as shown in Figure C-1 
and Table C-1.

Note that the 4.7MΩ input resistors at the input of the Digitizer ensure that the com-
mon-mode voltage will be negligible.

Figure C-1  Typical passive sensor cable design

Table C-1  Typical passive sensor wiring list 

From To
Colour Run

Conn Pin*

* Pinout will depend on the passive sensor that is selected.

Name Conn Pin Name

P1 COIL+ P2 U CH1+ RED 1

P1 COIL– P2 C CH1– BLK 1

P2 B CH1_GND DRAIN 1

P1 CAL+ P2 N SEN_CAL1+ WHT 2

P1 CAL– P2 Z CAL1–/CTRL4 BLK 2

P1 SHELL P2 b CHGND DRAIN 2

P1 SHELL P2 b CHGND BRAID

33k6
0.2%

4M7

4M7 4k7
0.1%

4k7
0.1%

COIL+

COIL-

SHELL

CAL+

CH1+

CH1-

CH1_GND

CAL+

DGND

SEN_V+
SEN_RTN

CHASSIS
SENSOR TAURUS

CAL-
CTRLCAL-

PWR
PWR_RTN

RCOIL

RCAL

Not present in high impedance
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Appendix C: Sensor-Digitizer Interconnection
C.3.3   Active sensors

For an active sensor with a differential output a typical cable design is shown in Figure 
C-2. Note that, for simplicity, one channel only is shown and the mass position state-
of-health connections have been omitted.

A typical wiring list is given in Table C-2. Pinouts given are for the Trillium and the 
Taurus.

When either of the sensor or digitizer power supplies are isolated, there is nothing to 
constrain the common-mode voltage of the sensor outputs with respect to the digitizer 
ground. For optimal shielding performance the digitizer channel grounds are connected 
to the drain wires of the inner shields at one end of the cable only. Therefore it is of 
critical importance that the analog ground of the sensor (AGND) be separately con-
nected to the analog ground of the digitizer (CH1_GND). The other two digitizer chan-
nel grounds (CH2_GND and CH3_GND) should only be connected to their respective 
shield drain wires and not to AGND.

The control signal reference (CTRL_REF) serves as the reference voltage for all of the 
Trillium control signals (U_CALEN, V_CALEN, W_CALEN, UVW and MC). This 
should be connected to the appropriate ground for the control signal outputs on the dig-
itizer. In the case of the digitizer this is the digital ground (DGND).

Figure C-2  Typical active sensor cable design

33k6
0.2%

4M7

4M7 4k7
0.1%

4k7
0.1%

Z+

Z-

SHELL

CAL_SIG

CH1+

CH1-

CH1_GND

CAL+

DGND

SEN_V+

SEN_RTN

CHASSIS
TAURUS

CAL-
CTRL

CALEN
UVW
MC/RX

PWR
PWR_RTN

Not present in high impedance

RS/2

RS/2

RCC

+V

RCAL

SENSOR

+V

-V

+PWR

-PWR

AGND

CTRL_REF
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Appendix C: Sensor-Digitizer Interconnection
Table C-2  Typical active sensor wiring list 

From To
Colour*

* Depends on cable type; this example shows Nanometrics cable 13050-x

Run
Conn Pin Name Conn Pin Name

P1 L Z+/W+ P2 U CH1+ RED 1

P1 M Z–/W– P2 C CH1– BLK 1

P2 B CH1_GND DRAIN 1

P1 N Y+/V+ P2 A CH2+ WHT 2

P1 A Y–/V– P2 S CH2– BLK 2

P2 T CH2_GND DRAIN 2

P1 P X+/U+ P2 a CH3+ GRN 3

P1 B X–/U– P2 P CH3– BLK 3

P2 R CH3_GND DRAIN 3

P1 T CAL_SIG P2 N CAL1+ BLU 4

P1 U W_CALEN P2 Z CAL1–/CTRL4 BLK 4

P1 SHELL P2 SHELL DRAIN 4

P1 J V_CALEN P2 c CAL2–/CTRL5 YEL 5

P1 K U_CALEN P2 Y CAL3–/CTRL6 BLK 5

P1 SHELL P2 SHELL DRAIN 5

P1 S W_MP P2 K SEN_SOH1 BRN 6

P1 F V_MP P2 X SEN_SOH2 BLK 6

P1 SHELL P2 SHELL DRAIN 6

P1 E U_MP P2 J SEN_SOH3 ORG 7

P1 V AGND P2 B CH1 GND BLK 7

P1 SHELL P2 SHELL DRAIN 7

P1 H +PWR P2 F SEN_V+ RED 8

P1 G –PWR P2 D SEN_RTN WHT 8

P1 SHELL P2 SHELL DRAIN 8

P1 D UVW/TX P2 H CTRL1 RED 9

P1 C MC/RX P2 W CTRL2 GRN 9

P1 R CTRL_REF P2 V DGND DRAIN 9

P1 SHELL P2 b CHGND BRAID

P2 N CAL1+ P2 M CAL2+

P2 M CAL2+ P2 L CAL3+
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Appendix C: Sensor-Digitizer Interconnection
C.4  Other considerations
Some other factors to consider when designing sensor cables:

Ensure that the cable length does not exceed sensor requirements for capacitive 
loading.

Ensure that the peak current requirement of the sensor does not result in a voltage 
drop along the cable which takes the power supply voltage below the minimum 
required at the sensor.

Ensure the cable is watertight.

Check the cable electrically after assembly. In particular, ensure that the individual 
and overall shields are not shorted together unless so specified.

Make sure cables are labelled with correct drawing numbers and revisions.

Make sure the digitizer is configured so that the default states of the control lines 
put the sensor in the state you want it to be in.

C.5  Digitizer operation with single-ended inputs
The Taurus is designed for best dynamic range performance when used with sensors 
having differential outputs. Over a limited voltage range common-mode signal compo-
nents, such as unwanted noise induced into the input cable are rejected. However, com-
mon-mode signals greater than ±0.78V with respect to chassis ground cause distortion. 
Maximum single-ended signal before distortion is:
2*maximum common-mode signal = 2*0.78 = 1.56V.

Common mode range can be extended by using high impedance, high power mode.

C.5.1   Input range and gain for a single-ended signal

A single-ended signal can be considered as the sum of differential and common-mode 
signals.

Assume Vcm is the common-mode input (to both +ve and –ve terminals) and 
+Vdif  /2 and –Vdif /2 are the differential inputs. If these are the components to a single-
ended signal, and the –ve terminal is connected to GND return, then
Vcm + (–Vdif /2) = 0. Therefore, Vcm = Vdif /2.
At the +ve terminal, with Vcm + Vdif /2 referred to GND, the differential input is
(Vcm + Vdif /2) – (Vcm +(–Vdif /2)) = Vdif.

Therefore, gain to a single-ended signal is the same for differential and the common-
mode component is half of the single-ended input.

C.6  Sensor cable wiring lists
Table C-3 provides guidelines for sensor cable wiring for connecting Taurus to various 
sensor types. Confirm the pinout for your sensor using information from the sensor 
manufacturer before building your cable.
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Appendix C: Sensor-Digitizer Interconnection
Table C-3  Sensor cable wiring lists
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Appendix D Filter Response

D.1  Response overview
Analog signals connected to the Digitizer module are filtered using a first order low 
pass antialias filter before being sampled at 30kHz. This data is later low pass filtered 
and decimated, using a 3 to 4 stage FIR filter, to the output sample rate. Depending on 
the requested sample rate, different filters are used and a different number of filter 
stages are required. The output bandwidth will always be 0.4 times the output sample 
rate.

The low frequency response is also configurable using the DC removal IIR filter. With 
the DC removal filter enabled it can be set to a number of predetermined frequencies. 
With no DC removal filter DC signals are preserved.

D.2  System filter values
This section describes the transfer functions of the Digitizer module components.

D.2.1   Analog low pass antialias filter

The analog antialias filter is a first order low pass filter, with a corner frequency that is 
dependent on whether the Taurus input impedance is set to low impedance (Low-Z) or 
high impedance (High-Z).

D.2.1.1    Transfer function

(EQ 1)

where F

and  for low impedance mode

and  for high impedance mode

F jω( )
1

R C jω⋅ ⋅ 1+
--------------------------------=

C 1.0 10 8–×=

R 1
1

33600
--------------- 1

9600 Z+
---------------------+

-------------------------------------------Ω=

R 9600 ZΩ+=
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Appendix D: Filter Response
where Z is the sensor’s output impedance.

The corner frequency  is therefore

Hz (EQ 2)

If the sensor output impedance is negligible,

 = 2132Hz in low impedance mode

 = 1659Hz in high impedance mode

D.2.2   Digital IIR high pass filter

The digital IIR high pass filter is used for the optional DC removal feature. DC 
removal, if used, is applied after the digital FIR filtering.

D.2.2.1    Transfer function

(EQ 3)

where
y(n) is the current output sample
K is the filter gain
x(n) is the current input sample
x(n-1) is the previous input sample
F1 is the filter coefficient
y(n-1) is the previous output sample

D.2.2.2    Coefficients

The IIR filter is implemented as a first order IIR filter using the following coefficients 
calculated at runtime:

(EQ 4)

(EQ 5)

where:
 is the output sample rate

f is the 3dB corner frequency of the filter

f0

f0
1

2πRC
---------------=

f0

f0

y n( ) K x n( ) x n 1–( )–[ ]⋅ F1 y n 1–( )⋅+=

F1

1 π f⋅
FS
--------⎝ ⎠

⎛ ⎞–

1 π f⋅
FS
--------⎝ ⎠

⎛ ⎞+
--------------------------=

K 1

1 π f⋅
FS
--------⎝ ⎠

⎛ ⎞+
--------------------------=

FS
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Appendix D: Filter Response
The time constant (TC) of the filter can be calculated as follows:

(EQ 6)

D.2.3   Digital FIR low pass filters

The 3 to 4 stage digital FIR filter low pass-filters and decimates the data to the output 
sample rate.

D.2.3.1    Transfer function

(EQ 7)

where:
y(n) is the output sample
x(n-i) is an input sample
c(i) is a FIR coefficient
N is the number of coefficients

D.2.3.2    Coefficients

Table D-1 on page 148 shows the individual digital filter stages and associated decima-
tion for each output sample rate, and the cumulative filter delay. You may obtain the 
filter coefficient sets from the file Taurus_FIR_filter_coefficients.txt 
included with the Taurus software. You may also obtain these values by running the 
utility Tresponse (see the Data Playback manual, Nanometrics document number 
14548).

TC 1
2π f⋅
------------=

y n( ) c i( ) x n i–( )⋅

i 0=

N 1–

∑=
Taurus Portable Seismograph
User Guide

15148R5
2007-02-09 147



Appendix D: Filter Response
Table D-1  Digital filter stages and associated decimation for each output sample rate 

Output 
Sample 

Rate
Filter Parameter

Stage Cumulative 
Filter Delay 
(seconds)1 2 3 4

10
# of Coefficients 213 177 113 223

6.172200
Decimation 20 15 5 2

20
# of Coefficients 165 187 113 223

3.104233
Decimation 15 10 5 2

40
# of Coefficients 177 71 113 223

1.547933
Decimation 15 5 5 2

50
# of Coefficients 203 245 223 —

1.194700
Decimation 20 15 2 —

80
# of Coefficients 165 63 497 —

0.638233
Decimation 15 5 5 —

100
# of Coefficients 165 187 223 —

0.604233
Decimation 15 10 2 —

120
# of Coefficients 59 69 113 223

0.515800
Decimation 5 5 5 2

200
# of Coefficients 173 95 223 —

0.303867
Decimation 15 5 2 —

250
# of Coefficients 187 73 223 —

0.243100
Decimation 15 4 2 —

500
# of Coefficients 123 65 223 —

0.123700
Decimation 10 3 2 —
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Appendix E Open Source/Free 
Software Information

The Taurus software includes open source/free software components (see Table E-1). 
License information for each such component is included in the sections as indicated. 
You may request from Nanometrics the source code for derived components (see 
Chapter 1 “Introduction” for contact information); the remaining open source code may 
be obtained from the original developers.

E.1  Availability of open source/free software components

E.2  Apache License
Apache License

Table E-1  List of open source/free software components

Software component Source code available
from Nanometrics? See this section for license information

Das U-Boot yes Section E.4 “GNU-GPL” on page 152

Epson video driver yes Section E.4 “GNU-GPL” on page 152

JFFS2 driver yes Section E.4 “GNU-GPL” on page 152

Konqueror Embedded yes Section E.4 “GNU-GPL” on page 152

Linux Kernel yes Section E.4 “GNU-GPL” on page 152

Qt Embedded Free yes Section E.4 “GNU-GPL” on page 152

Apache Commons FileUpload no Section E.2 “Apache License”

Bouncy Castle no Section E.3 “Bouncy Castle License” on page 152

Jetty no Section E.2 “Apache License”

lwIP no Section E.6 “Modified BSD License” on page 157

md5.js no Section E.5 “md5.js License (BSD License)” on 
page 157

OpenSSH no Section E.7 “OpenBSD License” on page 158
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Appendix E: Open Source/Free Software Information
Version 2.0, January 2004
http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.
"License" shall mean the terms and conditions for use, reproduction, and distribution as defined 
by Sections 1 through 9 of this document.
"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is 
granting the License.
"Legal Entity" shall mean the union of the acting entity and all other entities that control, are 
controlled by, or are under common control with that entity. For the purposes of this definition, 
"control" means (i) the power, direct or indirect, to cause the direction or management of such 
entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the 
outstanding shares, or (iii) beneficial ownership of such entity.
"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by 
this License.
"Source" form shall mean the preferred form for making modifications, including but not lim-
ited to software source code, documentation source, and configuration files.
"Object" form shall mean any form resulting from mechanical transformation or translation of 
a Source form, including but not limited to compiled object code, generated documentation, and 
conversions to other media types.
"Work" shall mean the work of authorship, whether in Source or Object form, made available 
under the License, as indicated by a copyright notice that is included in or attached to the work 
(an example is provided in the Appendix below).
"Derivative Works" shall mean any work, whether in Source or Object form, that is based on 
(or derived from) the Work and for which the editorial revisions, annotations, elaborations, or 
other modifications represent, as a whole, an original work of authorship. For the purposes of 
this License, Derivative Works shall not include works that remain separable from, or merely 
link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.
"Contribution" shall mean any work of authorship, including the original version of the Work 
and any modifications or additions to that Work or Derivative Works thereof, that is intention-
ally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual 
or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this 
definition, "submitted" means any form of electronic, verbal, or written communication sent to 
the Licensor or its representatives, including but not limited to communication on electronic 
mailing lists, source code control systems, and issue tracking systems that are managed by, or 
on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding 
communication that is conspicuously marked or otherwise designated in writing by the copy-
right owner as "Not a Contribution."
"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Con-
tribution has been received by Licensor and subsequently incorporated within the Work.
2. Grant of Copyright License. Subject to the terms and conditions of this License, each Con-
tributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, 
irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, pub-
licly perform, sublicense, and distribute the Work and such Derivative Works in Source or 
Object form.
3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor 
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevoca-
ble (except as stated in this section) patent license to make, have made, use, offer to sell, sell, 
import, and otherwise transfer the Work, where such license applies only to those patent claims 
licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or 
by combination of their Contribution(s) with the Work to which such Contribution(s) was sub-
mitted. If You institute patent litigation against any entity (including a cross-claim or counter-
claim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work 
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Appendix E: Open Source/Free Software Information
constitutes direct or contributory patent infringement, then any patent licenses granted to You 
under this License for that Work shall terminate as of the date such litigation is filed.
4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works 
thereof in any medium, with or without modifications, and in Source or Object form, provided 
that You meet the following conditions:
(a) You must give any other recipients of the Work or Derivative Works a copy of this License; 
and
(b) You must cause any modified files to carry prominent notices stating that You changed the 
files; and
(c) You must retain, in the Source form of any Derivative Works that You distribute, all copy-
right, patent, trademark, and attribution notices from the Source form of the Work, excluding 
those notices that do not pertain to any part of the Derivative Works; and
(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative 
Works that You distribute must include a readable copy of the attribution notices contained 
within such NOTICE file, excluding those notices that do not pertain to any part of the Deriva-
tive Works, in at least one of the following places: within a NOTICE text file distributed as part 
of the Derivative Works; within the Source form or documentation, if provided along with the 
Derivative Works; or, within a display generated by the Derivative Works, if and wherever such 
third-party notices normally appear. The contents of the NOTICE file are for informational pur-
poses only and do not modify the License. You may add Your own attribution notices within 
Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from 
the Work, provided that such additional attribution notices cannot be construed as modifying 
the License.
You may add Your own copyright statement to Your modifications and may provide additional 
or different license terms and conditions for use, reproduction, or distribution of Your modifi-
cations, or for any such Derivative Works as a whole, provided Your use, reproduction, and dis-
tribution of the Work otherwise complies with the conditions stated in this License.
5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution inten-
tionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and 
conditions of this License, without any additional terms or conditions. Notwithstanding the 
above, nothing herein shall supersede or modify the terms of any separate license agreement you 
may have executed with Licensor regarding such Contributions.
6. Trademarks. This License does not grant permission to use the trade names, trademarks, serv-
ice marks, or product names of the Licensor, except as required for reasonable and customary 
use in describing the origin of the Work and reproducing the content of the NOTICE file.
7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor 
provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, 
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, 
MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely 
responsible for determining the appropriateness of using or redistributing the Work and assume 
any risks associated with Your exercise of permissions under this License.
8. Limitation of Liability. In no event and under no legal theory, whether in tort (including neg-
ligence), contract, or otherwise, unless required by applicable law (such as deliberate and 
grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for dam-
ages, including any direct, indirect, special, incidental, or consequential damages of any char-
acter arising as a result of this License or out of the use or inability to use the Work (including 
but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, 
or any and all other commercial damages or losses), even if such Contributor has been advised 
of the possibility of such damages.
9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative 
Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, 
indemnity, or other liability obligations and/or rights consistent with this License. However, in 
accepting such obligations, You may act only on Your own behalf and on Your sole responsi-
bility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and 
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Appendix E: Open Source/Free Software Information
hold each Contributor harmless for any liability incurred by, or claims asserted against, such 
Contributor by reason of your accepting any such warranty or additional liability.
END OF TERMS AND CONDITIONS
APPENDIX: How to apply the Apache License to your work.
To apply the Apache License to your work, attach the following boilerplate notice, with the 
fields enclosed by brackets "[]" replaced with your own identifying information. (Don't include 
the brackets!)  The text should be enclosed in the appropriate comment syntax for the file for-
mat. We also recommend that a file or class name and description of purpose be included on the 
same "printed page" as the copyright notice for easier identification within third-party archives.
Copyright [yyyy] [name of copyright owner]
Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file 
except in compliance with the License. You may obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0
Unless required by applicable law or agreed to in writing, software distributed under the License 
is distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY 
KIND, either express or implied.
See the License for the specific language governing permissions and limitations under the 
License.

E.3  Bouncy Castle License
License
Copyright (c) 2000 - 2004 The Legion Of The Bouncy Castle (http://www.bouncycastle.org) 
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, 
including without limitation the rights to use, copy, modify, merge, publish, distribute, subli-
cense, and/or sell copies of the Software, and to permit persons to whom the Software is fur-
nished to do so, subject to the following conditions: 
The above copyright notice and this permission notice shall be included in all copies or substan-
tial portions of the Software. 
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGE-
MENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE 
FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

E.4  GNU-GPL
The GNU General Public License (GPL)
Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but 
changing it is not allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it. 
By contrast, the GNU General Public License is intended to guarantee your freedom to share 
and change free software--to make sure the software is free for all its users. This General Public 
License applies to most of the Free Software Foundation's software and to any other program 
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whose authors commit to using it. (Some other Free Software Foundation software is covered 
by the GNU Library General Public License instead.) You can apply it to your programs, too.
When we speak of free software, we are referring to freedom, not price. Our General Public 
Licenses are designed to make sure that you have the freedom to distribute copies of free soft-
ware (and charge for this service if you wish), that you receive source code or can get it if you 
want it, that you can change the software or use pieces of it in new free programs; and that you 
know you can do these things.
To protect your rights, we need to make restrictions that forbid anyone to deny you these rights 
or to ask you to surrender the rights. These restrictions translate to certain responsibilities for 
you if you distribute copies of the software, or if you modify it.
For example, if you distribute copies of such a program, whether gratis or for a fee, you must 
give the recipients all the rights that you have. You must make sure that they, too, receive or can 
get the source code. And you must show them these terms so they know their rights.
We protect your rights with two steps: (1) copyright the software, and (2) offer you this license 
which gives you legal permission to copy, distribute and/or modify the software.
Also, for each author's protection and ours, we want to make certain that everyone understands 
that there is no warranty for this free software. If the software is modified by someone else and 
passed on, we want its recipients to know that what they have is not the original, so that any 
problems introduced by others will not reflect on the original authors' reputations.
Finally, any free program is threatened constantly by software patents. We wish to avoid the 
danger that redistributors of a free program will individually obtain patent licenses, in effect 
making the program proprietary. To prevent this, we have made it clear that any patent must be 
licensed for everyone's free use or not licensed at all.
The precise terms and conditions for copying, distribution and modification follow.
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License applies to any program or other work which contains a notice placed by the cop-
yright holder saying it may be distributed under the terms of this General Public License. The 
"Program", below, refers to any such program or work, and a "work based on the Program" 
means either the Program or any derivative work under copyright law: that is to say, a work con-
taining the Program or a portion of it, either verbatim or with modifications and/or translated 
into another language. (Hereinafter, translation is included without limitation in the term "mod-
ification".) Each licensee is addressed as "you".
Activities other than copying, distribution and modification are not covered by this License; 
they are outside its scope. The act of running the Program is not restricted, and the output from 
the Program is covered only if its contents constitute a work based on the Program (independent 
of having been made by running the Program). Whether that is true depends on what the Pro-
gram does.
1. You may copy and distribute verbatim copies of the Program's source code as you receive it, 
in any medium, provided that you conspicuously and appropriately publish on each copy an 
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to 
this License and to the absence of any warranty; and give any other recipients of the Program a 
copy of this License along with the Program.
You may charge a fee for the physical act of transferring a copy, and you may at your option 
offer warranty protection in exchange for a fee.
2. You may modify your copy or copies of the Program or any portion of it, thus forming a work 
based on the Program, and copy and distribute such modifications or work under the terms of 
Section 1 above, provided that you also meet all of these conditions:
a) You must cause the modified files to carry prominent notices stating that you changed the 
files and the date of any change.
b) You must cause any work that you distribute or publish, that in whole or in part contains or 
is derived from the Program or any part thereof, to be licensed as a whole at no charge to all 
third parties under the terms of this License.
c) If the modified program normally reads commands interactively when run, you must cause 
it, when started running for such interactive use in the most ordinary way, to print or display an 
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announcement including an appropriate copyright notice and a notice that there is no warranty 
(or else, saying that you provide a warranty) and that users may redistribute the program under 
these conditions, and telling the user how to view a copy of this License. (Exception: if the Pro-
gram itself is interactive but does not normally print such an announcement, your work based 
on the Program is not required to print an announcement.)
These requirements apply to the modified work as a whole. If identifiable sections of that work 
are not derived from the Program, and can be reasonably considered independent and separate 
works in themselves, then this License, and its terms, do not apply to those sections when you 
distribute them as separate works. But when you distribute the same sections as part of a whole 
which is a work based on the Program, the distribution of the whole must be on the terms of this 
License, whose permissions for other licensees extend to the entire whole, and thus to each and 
every part regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written 
entirely by you; rather, the intent is to exercise the right to control the distribution of derivative 
or collective works based on the Program.
In addition, mere aggregation of another work not based on the Program with the Program (or 
with a work based on the Program) on a volume of a storage or distribution medium does not 
bring the other work under the scope of this License.
3. You may copy and distribute the Program (or a work based on it, under Section 2) in object 
code or executable form under the terms of Sections 1 and 2 above provided that you also do 
one of the following:
a) Accompany it with the complete corresponding machine-readable source code, which must 
be distributed under the terms of Sections 1 and 2 above on a medium customarily used for soft-
ware interchange; or,
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a 
charge no more than your cost of physically performing source distribution, a complete 
machine-readable copy of the corresponding source code, to be distributed under the terms of 
Sections 1 and 2 above on a medium customarily used for software interchange; or,
c) Accompany it with the information you received as to the offer to distribute corresponding 
source code. (This alternative is allowed only for noncommercial distribution and only if you 
received the program in object code or executable form with such an offer, in accord with Sub-
section b above.)
The source code for a work means the preferred form of the work for making modifications to 
it. For an executable work, complete source code means all the source code for all modules it 
contains, plus any associated interface definition files, plus the scripts used to control compila-
tion and installation of the executable. However, as a special exception, the source code distrib-
uted need not include anything that is normally distributed (in either source or binary form) with 
the major components (compiler, kernel, and so on) of the operating system on which the exe-
cutable runs, unless that component itself accompanies the executable.
If distribution of executable or object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place counts as 
distribution of the source code, even though third parties are not compelled to copy the source 
along with the object code.
4. You may not copy, modify, sublicense, or distribute the Program except as expressly pro-
vided under this License. Any attempt otherwise to copy, modify, sublicense or distribute the 
Program is void, and will automatically terminate your rights under this License. However, par-
ties who have received copies, or rights, from you under this License will not have their licenses 
terminated so long as such parties remain in full compliance.
5. You are not required to accept this License, since you have not signed it. However, nothing 
else grants you permission to modify or distribute the Program or its derivative works. These 
actions are prohibited by law if you do not accept this License. Therefore, by modifying or dis-
tributing the Program (or any work based on the Program), you indicate your acceptance of this 
License to do so, and all its terms and conditions for copying, distributing or modifying the Pro-
gram or works based on it.
6. Each time you redistribute the Program (or any work based on the Program), the recipient 
automatically receives a license from the original licensor to copy, distribute or modify the Pro-
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gram subject to these terms and conditions. You may not impose any further restrictions on the 
recipients' exercise of the rights granted herein. You are not responsible for enforcing compli-
ance by third parties to this License.
7. If, as a consequence of a court judgment or allegation of patent infringement or for any other 
reason (not limited to patent issues), conditions are imposed on you (whether by court order, 
agreement or otherwise) that contradict the conditions of this License, they do not excuse you 
from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your 
obligations under this License and any other pertinent obligations, then as a consequence you 
may not distribute the Program at all. For example, if a patent license would not permit royalty-
free redistribution of the Program by all those who receive copies directly or indirectly through 
you, then the only way you could satisfy both it and this License would be to refrain entirely 
from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, 
the balance of the section is intended to apply and the section as a whole is intended to apply in 
other circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right 
claims or to contest validity of any such claims; this section has the sole purpose of protecting 
the integrity of the free software distribution system, which is implemented by public license 
practices. Many people have made generous contributions to the wide range of software distrib-
uted through that system in reliance on consistent application of that system; it is up to the 
author/donor to decide if he or she is willing to distribute software through any other system and 
a licensee cannot impose that choice.
This section is intended to make thoroughly clear what is believed to be a consequence of the 
rest of this License.
8. If the distribution and/or use of the Program is restricted in certain countries either by patents 
or by copyrighted interfaces, the original copyright holder who places the Program under this 
License may add an explicit geographical distribution limitation excluding those countries, so 
that distribution is permitted only in or among countries not thus excluded. In such case, this 
License incorporates the limitation as if written in the body of this License.
9. The Free Software Foundation may publish revised and/or new versions of the General Public 
License from time to time. Such new versions will be similar in spirit to the present version, but 
may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version 
number of this License which applies to it and "any later version", you have the option of fol-
lowing the terms and conditions either of that version or of any later version published by the 
Free Software Foundation. If the Program does not specify a version number of this License, 
you may choose any version ever published by the Free Software Foundation.
10. If you wish to incorporate parts of the Program into other free programs whose distribution 
conditions are different, write to the author to ask for permission. For software which is copy-
righted by the Free Software Foundation, write to the Free Software Foundation; we sometimes 
make exceptions for this. Our decision will be guided by the two goals of preserving the free 
status of all derivatives of our free software and of promoting the sharing and reuse of software 
generally.
NO WARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WAR-
RANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. 
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS 
AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY 
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORM-
ANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION.
12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 
WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 
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MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIA-
BLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL 
OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA 
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PAR-
TIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, 
the best way to achieve this is to make it free software which everyone can redistribute and 
change under these terms.
To do so, attach the following notices to the program. It is safest to attach them to the start of 
each source file to most effectively convey the exclusion of warranty; and each file should have 
at least the "copyright" line and a pointer to where the full notice is found.
One line to give the program's name and a brief idea of what it does.
Copyright (C) <year> <name of author>
This program is free software; you can redistribute it and/or modify it under the terms of the 
GNU General Public License as published by the Free Software Foundation; either version 2 of 
the License, or (at your option) any later version.
This program is distributed in the hope that it will be useful, but WITHOUT ANY WAR-
RANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A 
PARTICULAR PURPOSE. See the GNU General Public License for more details.
You should have received a copy of the GNU General Public License along with this program; 
if not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 
02111-1307 USA
Also add information on how to contact you by electronic and paper mail.
If the program is interactive, make it output a short notice like this when it starts in an interactive 
mode:
Gnomovision version 69, Copyright (C) year name of author Gnomovision comes with ABSO-
LUTELY NO WARRANTY; for details type `show w'. This is free software, and you are wel-
come to redistribute it under certain conditions; type `show c' for details.
The hypothetical commands `show w' and `show c' should show the appropriate parts of the 
General Public License. Of course, the commands you use may be called something other than 
`show w' and `show c'; they could even be mouse-clicks or menu items--whatever suits your 
program.
You should also get your employer (if you work as a programmer) or your school, if any, to sign 
a "copyright disclaimer" for the program, if necessary. Here is a sample; alter the names:
Yoyodyne, Inc., hereby disclaims all copyright interest in the program `Gnomovision' (which 
makes passes at compilers) written by James Hacker.
signature of Ty Coon, 1 April 1989
Ty Coon, President of Vice
This General Public License does not permit incorporating your program into proprietary pro-
grams. If your program is a subroutine library, you may consider it more useful to permit linking 
proprietary applications with the library. If this is what you want to do, use the GNU Library 
General Public License instead of this License.
**********************************************************
Copyright © 2005 by the Open Source Initiative
Technical questions about the website go to Steve M.: webmaster at opensource.org / Policy 
questions about open source go to the Board of Directors.
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The contents of this website are licensed under the Open Software License 2.1 or Academic 
Free License 2.1 
OSI is a registered non-profit with 501(c)(3) status. Contact our Board for further donation 
information.

E.5  md5.js License (BSD License)
Copyright (c) 1998 - 2002, Paul Johnston & Contributors
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. Redistributions in binary form must reproduce the above copyright 
notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.
Neither the name of the author nor the names of its contributors may be used to endorse or pro-
mote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBU-
TORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDI-
RECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE.

E.6  Modified BSD License
2.2. Berkeley-based copyrights:
2.2.1. General
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the dis-
tribution. 
The name of the author may not be used to endorse or promote products derived from this soft-
ware without specific prior written permission. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUP-
TION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHER-
WISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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2.2.2. UCB/LBL
Copyright (c) 1993 The Regents of the University of California. All rights reserved.
This software was developed by the Computer Systems Engineering group at Lawrence Berke-
ley Laboratory under DARPA contract BG 91-66 and contributed to Berkeley.
All advertising materials mentioning features or use of this software must display the following 
acknowledgement: This product includes software developed by the University of California, 
Lawrence Berkeley Laboratory.
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:
Redistributions of source code must retain the above copyright notice, this list of conditions and 
the following disclaimer. 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other materials provided with the dis-
tribution. 
All advertising materials mentioning features or use of this software must display the following 
acknowledgement: This product includes software developed by the University of California, 
Berkeley and its contributors. 
Neither the name of the University nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission. 
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAM-
AGE.

E.7  OpenBSD License
This file is part of the OpenSSH software.
The licences which components of this software fall under are as follows.  First, we will sum-
marize and say that all components are under a BSD licence, or a licence more free than that.
OpenSSH contains no GPL code.
1)
     * Copyright (c) 1995 Tatu Ylonen <ylo@cs.hut.fi>, Espoo, Finland
     *                    All rights reserved
     *
     * As far as I am concerned, the code I have written for this software
     * can be used freely for any purpose.  Any derived versions of this
     * software must be clearly marked as such, and if the derived work is
     * incompatible with the protocol description in the RFC file, it must be
     * called by a name other than "ssh" or "Secure Shell".
[Tatu continues]
     *  However, I am not implying to give any licenses to any patents or
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     * copyrights held by third parties, and the software includes parts that
     * are not under my direct control.  As far as I know, all included
     * source code is used in accordance with the relevant license agreements
     * and can be used freely for any purpose (the GNU license being the most
     * restrictive); see below for details.
[However, none of that term is relevant at this point in time.  All of these restrictively licenced 
software components which he talks about have been removed from OpenSSH, i.e.,
- RSA is no longer included, found in the OpenSSL library
- IDEA is no longer included, its use is deprecated
- DES is now external, in the OpenSSL library
- GMP is no longer used, and instead we call BN code from OpenSSL
- Zlib is now external, in a library
- The make-ssh-known-hosts script is no longer included
- TSS has been removed
- MD5 is now external, in the OpenSSL library
- RC4 support has been replaced with ARC4 support from OpenSSL
- Blowfish is now external, in the OpenSSL library
[The licence continues]
Note that any information and cryptographic algorithms used in this software are publicly avail-
able on the Internet and at any major bookstore, scientific library, and patent office worldwide.  
More information can be found e.g. at "http://www.cs.hut.fi/crypto".
The legal status of this program is some combination of all these permissions and restrictions.  
Use only at your own responsibility. You will be responsible for any legal consequences your-
self; I am not making any claims whether possessing or using this is legal or not in your country, 
and I am not taking any responsibility on your behalf.
NO WARRANTY
BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WAR-
RANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS 
AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY 
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORM-
ANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFEC-
TIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRIT-
ING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY 
AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO 
YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA 
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PAR-
TIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PRO-
GRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.
2)
The 32-bit CRC compensation attack detector in deattack.c was contributed by CORE SDI S.A. 
under a BSD-style license.
Cryptographic attack detector for ssh - source code
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Copyright (c) 1998 CORE SDI S.A., Buenos Aires, Argentina.
All rights reserved. Redistribution and use in source and binary forms, with or without modifi-
cation, are permitted provided that this copyright notice is retained.
THIS SOFTWARE IS PROVIDED ̀ `AS IS'' AND ANY EXPRESS OR IMPLIED WARRAN-
TIES ARE DISCLAIMED. IN NO EVENT SHALL CORE SDI S.A. BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL 
DAMAGES RESULTING FROM THE USE OR MISUSE OF THIS SOFTWARE.
Ariel Futoransky <futo@core-sdi.com>
<http://www.core-sdi.com>
3)
ssh-keyscan was contributed by David Mazieres under a BSD-style license.
Copyright 1995, 1996 by David Mazieres <dm@lcs.mit.edu>.
Modification and redistribution in source and binary forms is permitted provided that due credit 
is given to the author and the OpenBSD project by leaving this copyright notice intact.
4)
The Rijndael implementation by Vincent Rijmen, Antoon Bosselaers and Paulo Barreto is in the 
public domain and distributed with the following license:
@version 3.0 (December 2000)
Optimised ANSI C code for the Rijndael cipher (now AES)
@author Vincent Rijmen <vincent.rijmen@esat.kuleuven.ac.be>
@author Antoon Bosselaers <antoon.bosselaers@esat.kuleuven.ac.be>
@author Paulo Barreto <paulo.barreto@terra.com.br>
This code is hereby placed in the public domain.
THIS SOFTWARE IS PROVIDED BY THE AUTHORS ''AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHORS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCURE-
MENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; 
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIA-
BILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEG-
LIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
5)
One component of the ssh source code is under a 3-clause BSD license, held by the University 
of California, since we pulled these parts from original Berkeley code.
Copyright (c) 1983, 1990, 1992, 1993, 1995
The Regents of the University of California.  All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of condi-
tions and the following disclaimer in the documentation and/or other materials provided with 
the distribution.
3. Neither the name of the University nor the names of its contributors may be used to endorse 
or promote products derived from this software without specific prior written permission.
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THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE REGENTS 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPE-
CIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIM-
ITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE.
6)
Remaining components of the software are provided under a standard 2-term BSD licence with 
the following names as copyright holders:
Markus Friedl
Theo de Raadt
Niels Provos
Dug Song
Aaron Campbell
Damien Miller
Kevin Steves
Daniel Kouril
Wesley Griffin
Per Allansson
Nils Nordman
Simon Wilkinson
Redistribution and use in source and binary forms, with or without modification, are permitted 
provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions 
and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of condi-
tions and the following disclaimer in the documentation and/or other materials provided with 
the distribution.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WAR-
RANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUP-
TION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHER-
WISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
------
$OpenBSD: LICENCE,v 1.19 2004/08/30 09:18:08 markus Exp $
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Appendix F Apollo Light Utility

Apollo Light is a utility for extracting data from Nanometrics Store files on your PC. It 
provides a web interface with the same options to view data availability and to down-
load data that are provided in the Taurus UI.

Note Apollo Light is used for Stores created with Taurus firmware V2.xx, indi-
cated by file names of the form taurus_0123_001.store. For Stores 
created with Taurus firmware V1.xx, indicated by file names of the form 
NmxVolume_001, use the TaurusExtract utility.

Apollo Light is supported on Windows and Linux/Unix. It has been tested on Microsoft 
Windows XP using Java2RE 1.4.2.

F.1  Installing Apollo Light
To install Apollo Light, extract the files from apollo-2_xx_yy.zip on the 
Taurus CD to your PC. The files will unzip to a directory named apollo.

Additionally, on Linux/Unix, set the apollo.sh file to be executable: 
Change to the /apollo directory and then enter the command chmod +x 
apollo.sh

F.2  Running Apollo Light
Apollo Light requires Java.

Note Apollo Light must always be started from the command line. That is, you 
must run the batch or script file before you can navigate to Apollo Light in 
your web browser.

1. Open a command window and start Apollo Light from the apollo directory.
On Windows, enter apollo [port=value]
On Linux/Unix, enter ./apollo [port=value]

where the default is port=80. Use the optional parameter to indicate an alterna-
tive port greater than 1024 (for example, 8080) in either of these cases:

If there is a web server running on the machine, port 80 will already be in 
use.
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On Linux/Unix, root login may be required to run the web server at the 
default port (port 80).

Example 1: apollo
Example 2: apollo port=8080

2. Open a web browser and go to the “root” page of the machine on which Apollo is 
running (for example, http://localhost/). If the port is a value other than the default, 
you must include the port number (for example, http://localhost:8080/).

F.2.1   Initialize the Store location

The first time you start Apollo Light from a new installation, or if the last-used Store 
directory has been deleted, the command window will indicate “Got error while open-
ing store” followed by java exceptions as shown (example on Windows):

->    Got error while opening store: : ca.nanometrics.store.excep 
tion.StoreException: Directory: 'C:\nmx\store/' does not exist. & 
at ca.nanometrics.store.NPStore.createStoreFile(NPStore.java:345) & 
at ca.nanometrics.store.NPStore.init(NPStore.java:262) & at 
ca.nanometrics.store.NPStore.<init>(NPStore.java:226) & at ca.nano 
metrics.store.NPStore.instance(NPStore.java:206) & at ca.nanomet 
rics.apollo.MissionControl.openStore(MissionControl.java:304) & at 
ca.nanometrics.apollo.MissionControlCentral.body(MissionControlCen 
tral.java:82) & at ca.nanometrics.apollo.MissionControl.run(Mis 
sionControl.java:823) & at ca.nanometrics.apollo.MissionCon 
trol.main(MissionControl.java:891) &

This is normal. It indicates that a Store directory has not yet been identified.

Until you point to a Store, the menu will not include the Data Availability or Data 
Retrieval options. Once you have selected a Store (Section F.3.3), all of the menu 
options will be shown (Figure F-1). (If the Store you selected is corrupted, the menu 
still will not show the Data Availability or Data Retrieval options, and the startup win-
dow may show additional exceptions.)

F.2.2   Exit Apollo Light
To exit Apollo Light, choose Exit from the menu.

Figure F-1  Apollo Light options without a Store location, and after a Store has been opened
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F.3  Using Apollo Light
You can use Apollo Light to view what data are available in a Store on your file system, 
and to extract the data.

F.3.1   Working with data from multiple Tauruses

You can have Stores from different Tauruses in the same directory. Apollo Light will 
use the Store ID in the file name to access the correct files. The Store ID uses the serial 
number of the Taurus that recorded data into the Store.

In rare cases, a single Store may contain data from multiple Tauruses (see Section 
10.2.1.1 “About appended Stores” on page 96). In that case, the Store ID in the 
filename uses the serial number of the last Taurus that recorded data into the Store. 
Each set of log and SOH data in a multi-Taurus Store is associated with the Taurus that 
originally recorded those data. Therefore, you must also specify the Instrument ID of 
the Taurus before retrieving log or SOH data for that Taurus data set. All time-series 
data can always be retrieved, regardless of the Instrument ID setting.

F.3.2   Requirements for accessing Store files
The Store files must be in a directory that is accessible from your machine.
All of the files for the Store you are accessing must be present in the same direc-
tory (for example, for a Store containing 5 files, all of the files from 
taurus_serialNumber_001.store to taurus_serialNumber_005.store 
must be present in the directory).
The Store files must be set to read/write:

On Windows, right-click on the file name, choose Properties, and deselect the 
attribute Read-only.
On Linux/Unix, in the Store files directory enter the command ls -al to 
check read/write status (w indicates write permission; the files should already 
show read permission r).

To set a selected file for write permission, enter chmod +w filename.
To set all files in the directory to write permission, enter chmod +w *.

F.3.3   Select a Store
1. Choose Store Selection from the menu.

2. Click Browse to search for a Store on your file system.

3. Select any one of the files for that Store.

4. Click Change Store to point Apollo to the selected Store (Figure F-2).

5. If the Store contains data from more than one Taurus, choose the correct Taurus 
before working with logs or SOH data (Figure F-3). In the Instrument ID list, 
choose the appropriate Taurus Instrument ID, and then click Change Instrument.

6. Ensure you have configured the Playback options as appropriate for the data 
source (Section F.3.4).
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The next time you start Apollo Light, it will by default point to the last Store used if it 
is still available. (See also Section F.2.1 “Initialize the Store location” on page 164.)

F.3.4   Configure extracted file headings (Playback)

Each time you open a different Store you must configure the headings to apply to time-
series files extracted with the Data Retrieval options. Configure these file headings as 
appropriate to the data source. Use the options in the Playback configuration page. The 
options are identical to those included in the Taurus UI Playback page (Section 11.1.3.2 
“Confirm Playback settings” on page 107 and Table H-23 “Playback page options” on 
page 197).

To open the Playback configuration page, choose Configuration from the menu 
and then click the Playback link.

F.3.5   Check data availability and extract data

The Data Availability and Data Retrieval options are identical to those included in the 
Taurus UI (see Chapter 11 “Accessing Data”).

Figure F-2  Choose a Store

Figure F-3  Specify a Taurus from a multi-Taurus Store for retrieving log and SOH data
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F.4  Using the log files
Apollo Light creates two log text files, a startup log and a main log. A new log file is 
opened each day that Apollo Light is run. The date is encoded in the log file name (for 
example, Apollo_20050823.log).

The startup log is written to Apollo_yyyymmdd.log on the same disk on which 
the current Store files directory exists, one level above the Store files directory. It 
contains startup messages only.
The main log is written to Apollo_yyyymmdd.log in the \apollo\logs 
directory. It contains operation messages generated by Apollo.
The main log can be configured to show only messages at or above a specified 
level of detail (or verbosity). The default is Info (the minimum amount of detail); 
Debug is the most detailed level.

To configure the log verbosity to a different level of detail, choose an option 
from the drop-down list in Configuration > General > Log verbosity, then 
Apply and Commit the change.
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Appendix G Taurus Firmware 
Upgrade Procedures

Use the scripts upgrade procedure (Section G.1) for firmware upgrades from Taurus 
Version 1.xx to Version 2.xx or higher. Use the web upgrade procedure (Section G.2) 
for firmware upgrades after a Version 2.xx or higher has been installed.

G.1  Upgrading Taurus from Version 1.xx to Version 2.xx or 
higher

The scripts procedure described in this section is applicable only to upgrades from Ver-
sion 1.xx to Version 2.xx (or higher) and will not be supported for future releases. For 
future releases, use the Web upgrade procedure described in Section G.2 on page 172.

Warning Taurus Version 1.xx uses a data Store that is incompatible with Ver-
sion 2.xx and higher. Ensure that you download or back up your Ver-
sion 1.xx data before installing the 2.xx or higher upgrade, as the 
upgrade will delete the old Store.

This procedure requires that the Taurus be connected to a local network (LAN) using 
the supplied Ethernet cable (15228) or equivalent. You will require a Windows or 
Linux PC to establish a telnet session with the Taurus to upload the new firmware and 
install it.

1. Obtain the Taurus firmware upgrade package (a taurus-
release_releaseNumber.tgz file) and place it in a convenient folder on the 
Windows or Linux PC you will use to connect to the Taurus.

2. Power up the Taurus in factory test mode:
a) Shut down the Taurus: Go to the Shutdown page and click Shutdown.
b) Once the LED below the Ethernet connector is off, disconnect the power cable.
c) Press and hold the centre key down while you connect the power cable and wait 

for the LED on the top of the Taurus to start blinking, then release the centre 
key.

3. Check the IP address of your Taurus if you are not sure what it is: Once the Ether-
net LED is blinking green, press the centre key for about 1 second to start the dis-
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play. Wait for the display to come up (if the display has not started after several 
minutes, press the centre key again for about 1 second and wait). The IP address of 
the Taurus is shown on the Current Status page.

4. Telnet to the Taurus. Use root for both the login and the password.

Note The installation files will require about 50MB of space on the recording 
medium.

5. Create an upgrade directory on either of the available recording media (either an 
IDE drive or a CF card):

mkdir /mnt/media/upgrade

where media is ide if you are using an IDE harddrive, and cf if you are using a 
CompactFlash card; for example, mkdir /mnt/cf/upgrade.

If the /mnt/media directory does not exist, it is because the media is not 
installed properly. Do NOT make that directory manually using mkdir. 
Instead, power down the unit, ensure the media is installed properly, and power 
the unit back on.

6. Keep the telnet session running.

7. FTP to the appropriate directory on the Taurus IDE or CF. Use root for both the 
login and the password. For example:

ftp://root:root@ip_address_of_your_taurus/../mnt/media/upgrade

8. Locate your taurus-release-2.xx.yy.tgz file. Upload the file, with FTP 
set for binary transfer, to the appropriate upgrade directory on the Taurus (either 
/mnt/ide/upgrade or /mnt/cf/upgrade).

9. From the telnet session, go to the upgrade directory and untar the files (you can 
press Tab to auto-complete directory and file names):

cd /mnt/media/upgrade
tar zxvf taurus-release-2.xx.yy.tgz

The files should finish untarring within 5 minutes.

10. Change directories to the release files directory, and then run the installation 
scripts:

cd release-2.xx.yy
./taurus_install.sh

    The files should finish installing within about 15 to 20 minutes.
Make sure there are no errors during installation (these would be indicated by 
error messages on the screen). If there are errors, wait until the installation 
scripts have completed and then run them again.
If there is a power failure while the installation scripts are running, the media 
might unmount. If this occurs, you must mount the media before you can run 
the installation scripts. If the upgrade process is interrupted after the rootfs was 
successfully uploaded, the root password will have changed to dolphin18.

For the CF card, enter the command
mount -t ext3 dev/hdc1 mnt/cf

For the IDE drive, enter the command
mount dev/hda1 mnt/ide
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Note In some browsers you may get an HTTP 404 error (page not found) when 
attempting to access the Taurus after the new software is installed. If this 
occurs, clear your browser cache.

11. Once the files have installed successfully (you will see a message saying so), start 
a browser on your PC and check the firmware version numbers. (The correspond-
ing files are tdp-component-versionNumber.nbf.)
a) Go to http://ip_address_of_your_taurus:8080/firmware/ 
b) Confirm that the files have been uploaded correctly, by comparing the version 

numbers on the page with the versions in the release-2.xx.yy directory.
c) Go to http://ip_address_of_your_taurus:8080/pwm/
d) Confirm that the file has been uploaded correctly, by comparing the version 

number on the page with the version in the release-2.xx.yy directory.

12. From the telnet session, run the testcode script to set the installed files to Active 
and to force creation of a Version 2.xx data Store (this will delete the Version 1.xx 
data Store):

./testcode.sh -force

    The unit will reboot automatically.

Note The Taurus will try to use IDE as the recording medium on this reboot as 
that is the initial default with the new firmware. If you had CF as the con-
figured recording medium prior to the upgrade, the Status page will indi-
cate that no data are available. To select CF, log in either as tech 
(password is tech) or central (password is central). Choose Store 
Tools from the menu, then click Switch Media and follow the instructions 
shown in the UI.

13. After the Taurus has finished booting, indicated by the Ethernet LED blinking 
green, press the centre key for about 1 second to start the display. It will take the 
display a few minutes to start up. Check the Status page for normal operation (for 
example, you should see packets increasing for either recording medium, and 
waveforms moving on the Status page if your unit was previously configured to 
use IDE as the recording medium. See also the Note above this step).

14. To check if the upgrade was successful, go to the System Info page and confirm 
that versions are the same as those in the Taurus directory 
/mnt/media/upgrade/release-2.xx.yy. The items should map as follows, 
where * is the version number:

Taurus Firmware V: directory_name (release-*)

Digital Processor V: tdp-arm-*.nbf (ignore the A/B)
Signal Processor V: tdp-dsp-*.nbf

Power Manager V: tdp-pwm-*.nbf (ignore the A/B)
Filter Coefficients V: tdp-coeff-*.nbf

Fpga V: tdp-fpga-*.nbf

Flash Boot System V: tcp-uboot-*.bin (starts with 0.4.8 NMX *)
Root File System V: tcp-rootfs-update-*.sh (starts with NMX-*)
Kernel V: tcp-uimage-.* (starts with 2.4.24-NMX-*)
Apollo V: apollo-taurus-*.tgz
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15. Go to the Taurus Log In page and log in as central (password central) and 
then set the Active firmware to Default: Click the Commit button.

16. In a browser window, confirm that the Active firmware is now also the Default 
firmware:
a) Go to http://ip_address_of_your_taurus:8080/firmware/ and confirm that the 

new firmware is both Default and Active.
b) Go to http://ip_address_of_your_taurus:8080/pwm/ and confirm that the new 

firmware is both Default and Active.

17. The upgrade is now complete. Optionally, you may remove the installation files 
from the Taurus: In the Upgrade page, select the installation filename from the 
drop-down list and then click Delete.

G.2  Upgrading Taurus from Version 2.00.xx or higher
Use the Taurus Web upgrade procedure for Taurus firmware upgrades after a Version 
2.xx or higher has been installed. The scripts procedure described in Section G.1 is 
applicable only to upgrades from Version 1.xx to Version 2.xx (or higher) and will not 
be supported for future releases.

Do not boot the Taurus in factory test mode for Web upgrades, boot it in normal 
mode. Factory test mode is required only for the scripts upgrade procedure 
described in Section G.1.

Ensure that the Taurus is configured to Communications Mode before upgrading 
with the Web upgrade procedure (Section 3.1 “About the Taurus operating modes” 
on page 17).

Uploading the file over your LAN using the Web upgrade may time out if you are 
using a proxy server. If this happens, you can change network settings to bypass 
the proxy server for local addresses. For example:

In Firefox, go to Tools > Options (General) > Connection Settings > No Proxy 
for: [use the address and mask width for a range of addresses, for example 
w.x.y.0/24].
In Netscape, go to Edit > Preferences > Advanced > Proxies > No Proxy for: 
[use the address and mask width for a range of addresses, for example 
w.x.y.0/24].
In Internet Explorer, go to Tools > Internet Options > Connections > LAN Set-
tings [enable Bypass proxy server for local addresses] > Advanced > Excep-
tions [use the address and an asterisk wildcard for a range of addresses, for 
example w.x.y.*].

G.2.1   Using the Taurus Upgrade page

This procedure requires that the Taurus be connected to a local network (LAN) using 
the supplied Ethernet cable (15228) or equivalent. You will require a Windows or 
Linux PC with an Internet browser to upload the new firmware and install it.
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Appendix G: Taurus Firmware Upgrade Procedures
Taurus Versions 2.xx and higher provide an Upgrade page for firmware updates and 
upgrade file management. Follow this general procedure to use the Upgrade page:

Warning Taurus Versions 2.00.16 and earlier use a data Store that is incom-
patible with versions higher than 2.00.16. Ensure that you download 
or back up your Store before upgrading to a version higher than 
2.00.16, as the upgrade will delete the old Store.

Note The installation files will require about 50MB of space on the recording 
medium.

1. Obtain the Taurus firmware upgrade package (a taurus-
release_releaseNumber.tgz file) and place it in a convenient folder on the 
Windows or Linux PC you will use to connect to the Taurus.

2. Boot the Taurus in normal mode.

3. Log in under the central account:
a) On the Taurus menu, choose Log In.
b) Enter the UserID central and the account Password (the initial default pass-

word is central), then click Log In.

4. Ensure the Taurus is set to Communications mode (see Section 3.1 “About the 
Taurus operating modes” on page 17).

5. In a browser on the Windows or Linux PC, choose Upgrade from the Taurus menu.
If there are no .tgz files currently uploaded to the Taurus, the Upgrade page on a 
browser will show only the option to browse for an upgrade file (Figure G-1). The 
display will not have any options showing.

6. In a browser, click Browse and locate the Taurus upgrade package you want to use 
(a taurus-release_*.tgz file). Click Upload to upload the taurus-
release_releaseNumber.tgz file to the Taurus.

7. The Upgrade page will now show the remaining upgrade management options. 
These options are also available on the Taurus display:

Install – Install the selected firmware package and start it up as the active ver-
sion.
Delete – Remove the selected firmware upgrade file from the Taurus.
Commit – Set the currently running version of the firmware as default.
Revert – Reboot Taurus and run the default version of the firmware.
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8. Ensure that the version you want to install is selected in the drop-down list.

9. Click Install to install the selected firmware. The unit will install the firmware (the 
files should finish installing within about 15 to 20 minutes) and then reboot auto-
matically. The Taurus will take 2 or 3 minutes to finish rebooting.
Once the firmware is installed and the unit has rebooted, the new firmware is 
active but it is not yet default. (You can run the unit with the active firmware but it 
will revert to the default firmware after a reboot.)

10. To set the new firmware as Default, log in as central, go to the Upgrade page, 
and click Commit. 

11. The upgrade is now complete. Optionally, you may remove the installation files 
from the Taurus recording medium: In the drop-down list on the Upgrade page, 
choose the version you want to delete, then click Delete.

Figure G-1  Upgrade options before and after uploading a .tgz file to the Taurus
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Appendix H UI Pages and 
Parameters

This appendix shows a map of the Taurus UI page hierarchy (Section H.1 “Taurus UI 
page map” with links to page descriptions), and provides a summary of the options 
available on each UI page.

Access to some options depends on the level of user access (for example, you can 
upgrade the Taurus firmware only if you are logged in as central; see also Table 6-
1 “User permissions” on page 47). Availability of some options also depends on 
whether you are using a browser or the display (for example, data retrieval is available 
only via a browser).
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H.1  Taurus UI page map
Go to the page number indicated for a description of the UI page and its parameters.

Status (p. 177)
Waveform (p. 180)
SOH (p. 181)
Alerts (p. 181)
Data Availability (p. 181) Month (p. 182)

Week (p. 182)
Day (p. 182)
Text (p. 182) Time Series (p. 182) Time Series band (p. 183)

Other (p. 183) Other band (p. 183)
Data Retrieval (p. 183)
[Browser only]

Time Series (p. 184)
Time Series By Event (p. 185)
State of Health (p. 186)
System Logs (p. 187)
System Configuration (p. 187)

Timing (p. 187) Timing (p. 187)
GPS Satellites (p. 188)
GPS Map (p. 189)

Sensor (p. 189)
Store Tools (p. 190)
Configuration (p. 190)
[Log in to access]
System Info (p. 191)
Advanced Configuration (p. 191)
[Log in to access]

General (p. 192)
Communications (p. 193) Ethernet (p. 193)

Data Streaming (p. 194)
Serial Port 1 (p. 194) SLIP (p. 195)

Raw (p. 195)
PPP (p. 195)
TDMA (p. 196)

Serial Port 2 (p. 196)
Discovery (p. 196)

Security (p. 197)
Playback (p. 197)
Timing configuration (p. 198)
Calibration (p. 198)
Sensor Details (p. 199) Sensor Control Lines (p. 200)

Mass Auto-Centering (p. 201)
Digitizer (p. 202) Main (p. 202)

Front End (p. 203)
Triggers (p. 204) Input Filter (p. 204)

Detectors (p. 205)
Power (p. 205)

Upgrade (p. 206)
[Log in to access]
Log In/Log Off (p. 207) Change Password (p. 207)
Shutdown (p. 208)
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H.2  Status
The Status page shows basic unit and system status information in read-only fields, and 
widgets such as status bars and waveform images (Table H-1).

Status bars indicate subsystem status using a colour code and a text message; some of 
these also provide a link to the relevant SOH or configuration page. The status colour 
codes correspond to the status LED states. That is, red indicates an error state that must 
be investigated and fixed, green indicates that everything is working properly, and yel-
low indicates a temporary situation that will resolve either to a red or a green state.

Table H-1  Status page options

Parameter/Widget Description

Mode The running mode for collecting data (Buffered | Communications). 
(Configured in either Advanced Configuration > General – Running 
Mode, or in Configuration – Running Mode.)

Channels Number of channels @ Sample rate. (Options are configured in 
Advanced Configuration > Digitizer > Main – Output Channels and 
Sample Rate [Hz], or in Configuration – Output Channels and Sample 
Rate [Hz].)

Store(Type) The space used as percentage of configured Store size on the active 
recording medium. (The recording media type is configured with 
options on the Store Tools page.)

Store Time Left | 
Avg Time in Store

Store Time Left is the estimated number of days of recording space 
remaining in the active Store at the current sample rate. 
Once the Store has wrapped (that is, it has recorded data to the 
configured Store capacity and started to record over old data), it 
changes to a continuously recalculated average quantity of data in the 
Store, expressed as the number of days or hours of data.

IP The current IP address of the Taurus, in dotted decimal format. (The 
assignment method for the IP address is configured in Advanced 
Configuration > Communications > Ethernet – Mode.)

Time Shows the current time as yyyy-mm-dd HH:mm:ss (uses Controller 
time; see Table 8-1 “Taurus time definitions” on page 79). GPS 
options are configured in Advanced Configuration > Timing.

Battery The power supply level in volts. (Battery options are configured in 
Advanced Configuration > Power.)

Power The average power consumption of the Taurus in watts. This will 
include power consumption of any externally connected devices such 
as a seismometer, serial device, or a device connected to the External 
SOH.

Temp The temperature inside the Taurus in degrees Celsius. 

Packets The number of data packets recorded to the Store since the Controller 
was started. 
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Timing status bar The timing status bar indicates the status of the system time and its 
inputs with a status colour and a text message, and provides a link to 
the Timing page. Timing configuration options are on the Advanced 
Configuration > Timing page. (See Table 8-1 “Taurus time definitions” 
on page 79 for definitions of Taurus derived times.)
Note that:
• System time starts from zero on power-on, and has not been set 

properly until Time status has been Green at least once since 
power-on.

• PLL state < Coarse Lock = either Free Running or No Lock.

Table H-1  Status page options (Continued)

Parameter/Widget Description

Colour Text Indicates...

Red No 
Antenna

Antenna open is detected. This is a hardware 
fault condition even if Taurus time is OK. The 
Lassen iQ GPS receiver can detect an 
antenna open condition, but the Lassen SQ 
GPS receiver cannot. If your Taurus uses the 
SQ, this status report option is not available.

Antenna 
Short

Antenna short is detected. This is a hardware 
fault condition even if Taurus time is OK.

GPS Off Either of these conditions:
• System Time has not been set yet after 

power-on, GPS is off.
• Timing status was Green at least once, Time 

Uncertainty >= 100µs, GPS is off.

GPS 
Failed

Either of these conditions:
• System Time has not been set yet after 

power-on, PLL state has not reached Coarse 
Lock, GPS has been switched on for longer 
than the initialization time limit.

• Timing Status was Green at least once, Time 
Uncertainty >= 100µs, GPS is on.

Bad 
Time

Either of these conditions:
• System Time has not been set yet after 

power-on, GPS is on, PLL state has reached 
Coarse Lock or better, Time Error >= 100µs.

• Timing Status was Green at least once, PLL 
state >= Coarse Lock, Time Error >= 100µs.

Yellow GPS Init System Time has not been set yet after power-
on, GPS is on, PLL state has not reached 
Coarse Lock, GPS is on for shorter than the 
initialization time limit.

Green Time 
OK

Either of these conditions:
• PLL state has not reached Coarse Lock and 

Time Uncertainty < 100µs.
• PLL state has reached Coarse Lock or better 

and Time Error < 100µs.
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Media door status 
bar

The media door status bar indicates the status of the media door, with 
a status colour and a text message.
• Red, with text “Door Open”.
• Green, with text “Door Closed”.
The media door should be closed while the Taurus is operating at an 
installation.

Store status bar The Store status bar indicates the status of the Store and the active 
recording medium, with a status colour and a text message, and 
provides a link to the Store Tools page.
• Red, with various messages indicating that a Store is not available 

(for example, during reindexing, or if no media are installed).
• Green, indicates data are being recorded to the currently active 

Store.

Sensor power 
status bar

The sensor power status bar indicates the sensor power status, with a 
status colour and a text message, and provides a link to the Sensor 
page. Sensor configuration options are on the Advanced 
Configuration > Sensor Details page, and control options are on the 
Sensor page.
It uses these inputs:
• Advanced Configuration > Sensor Details – Needs Power
• Advanced Configuration > Sensor Details – Detect Sensor Pres-

ence
• Sensor – Sensor [On | Off]

Table H-1  Status page options (Continued)

Parameter/Widget Description

Colour Text Indicates...

Red Sensor No 
Power

The sensor is configured as Needs Power 
enabled  and Sensor Off.

Sensor 
Powered

The sensor is configured as Needs Power 
not enabled  and Sensor On.

Sensor No 
Current*

* If there is a No Current error for a sensor that normally draws 
more than 8mA, it probably means either that the sensor is not 
connected, or the power manager has cut off power to the sen-
sor. In the latter case, the Status Page will show red for both 
the sensor status and for the power status.

The sensor is configured as Needs Power 
enabled , Detect Sensor Presence 
enabled , Sensor On, but it is not 
consuming any power. (Detect sensor 
presence works only for sensors drawing 
more than about 8mA.)

Green Sensor 
Power

Either of these conditions: 
• The sensor is configured as Needs Power 

enabled , Detect Sensor Presence 
enabled , Sensor On, and it is consum-
ing power.

• The sensor is configured as Needs Power 
not enabled  and Sensor Off.
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H.3  Waveform
The Waveform page shows a waveform in near-real time for each channel, with DC 
offset correction. There are options to view a single channel at a time or all three chan-
nels, pause the waveform display, and adjust the scale (Table H-2).

Power manager 
status bar

The power manager status bar indicates the status of external device 
current draw, with a status colour and a text message.
• Red status, with text Power OverCurrent: An external device (on 

either the serial or the sensor connector) has drawn too much cur-
rent and has been shut off. Sensor power can be turned back on 
(assuming the fault condition has been fixed) in the Sensor page 
(see Section H.9 “Sensor” on page 189). The Taurus must be 
power-cycled to restore serial power once it has been tripped.

• Green status, with text Power: Power usage of external devices is 
within tolerance.

Ethernet status bar The Ethernet status bar indicates the status of Ethernet networking, 
with a status colour and a text message. (Some status conditions, 
such as Ethernet Off, can only be viewed on the display.)
• Red status, with text Ethernet: Ethernet networking is enabled, but 

there is no link.
• Green status, with text Ethernet: Ethernet networking is enabled and 

a link is established.
• Green status, with text Ethernet Off: Ethernet networking is not ena-

bled.
Ethernet configuration options are in the Advanced Configuration > 
Communications page and the Advanced Configuration > 
Communications > Ethernet page.

Waveform images One waveform image for each channel shows the time-series data in 
near-real time.

Table H-1  Status page options (Continued)

Parameter/Widget Description

Table H-2  Waveform page options

Parameter/Widget Description

Time scale Choose the time scale width in seconds.
• Options: 5, 10, 15, 30, 60, 120. Factory default is 30.

Vertical scale Choose the amplitude scale in counts. The setting presently in use is 
shown on the upper right of the waveform. After about 1 minute from 
startup of the Controller, the waveform will show AC RMS and DC 
average. On a single-waveform display, the minimum and maximum 
values of the visible data are also shown as a numeric value.
• Options: Auto (for automatic scaling of each channel independently), 

20e6, 10e6, 1e6, 100e3, 10e3, 1e3, 100, 10, 5, 2). Factory default is 
Auto. 

Pause/Resume Pause the waveform display, or resume a paused waveform. You 
cannot adjust the scale on a paused waveform.

Show One/Show 
Three

View one waveform at a time, or view all channel waveforms 
simultaneously.

 Next Channel View the next channel waveform, if Show One is selected.
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H.4  SOH
The SOH page shows a summary of the Taurus state of health as of the time shown 
(Table H-3). You can download detailed SOH information as .csv files (see Section 
H.6 “Data Availability” on page 181 and Section 11.3.1 “Extract State of Health data 
to a .csv file” on page 116).

H.5  Alerts
The Alerts pages show a list of occurrences such as startups, shutdowns, and major 
errors. Alert messages include the timestamp and a brief description. You can use these 
message timestamps as reference points for searching through log files for events that 
generated an Alert. See also Section 3.8.7 “Alert messages” on page 30.

H.6  Data Availability
The Data Availability pages show graphical and text summaries of data availability. 
There is a graphical summary of the time-series data availability under the appropriate 
tab for a selected month, week, or day. Under the Text tab are text summaries with links 

Waveform images One waveform image for each channel displays data in near-real time.

Table H-2  Waveform page options (Continued)

Parameter/Widget Description

Table H-3  SOH page options

Parameter Description

Temperature Internal temperature of the Taurus in degrees Celsius. Read only.

Battery Voltage The power supply voltage, accurate to ±0.2V. Read only. Battery 
power cutoff options are on the Advanced Configuration > Power 
page.

Serial Current An estimate of the current drawn by a connected serial device. It is 
accurate to about ±15% for currents over 100mA. Read only.

NMXbus Current An estimate of the current at the external NMXbus connector. 
(External NMXbus is not yet supported.) Read only.

Sensor Current An estimate of the current drawn by the connected sensor (for 
sensors that draw more than about 8 mA). It is accurate to about 
±15%. Read only.

Controller Current An estimate of the current drawn by the Taurus controller board. It is 
accurate to about ±15%. Read only.

Digitizer Current An estimate of the current drawn by the Taurus Digitizer board. It is 
accurate to about ±15%. Read only.

External 1 / 2 / 3 / 4 Voltage on the specified External SOH connector. Read only.

Time Last update time of the SOH information. (Controller Time; see Table 
8-1 “Taurus time definitions” on page 79). Read only.
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to detailed availability information for each channel (band) of data. Text summaries are 
available for both time-series and the other data types (such as SOH).

H.6.1   Month

The Data Availability > Month page shows a calendar-view summary of time-series 
data availability for the selected 6-week period. The graphical links at the top of the 
page  scroll the calendar view in 2-week increments back or forward. 
The graphical link for each week  opens the selected Week view. Any 
day for which there are data gaps have a link to the graphical summary for that day. The 
default view shows the current or most recently selected week at the bottom of the cal-
endar. A legend for the colour-coding for Percent Data Available is shown at the bot-
tom of the page. The Refresh link updates the page.

H.6.2   Week

The Data Availability > Week page shows a graphical summary of the time-series data 
availability for each channel for the selected week. The graphical links at the top of the 
page  open the previous and next Week pages. The date links 
open the graphical summary for that day. It defaults to either the current or the most 
recently-selected week, or the last week on the Month calendar view, depending on 
your previous selections. The Refresh link updates the page.

H.6.3   Day

The Data Availability > Day page shows a graphical summary of the time-series data 
availability for each channel for the selected day. The graphical links at the top of the 
page  open the previous and next Day pages. It defaults to either the 
current or the most recently-selected day, or the last day on the Month calendar view, 
depending on your previous selections. The Refresh link updates the page.

H.6.4   Text

There is a Data Availability > Text page for each of Time Series data and Other data. 
These pages show data availability and gap information. A gap can be either a data gap 
(data packets are missing), or a time tear (a time jump with no missing packets; for 
example, caused by a time adjustment after an extended GPS reception outage), or both 
(for example, after the power has been disconnected for an extended period).

H.6.4.1    Time Series

The Data Availability > Text > Time Series page shows a text summary of the available 
time ranges of data for each time series channel (band), the number of data gaps and 
time tears, and the quantity of data as both units of time and as the percentage of space 
used in the Store. The band name links to a page showing details about all gaps for that 
band. The Refresh link updates the page.
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H.6.4.1.1    Time Series band

Each Data Availability > Text > Time Series > band page shows details about availa-
bility for that band. The page shows the quantity of data as the percentage of space used 
in the Store, the available time range of data, the number of gaps (includes both data 
gaps and time tears), and a list of all gaps that exceed the gap tolerance, with the number 
of packets missing (if that information is available), and the gap duration. You can 
select a gap tolerance for this band from the Gap Tolerance drop-down list (options are 
5min, 1min, 30s, 1s, 500ms, none). The Refresh link updates the page, and the All 
Channels link opens the main Time Series page.

H.6.4.2    Other

Other data types include alert, config, log (apollo, DSP, ARM), SOH (ARM, control-
ler), and triggers. The Data Availability > Text > Other page provides a text summary 
of the available time ranges of data for each band of data, the number of data gaps and 
time tears, and the quantity of data as both units of time and as the percentage of space 
used in the Store. The band name links to a page showing details about all gaps for that 
band. The Refresh link updates the page.

H.6.4.2.1    Other band

Each Data Availability > Text > Other > band page shows details about availability for 
that band. The page shows the quantity of data as the percentage of space used in the 
Store, the available time range of data, the number of gaps (includes both data gaps and 
time tears), and a list of all gaps that exceed the gap tolerance, with the number of pack-
ets missing (if that information is available), and the gap duration. You can select a gap 
tolerance for this band from the Gap Tolerance drop-down list (options are 5min, 1min, 
30s, 1s, 500ms, none). The Refresh link updates the page, and the All Channels link 
opens the main Time Series page.

H.7  Data Retrieval
The Data Retrieval pages provide options to extract data from the Store to a file. This 
section provides a brief overview of the Data Retrieval pages. See Chapter 11 “Access-
ing Data” for detailed information and procedures.

One data download can be run at a time. Any subsequent download requests are proc-
essed pending completion of the download in progress. Use the Next button to navigate 
within a download session, to ensure that your choices are preserved.

For all data types, the data retrieved are all of the samples from the specified start time 
up to but not including the sample at the specified end time.

The main Data Retrieval page provides options to choose the type of data to extract to 
a file. Data types include:

Time Series
Time Series By Event
State Of Health
System Logs
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System Configuration

To set options for the download for a new session or new data type, click Next. If any 
data download selections have already been made, a summary of the current choices is 
shown at the bottom of the page (for example, Figure H-1). To set options for a subse-
quent session with the same data type, you may use either the Next button or a Current 
Choices link.

H.7.1   Time Series

The Time Series pages provide options to download recorded data to a file. Options to 
delimit the data are grouped on the corresponding linked pages listed below. See Sec-
tion 11.2.1 “Extract time-series data to a file” on page 109.

Change Data Type: Choose a data type to download.
Change Channel: Choose one or more time-series channels.
Change Time: Choose a start date and time, and a duration.
• Show Available Times: Shows time and gap information for each data band.
Change Format: Choose ASCII, Seisan, or MiniSEED format. The current version 
cannot download more than 488MB of data in MiniSEED format or Seisan for-
mat. Use multiple downloads for quantities of data that exceed 488MB. Mini-
SEED files use a 512 byte Data Record Length. Seisan downloads use a 
conversion tool (Section 11.1.3.3 “Initial setup for extracting to Seisan format” on 
page 108).
Change Station Info: Edit station information for the downloaded data file headers. 
You can change Network Name, Station Name, and Channel Names.
Clear All Choices: Reset all options to the defaults.

Figure H-1  Data Retrieval page showing time-series current choices
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H.7.2   Time Series By Event

The Time Series By Event pages provide options to retrieve data from a Taurus using 
information from an event list. The event list may be a file that you upload to the Tau-
rus, or information for a single event that you enter into a text form. The Taurus calcu-
lates arrival times for various phases that are applicable to the event selected. You may 
then download the data for available events. See Section 11.2.2 “Extract seismic data 
to a file by event from an event list” on page 111.

Options to delimit the data are grouped on the corresponding linked pages listed below.
Change Data Type: Choose a data type to download.
Change Channel: Choose one or more time-series channels.
Change Time: Choose a different start date, time, and duration. (The initial time is 
set automatically on the Change Time By Phase page.)
• Show Available Times: Shows time and gap information for each data band.
Change Time By Phase: Choose a start time and duration automatically using the 
available phase data uploaded with the event.
Change Format: Choose ASCII, Seisan, or MiniSEED format. The current version 
cannot download more than 488MB of data in MiniSEED format or Seisan for-
mat. Use multiple downloads for quantities of data that exceed 488MB. Mini-
SEED files use a 512 byte Data Record Length. Seisan downloads use a 
conversion tool (Section 11.1.3.3 “Initial setup for extracting to Seisan format” on 
page 108).
Change Station Info: Edit station information that will be used in the downloaded 
data file headers. You can change Network Name, Station Name, and Channel 
Names.
Change Event: Choose a different event from the event list. (The page may take a 
minute to load if there is a large list of events.)
Clear All Choices: Reset all options to the defaults, including deleting the 
uploaded event file.

Table H-4  Time Series by Event file upload options

Parameter/Widget Description

File format Choose the type of event list file to upload (click the radio button). 
Each link opens the relevant site search page in a new window.
Options include:
• IRIS Search - ASCII

• http://www.iris.edu/quakes/eventsrch.htm. Do a search, then save 
using the ASCII Version link. Upload the ASCII version to Taurus.

• NEIC Epic Search - Compressed
• http://neic.usgs.gov/neis/epic/. Choose a search type (Global, 

Rectangular, or Circular), then choose '2. Compressed File For-
mat' for the output file type. Save then upload the search to the 
Taurus (as .html).

• NEIC Finger http://neic.usgs.gov/neis/finger/quake.asc. Save the 
document (quake.asc) and upload it to the Taurus.

File upload Browse for or enter the file path and name of the file to upload, then 
click Upload to upload the file.
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H.7.3   State of Health

The State of Health pages provide options to download SOH information from a Store 
to a .csv file. Options to delimit the data are grouped on the corresponding linked 
pages listed below. See also Section 11.3.1 “Extract State of Health data to a .csv file” 
on page 116.

Change Data Type: Choose a data type to download.
Change Time: Choose a start date and time, and a duration.
• Show Available Times: Shows time and gap information for each data band.
Change SOH Data: Choose a different set of SOH data to download.

Predefined sets of some SOH data (Table 11-1 on page 117) are provided in the drop-
down list on the SOH Data page. This is the recommended method for SOH data types 
that are included in a predefined download, as the predefined options include those 
SOH columns in context.

Event list The list of all events from the uploaded file. You may choose an event 
to search for in the Store (click the radio button).

Event form Click the radio button to select the event once you have filled in 
the event form fields.

Text fields are provided for you to enter an event manually:
• Label: The event name, as an ASCII string of any length.
• Time: An ASCII string of the format yyyy-MM-dd HH:mm:ss
• Location/Depth(km):

• lat: Latitude, –90 to +90 degrees.
• lon: Longitude, –180 to +180 degrees.
• depth: Depth in kilometres, integer from 0 to 231 – 1.

Table H-5  Time Series by Event time selection by phase options

Parameter/Widget Description

Pre Event Time Number of seconds of data to download preceding the calculated start 
time.

Start Phase Available phases that you may choose to set a start time 
automatically. Phase options are loaded according to what would be 
available for an event at that location relative to the Taurus location at 
the time the data were recorded.

Post Event Time Number of seconds of data to download following the calculated end 
time.

End Phase Available phases that you may choose to set an end time 
automatically. Phase options are loaded according to what would be 
available for an event at that location relative to the Taurus location at 
the time the data were recorded.

Selected Events Read-only information identifying the selected event.

Table H-4  Time Series by Event file upload options (Continued)

Parameter/Widget Description
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For other SOH data you can download individual columns. The default option (User 
Selected) shown in the drop-down list is used only for selecting individual SOH col-
umns for download. Use the Add/Remove and Move x buttons to populate and sort the 
selected columns. Use this option to download trigger information.

H.7.4   System Logs

The System Logs pages provide options to download all system log data (Apollo, 
ARM, DSP) for the selected time period to a text file. Options to delimit the data are 
grouped on the corresponding linked pages listed below. See also Section 11.3.2 
“Extract system logs to a .log file” on page 119.

Change Data Type: Choose a data type to download.
Change Time: Choose a start date and time, and a duration.
• Show Available Times: Shows time and gap information for each data band.
Clear All Choices: Reset all options to the current defaults.

H.7.5   System Configuration

The System Configuration pages provide options to download the current system con-
figuration information to a text file. This information is an audit trail of all configura-
tion changes, it is not a valid configuration file (see Section 5.5 on page 45 for 
information on downloading and uploading valid configurations). Options to delimit 
the data are grouped on the corresponding linked pages listed below. See also Section 
11.3.3 “Download the configuration audit trail to a .cfg file” on page 119.

Change Data Type: Choose a data type to download.
Change Time: Choose a start date and time, and a duration.
• Show Available Times: Shows time and gap information for this data band.

H.8  Timing
The Timing page includes pages showing the status of the system clock, GPS satellites, 
and a GPS satellites map. You can download timing SOH information as .csv files 
(see Section H.7 “Data Retrieval” on page 183 and Section 11.3.1 “Extract State of 
Health data to a .csv file” on page 116). There is a corresponding Timing status bar 
on the Status page (see the relevant entry in Table H-1 “Status page options” on 
page 177). GPS and timing configuration options are in the Advanced Configuration > 
Timing page (Section H.13.5 on page 198).

H.8.1   Timing

The Timing page shows information about the system clock and GPS receiver status 
(Table H-6).
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H.8.2   GPS Satellites

The GPS Satellites page shows information about each usable GPS satellite (Table H-
7).

Table H-6  Timing status page options

Parameter group Parameter Description

System Clock System 
Time

System time (see Table 8-1 “Taurus time definitions” on 
page 79).

PLL State Phase lock to GPS.

Uncertainty Uncertainty of System Time.

Time Error The amount of time by which System Time differs from 
GPS Time (see also Table 8-1 “Taurus time definitions” 
on page 79).

DAC Count The value used to calculate the time base. Read only.

GPS Engine State The current activity of the GPS receiver (for example, 
searching for usable satellites).

# Satellites The number of usable satellites.

PDOP Position dilution-of-precision. A standard estimate of the 
GPS position precision, based on the geometry of the 
visible satellites. A lower value indicates a more precise 
solution. The GPS receiver will not generate a solution if 
the PDOP is too high.

TDOP Time dilution-of-precision. A standard estimate of the 
GPS time precision, based on the geometry of the visible 
satellites. A lower value indicates a more precise 
solution.

Location Latitude The current latitude of the Taurus.

Longitude The current longitude of the Taurus.

Altitude The current altitude of the Taurus in metres.

Table H-7  GPS Satellites page options

Parameter Description

PRN The PRN (pseudo-random noise) code used to identify each satellite.

Status The tracking status for this satellite.

Elevation The elevation angle of the satellite in degrees. It ranges from 0° to 90° (0° is 
parallel to the surface of the Earth).

Azimuth The azimuth of the satellite in degrees, measured clockwise from true 
North.

Signal The strength of the signal in AMUs (antenna measurement unit, a measure 
of signal to noise ratio; to convert, C/N0 = 27 + 20log10( SNR[ AMUs ] ).

Last Updated The System Time when the GPS receiver last updated the information for a 
specific satellite (see also Table 8-1 “Taurus time definitions” on page 79).
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H.8.3   GPS Map

The GPS Map page provides a visual summary of GPS satellite status and related infor-
mation (Table H-8).

H.9  Sensor
The Sensor page provides sensor control and calibration command options, and status 
indicators (Table H-9). See also Chapter 9 “Controlling and Configuring Sensors”.

Table H-8  GPS Map page options

Parameter/Widget Description

PDOP Position dilution-of-precision (see Table H-6).

TDOP Time dilution-of-precision (see Table H-6)

GPS satellite skyplot A skyplot showing positions of the usable GPS satellites, labelled 
with the PRN codes, and a graph of the received signal strength of 
each satellite in AMUs.

Update Time The System Time when the GPS data (including the GPS time) was 
last updated (see also Table 8-1 “Taurus time definitions” on 
page 79).

GPS State Tracking status of the GPS receiver.

Location The latitude and longitude of the Taurus, and the altitude of the 
Taurus in metres.

Table H-9  Sensor page options

Parameter/Widget Description

Mass Center A function button to send a mass centre command.

Mass – Lock, Unlock Function buttons to lock and unlock sensor masses.

Mass centre images A graphic showing mass centring of each component, with auto-
centre voltage thresholds as configured in the Advanced 
Configuration > Sensor Details > Mass Auto Centering page.

Sensor – On, Off Function buttons to turn power to the sensor on and off.

Sensor power field An estimate of the sensor power consumption in watts, accurate 
to about ±15% for sensors drawing more than about 8mA.

Calibration – Start, Abort Function buttons to send a calibration command, and to abort a 
calibration in progress. Configuration options are in the 
Advanced Configuration > Calibration page.

System Sensitivity System sensitivity in cnt/(m/s) or cnt/(m/s/s). It is calculated 
using the sensor Sensitivity Value from the Advanced 
Configuration > Sensor Details page, and the Digitizer Input 
Range and Software Gain from the Advanced Configuration > 
Digitizer > Front End page. It is expressed in counts per unit of 
velocity or acceleration as appropriate using the selected 
Sensitivity Units on the Advanced Configuration > Sensor Details 
page.
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H.10  Store Tools
The Store Tools page shows information about the active recording medium (IDE drive 
or CF card) and the availability of other media. If you are logged in, it also provides 
media and Store management options (Table H-10). See also Chapter 10 “Recording 
Data”.

H.11  Configuration
The Configuration page provides configuration options that are assumed to be accessed 
more frequently (Table H-11). You must log in as tech or central to use this page. 
Each of the options is also available in the Advanced Configuration pages.

Waveform images A waveform in near-real time for each channel, with scaling 
options and waveform selection options as on the Waveform 
page (see Table H-2 on page 180).

Table H-9  Sensor page options (Continued)

Parameter/Widget Description

Table H-10  Store Tools page options

Parameter/Widget Description

Active Media A read-only identifier of the active media type, either IDE (IDE hard 
drive) or CF (CompactFlash card).

Active Store Size The capacity of the active Store. This is configured at the time the 
Store is created. 

Store Space Used A read-only field showing the amount of space used in the active 
Store.

other medium Available A read-only field that indicates whether an Ext3-formatted 
recording medium is available in the other slot. Options are Yes, 
and “No, or not formatted”.

Switch Media A wizard to switch recording of data onto a Store in the other media 
slot (if available). This does not move existing data between these 
Stores.

Format media A wizard to format the recording medium in the other slot. All data 
and partition information on the medium will be erased.

Reindex Store A wizard to reindex the entire Store on the active medium.

Delete Store A wizard to replace the current Store on the active medium with a 
new Store. All data in the old Store will be erased. 

Table H-11  Configuration page options

Parameter/Widget Description

Running Mode The operating mode of the Taurus, either Buffered or 
Communications. This option is also in the Advanced Configuration > 
General page (Section H.13.1 on page 192).
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H.12  System Info
The System Info pages show the revision information for this Taurus. Click the appro-
priate page link (Firmware or Hardware) to view the information.

Firmware page – Indicates the version of Taurus software that is installed, and the 
version information for each of the firmware components.
In a browser this page also has a link to download the revision information, for 
both the hardware and firmware, as a text file (Section 11.3.4 on page 120).
Hardware page – Shows the serial number and revision information for each of the 
Taurus sub-assemblies.

H.13  Advanced Configuration
The Advanced Configuration page provides links to various configuration sub-pages, 
and options to manage the configuration (Table H-12). Availability of pages depends 
on the level of user access (see Chapter 6 “Configuring Taurus User Access”).

All of the General, Communications, Security, Playback, Timing, Calibration, 
Sensor Details, Digitizer, and Power configuration pages are accessible if you are 
logged in as central.
All configuration pages except the Security page are accessible if you are logged 
in as tech.
No configuration pages are available if you are logged in as user (user access 
does allow access to the Store Tools options).

Output Channels The number of channels, 0 to 3. This option is also in the Advanced 
Configuration > Digitizer > Main page (Section H.13.8.1 on page 202).

Sample Rate The sample rate in samples per second. This option is also in the 
Advanced Configuration > Digitizer > Main page (Section H.13.8.1 on 
page 202).

Table H-11  Configuration page options (Continued)

Parameter/Widget Description

Table H-12  Advanced Configuration page options

Parameter/Widget Description

Hyperlinks Save all changes in a temporary cache and open the linked 
configuration page.

Previous Save all changes in a temporary cache and open the configuration 
page that is at the previous level in the hierarchy.

In a browser always use the Previous button, not the browser’s 
Back button, to preserve unapplied changes when navigating back 
through configuration pages.
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H.13.1   General

The Advanced Configuration > General page provides options to change miscellaneous 
settings (Table H-13).

Apply Apply all changes that have accumulated in the temporary cache, for 
example if you have applied changes from several configuration 
pages. Nothing is applied if an invalid parameter is found.
Applied changes that have not yet been committed are discarded 
when you restart the associated Taurus subsystem (Controller only, or 
any other component; see Section 5.1 “Configuration format and 
storage” on page 43). See Section 5.4.2 “Undo applied changes” on 
page 45 for discarding complex transactions (those that contain many 
applied changes).
Some changes require a commit and restart before they become 
active. If a restart is required, a message will be displayed.

Commit Commit all applied changes, and any subsequent new changes that 
have accumulated in the temporary cache. Committed changes are 
permanent. Commit includes Apply. Nothing is committed if an 
invalid parameter is found.
Some committed changes require a restart before they become 
active. If a restart is required, a message will be displayed.

Reset Discard all unapplied changes from the temporary cache.

Browse This option is available in a browser. Browse for a Taurus 
configuration file on your file system.

Upload This option is available in a browser. Upload and apply the selected 
configuration file to your Taurus. You can upload a partial configuration 
without affecting the rest of the configuration; for example, predefined 
sensor configurations from the /sensors directory. See also see 
Section 5.5.2 “Upload a configuration file to the Taurus” on page 46.

Download This option is available in a browser. Download the configuration from 
your Taurus to your file system. You can upload this configuration to 
other Tauruses.

Table H-12  Advanced Configuration page options (Continued)

Parameter/Widget Description

Table H-13  General page settings

Parameter/Widget Description

UI TimeOut [min] The time delay in minutes before Taurus shuts down the display 
and Interactive mode, and reverts to the configured Running Mode. 
Options are 10, 20, 30, 60, 120. Factory default is 10.
This parameter is overridden by UI activity and data downloads as 
described in Section 3.1.2 “Interactive mode” on page 17.

Apollo Log Verbosity The level of detail of the Apollo log. Options are Info, Verbose, 
Debug (Info is normal operation messages, Debug is all 
messages). Factory default is Info.

Running Mode The operating mode of the Taurus after Interactive mode ends. 
Options are Buffered, and Communications. This option is also in 
the Configuration page.
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H.13.2   Communications

The Advanced Configuration > Communications page provides an option to set the 
Taurus default networking interface, and links to related sub-pages (Table H-14).

H.13.2.1    Ethernet

The Advanced Configuration > Communications > Ethernet page provides options to 
set Ethernet networking parameters (Table H-15). See also Section 7.2 “Communica-
tions over Ethernet” on page 54.

Soh Report Interval [s] The SOH sampling rate in seconds, including some internal SOH 
and the 4 External SOH channels (see also Section 3.8.5.1 on 
page 30). Integer from 5 to 3600. Factory default is 60.

Post Data Interval [ms] Do not change this setting from the factory default (2000ms.)

ARM Log Verbosity The level of detail of the ARM log. Options are Info, Verbose, 
Debug (Info is normal operation messages, Debug is all 
messages). Factory default is Info.

Table H-13  General page settings (Continued)

Parameter/Widget Description

Table H-14  Communications page options

Parameter/Widget Description

Default Interface Specify on which interface the routing gateway is located (Ethernet or 
Serial Port 1). All packets not on an immediate subnet (more than a 
single hop) will be sent to a gateway determined by that interface.
The gateway is configured as an IP address of a machine. The Taurus 
may have multiple gateways configured, and the Default Interface 
specifies which gateway is in effect; only one is allowed.
• Ethernet – The gateway used is the one obtained from the settings 

specified from the Ethernet settings page. 
• Serial Port 1 – The gateway used is the Remote IP Address config-

ured in Serial Port 1. The serial port must be in either SLIP or PPP 
mode for this setting.

Hyperlinks Links to sub-pages Ethernet, Data Streaming, Serial Port 1, Serial 
Port 2, and Discovery. (See Table H-12 on page 191 for a description 
of hyperlink behaviour on configuration pages.)

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-15  Ethernet page options

Parameter/Widget Description

Mode The method Taurus will use to acquire an IP address. Options 
include DHCP, Link-Local, Static IP, and None (disable Ethernet). 
Factory default is DHCP.

Static IP Address The IP address assigned to the Taurus, applicable only if Mode is 
set to Static IP. Factory default is 127.0.0.1.
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H.13.2.2    Data Streaming

The Advanced Configuration > Communications > Data Streaming page provides 
options for streaming data from Taurus (Table H-16). See also Section 11.2.3 “Stream 
time-series data to a central acquisition server” on page 115.

H.13.2.3    Serial Port 1

The Advanced Configuration > Communications > Serial Port 1 page provides options 
to set the serial communication protocol and has links to related sub-pages (Table H-
17). See also Section 7.3 “Communications over serial” on page 55.

Static Subnet Mask The network mask for the Taurus Static IP Address. Factory default 
is 255.255.255.0.

Static Default Gateway The default gateway address for Static IP.

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

Table H-15  Ethernet page options (Continued)

Parameter/Widget Description

Table H-16  Data Streaming page options

Parameter/Widget Description

Stream NP Packets Set Taurus to stream data to a specified data acquisition server 
(NAQS, Apollo) at the specified IP address and Port number. Options 
are enabled , not enabled . Factory default is not enabled.
It is not enabled if Running Mode is set to Buffered (set in either the 
Configuration page or the Advanced Configuration > General page).

IP Address The address of the destination server; a valid IP address in dotted 
decimal format. The destination IP address can be either a multicast 
address or a unicast address.

Port # The port number used for NpToNmxp. Factory default is 32004.

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-17  Serial Port 1 page options

Parameter/Widget Description

Mode Choose the serial port protocol. Options are Raw, SLIP, PPP. Factory 
default is Raw.

Hyperlinks Links to sub-pages SLIP, Raw, PPP, and TDMA. (See Table H-12 on 
page 191 for a description of hyperlink behaviour on configuration 
pages.)

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.
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H.13.2.3.1    SLIP

The Advanced Configuration > Communications > Serial Port 1 > SLIP page provides 
options to set up a SLIP connection for streaming data (Table H-18).

H.13.2.3.2    Raw

The Advanced Configuration > Communications > Serial Port 1 > Raw page provides 
the option to choose the transmission rate between Taurus and a connected serial 
device. Options are 9600, 14400, 19200, 38400, 57600; factory default is 9600. See 
Table H-12 on page 191 for a description of the Apply, Commit, Reset, and Previous 
buttons.

H.13.2.3.3    PPP

The Advanced Configuration > Communications > Serial Port 1 > PPP page provides 
options to set up a PPP connection for streaming data (Table H-19).

Table H-18  SLIP page options

Parameter/Widget Description

Speed [bps] The data rate for SLIP mode. Options are 9600, 14400, 19200, 38400, 
57600. Factory default is 9600.

Protocol Protocol options include SLIP, and CSLIP (compressed for lower 
bandwidth usage).

Local IP The IP address of the local (Taurus) SLIP interface.

Remote IP The IP address of the remote SLIP interface.

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-19  PPP page options

Parameter/Widget Description

Speed [bps] The date rate for PPP mode. 9600, 14400, 19200, 38400, 57600. 
Factory default is 9600.

Local IP IP address for the local PPP interface in dotted decimal format (for 
example, 10.0.0.1).

Remote IP IP address for the remote PPP interface in dotted decimal format 
(for example, 10.0.0.1).

Connection Type Specifies the nature of the connection. Options are direct, and 
dial-in. Direct is a direct connection to the Taurus via a serial cable 
or a transparent serial modem line. For dial-in, the Taurus accepts 
a PPP connection request from a client using a dial-up modem.

Modem init string The modem initialization string for dial-in (for example, 
AT&F1 OK). Factory default is empty.

Extra modem init string An additional modem initialization string for dial-in (for example, 
ATS0=0 OK). Factory default is empty.

Authentication Indicates if authentication is required from the PPP client. Factory 
default is enabled (authentication required).
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H.13.2.3.4    TDMA

The Advanced Configuration > Communications > Serial Port 1 > TDMA page pro-
vides options to set up time slot access for this Taurus to a SLIP link (Table H-20).

H.13.2.4    Serial Port 2

The Advanced Configuration > Communications > Serial Port 2 page provides the 
option to choose the transmission rate between Taurus and a connected serial device. 
Options are 9600, 14400, 19200, 38400, 57600; factory default is 9600. See Table H-
12 on page 191 for a description of the Apply, Commit, Reset, and Previous buttons.

H.13.2.5    Discovery

The Advanced Configuration > Communications > Discovery page provides options to 
set Taurus to broadcast its presence to other devices on the network that are running 
Apollo (Table H-21; see also Section 7.5 on page 69).

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

Table H-19  PPP page options (Continued)

Parameter/Widget Description

Table H-20  TDMA page options

Parameter/Widget Description

Enable TDMA Set whether to use TDMA. When TDMA is enabled, Taurus will send 
data to Serial Port 1 only during the defined time slot. When TDMA is 
not enabled, data are sent immediately when the line is idle. Options 
are enabled , not enabled . Factory default is not enabled.

Frame Length [ms] The TDMA frame length in milliseconds. Frame length must be set to 
the same value for the devices sharing the link (for example, a Janus 
Port n-Taurus pair). Integer from 1000 to 10000. Factory default is 
4000.

Slot Start [%] The Taurus TDMA slot start position as a percentage of the entire 
frame. Integer from 0 to 99. Factory default is 0.
Slot Start plus Slot Duration must be less than or equal to 100.

Slot Duration [%] The Taurus TDMA slot duration as a percentage of the entire frame. 
Integer from 1 to 99. Factory default is 80.
Slot Duration plus Slot Start must be less than or equal to 100.
The minimum slot size is determined by the largest frame that can be 
transmitted over the serial link (Section 7.3.5.1.1 on page 62).

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.
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H.13.3   Security

The Advanced Configuration > Security page provides two authentication options for 
logging in via the display (Table H-22). You can access this page only if you are logged 
in as central. See also Chapter 6 “Configuring Taurus User Access”.

H.13.4   Playback

The Advanced Configuration > Playback page provides options to identifying informa-
tion about this Taurus to be used in downloaded data files (Table H-23). See also Sec-
tion 11.1.3.2 “Confirm Playback settings” on page 107.

Table H-21  Discovery page options

Parameter/Widget Description

Enable Discovery Set Taurus to send out identification messages to other devices on the 
network that are running Apollo. Options are enabled , not 
enabled . Factory default is enabled.

IP Address A valid multicast IP address (the first octet must be between 224 and 
240, inclusive; each of the last three octets can be any positive integer 
from 0 to 255). Factory default is 224.199.71.138.

Port # The port number to listen on for Discovery broadcasts from Taurus. 
Factory default is 6776.

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-22  Security page options

Parameter/Widget Description

Local Authentication Determines the type of authentication that can be used for logging in 
via the display. Options are Standard, Quick Login. Factory default is 
Standard. See also Section 6.1.1.2 “Quick login” on page 49.

Login Account Indicates which account will be used for Quick Login. Options are 
user, tech, central. Factory default is user.

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-23  Playback page options

Parameter/Widget Description

Network Name The network name or code. Alphanumeric value.

Station Name The station name for this Taurus. Alphanumeric value (for example, 
TAU0105 for Taurus serial number 0105).

Channel n Name The channel name for each of the time-series data channels. 
Alphanumeric value (for example, BHZ, BHN, BHE).

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.
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H.13.5   Timing configuration

The Advanced Configuration > Timing page provides options to set basic timing 
parameters (Table H-24). See also Section 8.2 “Configuring Taurus timing” on 
page 78.

H.13.6   Calibration

The Advanced Configuration > Calibration page provides the sensor calibration con-
figuration options listed in Table H-25. See also Section 9.3 “Configuring calibration” 
on page 91.

Table H-24  Timing configuration page options

Parameter/Widget Description

GPS Duty Cycle Mode The GPS receiver duty cycle. Options are Always On, 
Automatic, Every 10 minutes, Every 30 minutes, Always Off. 
Factory default is Automatic. Automatic is the most efficient 
setting for Taurus power consumption.

Do not use the Always Off setting.

Correction Mode Sample timing correction method. Options include Gradual 
Drift, No Alignment. Factory default is No Alignment.

Digitizing Needs GPS Lock Defines whether GPS lock is required before the Taurus starts 
digitizing on startup. Options are enabled , not enabled . 
Factory default is not enabled.

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

Table H-25  Calibration page options

Parameter/Widget Description

Calibration Type The type of calibration signal to use. Options are Sine, Pulse, PRB. 
Factory default is Sine.

Channel n Choose whether to enable this channel for calibration. Options are 
enabled , not enabled . Factory default is enabled.

Attenuation Attenuate the calibration signal by the specified value. Options are 1, 
10, 100, 1000. Factory default is 1.

Amplitude Set the calibration signal amplitude (in the appropriate Calibration 
Mode units, volts or amperes, as set in the Advanced Configuration > 
Sensor Details page). Float number. Factory default is 0.1.
This parameter will accept calibration signal amplitudes up to 5.0V or 
60mA, depending on the Calibration Mode (VOLTAGE or 
CURRENT). If taken as a single-ended output (for example, between 
pin N (SEN_CAL1+) and pin V (DGND), the calibration circuit can 
provide a signal with a maximum amplitude of 4.5V.

Wait Time The length of time in seconds after the calibration coil has been 
enabled before sending the calibration signal. Options are 0, 15, 30, 
60, 120, 300, 600, 1200. Factory default is 0.
Taurus Portable Seismograph
User Guide198 15148R5

2007-02-09



Appendix H: UI Pages and Parameters
H.13.7   Sensor Details

The Advanced Configuration > Sensor Details page provides options to edit and save 
basic sensor settings, and provides links to related pages (Table H-26). See also Section 
9.2 “Sensor configuration” on page 85.

Ramp Duration The length of time in seconds to bring the signal amplitude up to the 
configured amplitude and down from the configured amplitude. 
Options are 0, 10, 30, 60, 120, 600, 1800, 3600. Factory default is 0.

Duration The length of time in seconds to generate the calibration signal at the 
configured amplitude between ramps. Options are 10, 60, 300, 600, 
1800, 3600, 7200, 18000, 36000, 72000. Factory default is 60.

Sine Frequency [Hz] The sine signal frequency in hertz. Float number from 0.01000 to 
50.0000. Factory default is 1.0.

Pulse Duration The pulse signal segment width in milliseconds. Options are 100, 
1000, 10000. Factory default is 1000.

PRB Pulse Width The PRB signal unit pulse width in milliseconds. Options are 10, 20, 
50, 100, 200, 500, 1000, 2000, 5000, 10000. Factory default is 1000.

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-25  Calibration page options (Continued)

Parameter/Widget Description

Table H-26  Sensor Details page options

Parameter/Widget Description

Sensor Lists the types of sensors and their associated configurations 
currently saved to the Taurus. Factory default is Nanometrics 
Trillium 40.

Add Add a sensor type to the list. You can store up to 4 sensor 
configurations. 

Del Delete a sensor type and its associated configuration from the 
Taurus. You cannot delete an item if it is the only item in the list.

Sensor Name The label for this configuration used in the Sensor drop-down list. 
Alphanumeric value.

SP/LP Mode Choose the operating mode of the sensor, either short period 
(SP) or long period (LP). Factory default is LP.

XYZ/UVW Mode The orientation of the sensor elements. Choose Set to UVW to 
indicate a triaxial seismometer (this will run the calibration on 
each channel separately). Options are XYZ, UVW. Factory 
default is XYZ.

Calibration Mode The calibration signal mode; refer to your sensor manual. 
Options are VOLTAGE, CURRENT. Factory default is VOLTAGE.

Needs Power Indicates whether the sensor needs power (active sensors) or 
not (passive sensors). Options are enabled , not enabled .

Detect Sensor Presence This feature works only for sensors drawing more than about 
8mA.
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H.13.7.1    Sensor Control Lines

The Advanced Configuration > Sensor Details > Sensor Control Lines page provides 
options to set control line parameters for your sensor. Factory default values are for a 
Trillium 40 seismometer. Refer to your sensor manual for appropriate values. 

Sensitivity Units Refer to your sensor manual for the appropriate value. Options 
are V/(m/s), V/(m/s/s).

Sensitivity Value Refer to your sensor manual for this value.

Hyperlinks Links to sub-pages Sensor Control Lines, and Mass Auto-
Centering. (See Table H-12 on page 191 for a description of 
hyperlink behaviour on configuration pages.)

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

Table H-26  Sensor Details page options (Continued)

Parameter/Widget Description

Table H-27  Sensor Control Lines page options

Parameter/Widget Description

Sensor Lists the types of sensors and their associated configurations 
currently saved to the Taurus.

Add Add a sensor type to the list. You can store up to 4 sensor 
configurations.

Del Delete a sensor type and its associated configuration from the 
Taurus. You cannot delete an item if it is the only item in the list.

Assert (On) Level Assert line level; HIGH_Z, ZERO, POSITIVE. Factory default is 
ZERO.

Deassert (Off) Level Deassert line level; HIGH_Z, ZERO, POSITIVE. Factory default is 
ZERO.

Positive Voltage Level Positive voltage level; PLUS_5, PLUS_12. Factory default is 
PLUS_5.

Pulse Duration [s] Control pulse duration in seconds; 1, 3, 5, 7, 10, 15, 20. Factory 
default is 1.

Ctrl Line 1 (pin H) Control line options include Unused Assert, Unused Deassert, Ch 1 
Cal Enable, Ch 2 Cal Enable, Ch 3 Cal Enable, SP/LP On=SP, 
SP/LP On=LP, XYZ/UVW On=XYZ, XYZ/UVW On=UVW, Mass 
Center, Mass Lock, Mass Unlock. Factory default is XYZ/UVW 
On=UVW.

Ctrl Line 2 (pin W) Control line options include Unused Assert, Unused Deassert, Ch 1 
Cal Enable, Ch 2 Cal Enable, Ch 3 Cal Enable, SP/LP On=SP, 
SP/LP On=LP, XYZ/UVW On=XYZ, XYZ/UVW On=UVW, Mass 
Center, Mass Lock, Mass Unlock. Factory default is SP/LP On=SP.

Ctrl Line 3 (pin G) Control line options include Unused Assert, Unused Deassert, Ch 1 
Cal Enable, Ch 2 Cal Enable, Ch 3 Cal Enable, SP/LP On=SP, 
SP/LP On=LP, XYZ/UVW On=XYZ, XYZ/UVW On=UVW, Mass 
Center, Mass Lock, Mass Unlock. Factory default is Unused 
Deassert.
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H.13.7.2    Mass Auto-Centering

The Advanced Configuration > Sensor Details > Mass Auto-Centering page provides 
options to initiate mass centring automatically when the mass positions exceed config-
urable thresholds for sensors with that capability (Table H-28). The Sensor page shows 
mass position status (Section H.9 on page 189).

Ctrl Line 4 (pin Z) Control line options include Unused Assert, Unused Deassert, Ch 1 
Cal Enable, Ch 2 Cal Enable, Ch 3 Cal Enable, SP/LP On=SP, 
SP/LP On=LP, XYZ/UVW On=XYZ, XYZ/UVW On=UVW, Mass 
Center, Mass Lock, Mass Unlock. Factory default is Ch 1 Cal 
Enable.
• If you have configured calibration for current mode (Calibration 

Mode on the Sensor Details page), this control line will not be 
available for any other configuration option. It will be reserved for 
calibration current return.

Ctrl Line 5 (pin c) Control line options include Unused Assert, Unused Deassert, Ch 1 
Cal Enable, Ch 2 Cal Enable, Ch 3 Cal Enable, SP/LP On=SP, 
SP/LP On=LP, XYZ/UVW On=XYZ, XYZ/UVW On=UVW, Mass 
Center, Mass Lock, Mass Unlock. Factory default is Ch 2 Cal 
Enable.
• If you have configured calibration for current mode (Calibration 

Mode on the Sensor Details page), this control line will not be 
available for any other configuration option. It will be reserved for 
calibration current return.

Ctrl Line 6 (pin Y) Control line options include Unused Assert, Unused Deassert, Ch 1 
Cal Enable, Ch 2 Cal Enable, Ch 3 Cal Enable, SP/LP On=SP, 
SP/LP On=LP, XYZ/UVW On=XYZ, XYZ/UVW On=UVW, Mass 
Center, Mass Lock, Mass Unlock. Factory default is Ch 3 Cal 
Enable.
• If you have configured calibration for current mode (Calibration 

Mode on the Sensor Details page), this control line will not be 
available for any other configuration option. It will be reserved for 
calibration current return.

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

Table H-27  Sensor Control Lines page options (Continued)

Parameter/Widget Description

Table H-28  Mass Auto-Centering page options

Parameter/Widget Description

Sensor Lists the types of sensors and their associated configurations 
currently saved to the Taurus. Factory default is Trillium 40.

Add Add a sensor type to the list. You can store up to 4 sensor 
configurations.

Del Delete a sensor type and its associated configuration from the 
Taurus. You cannot delete an item if it is the only item in the list.
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H.13.8   Digitizer

The Advanced Configuration > Digitizer page provides links to the relevant sub-pages 
(Table H-29). See also Chapter 8 “Configuring the Digitizer and Timing”.

H.13.8.1    Main

The Advanced Configuration > Digitizer > Main page provides options to set the main 
parameters for the Digitizer (Table H-30). See also Section 8.1.1 “Main settings” on 
page 71.

Red Threshold [V] The minimum voltage level to indicate that the mass position is 
out of range. One minute after this level is crossed for any 
sensing element, mass centring is initiated. Threshold range is 
from negative to positive, for example 1 indicates –1 to +1. Float 
number 0.001 or higher, and greater than Yellow Threshold (if 
used). Factory default is 1.000000.

Auto-Center on Red Initiate mass centring if the Red Threshold is crossed. Options 
are enabled , not enabled . Factory default is not enabled.

Yellow Threshold [V] The minimum voltage level to indicate that the mass position is 
marginal. After Yellow Holdoff Time has expired, mass centring is 
initiated. Threshold range is from negative to positive, for 
example 1 indicates –1 to +1. Float number 0.001 or higher, and 
lower than Red Threshold (if used). Factory default is 1.000000.

Auto-Center on Yellow Initiate mass centring if the Yellow Holdoff Time has expired. 
Options are enabled , not enabled . Factory default is not 
enabled.

Yellow Holdoff Time [h] The number of hours to wait while any mass position voltage is 
higher than the Yellow Threshold (but lower than the Red 
Threshold) before initiating mass centring. Float number from 0.1 
to 72.

Retries per Auto-Center The maximum number of attempts to make to center the masses. 
Integer from 0 to 20. Factory default is 0.

Retry Interval [min] The number of minutes to wait between auto-center retries. 
Integer from 1 to 20. Factory default is 1.

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

Table H-28  Mass Auto-Centering page options (Continued)

Parameter/Widget Description

Table H-29  Digitizer page options

Widget Description

Hyperlinks Links to sub-pages Main, Front End, and Triggers. (See Table H-12 on 
page 191 for a description of hyperlink behaviour on configuration 
pages.)

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.
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H.13.8.2    Front End

The Advanced Configuration > Digitizer > Main page provides options to set the front 
end parameters for the Digitizer (Table H-31). See also Section 8.1.2 “Front End set-
tings” on page 72.

Table H-30  Main page options

Parameter/Widget Description

Sample Rate [Hz] The sample rate in hertz on the sensor signal. Options are 10, 
20, 40, 50, 80, 100, 120, 200, 250, 500. 500sps is not supported 
in Buffered mode. Factory default is 100.
Note that valid value ranges for some of the trigger parameters 
depend on the sample rate, therefore some sample rates may be 
incompatible with your current trigger settings. See also Section 
8.1.3 “Triggers settings” on page 75, Table H-33 “Input Filter 
page options” on page 204, and Table H-34 “Detector page 
options” on page 205.

Output Channels The number of output channels. Options are 0, 1, 2, 3. Factory 
default is 3.

Enable DC Removal Set whether the DC removal filter is used on data. Options are 
enabled , not enabled . Factory default is not enabled.

DC Removal Cutoff [Hz] The corner frequency of the DC removal filter in hertz. Float 
number between 0.001 and 1.0. Factory default is 0.001.

Frames Per Packet The number of standard SEED frames per packet for 
transmission of time-series data. Options are 3, 7. Factory default 
is 7.

Sample Alignment Sample alignment after a time error correction. Options are UTC, 
None, HRD. Factory default is UTC.

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

Table H-31  Front End page options

Parameter/Widget Description

Input Range The voltage range for the sensor input in volts peak-to-peak. The 
input voltage ranges represent the differential between the positive 
and negative signal inputs. Options are 40, 16, 8, 4, 2. Factory default 
is 40.

Input Impedance Options are Low Impedance, High Impedance (low power), High 
Impedance (high power). Low impedance is 43.07kΩ ± 0.2%, high 
impedance is >9MΩ. Factory default is Low Impedance.
Either Low Power or High Power mode can be used with High 
Impedance mode for all values of Input Range except 40Vpp, for 
which the Low Power setting is not applicable.
See also Section 8.1.2.2 “Input Impedance and common mode range” 
on page 74.
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H.13.8.3    Triggers

The Advanced Configuration > Digitizer > Triggers page provides options to select 
channels to use triggers, and links to the relevant sub-pages (Table H-32). Trigger 
information can be extracted to a .csv file (Section 11.3.1.1 on page 118). See also 
Section 8.1.3 “Triggers settings” on page 75.

H.13.8.3.1    Input Filter

The Advanced Configuration > Digitizer > Triggers > Input Filter page provides 
options to set the filter (Table H-33). This is used for all detectors.

Enable Dither Adds a very small random signal to the input signal of the Digitizer to 
eliminate idle tones. Options are enabled , not enabled . Factory 
default is not enabled.

Software Gain Set the Digitizer gain, to attenuate or amplify the sensor input signal to 
a level that will optimize use of the Digitizer dynamic range. Float 
number 0.001 to 100. Factory default is 1.

Enable Hard Clip Limits the output samples of the Digitizer to the specified limits. 
Options are enabled , not enabled . Factory default is not 
enabled.

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-31  Front End page options (Continued)

Parameter/Widget Description

Table H-32  Triggers page options

Widget Description

Enable channel n Select one or more channels to use triggers. Configure the triggers in 
the related sub-pages. Options are enabled , not enabled . Factory 
default is not enabled.

Hyperlinks Links to sub-pages Input Filter, Detector 1, Detector 2, and Detector 3. 
(See Table H-12 on page 191 for a description of hyperlink behaviour on 
configuration pages.)

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-33  Input Filter page options

Parameter/Widget Description

High Pass Order The order of the high pass filter. Integer from 0 to 5. Factory 
default is 0.

High Pass Frequency [Hz] The 3dB corner frequency in hertz of the high pass filter. Float 

number where . Factory 

default is 0.001.

0.000001 f
sampleRate
------------------------------- 0.499999< <
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H.13.8.3.2    Detectors

The Advanced Configuration > Digitizer > Triggers > Detector n page provides options 
to set the detector for the corresponding channel (Table H-34).

H.13.9   Power

The Advanced Configuration > Power page provides options to configure power sup-
ply parameters such as voltage disconnect levels (Table H-35). See also Section 4.4 
“Configuring power manager settings” on page 40.

Factory default values are for 12V lead-acid batteries. To protect your equipment, 
confirm the appropriate values for your power system and the maximum voltage 
tolerance of your sensor before setting these parameters.

Low Pass Order The order of the low pass filter. Integer from 0 to 5. Factory 
default is 0.

Low Pass Frequency [Hz] The 3dB corner frequency of the low pass filter. Float number 

where . Factory default is 

1.0.

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

Table H-33  Input Filter page options (Continued)

Parameter/Widget Description

0.000001 f
sampleRate
------------------------------- 0.499999< <

Table H-34  Detector page options

Parameter/Widget Description

STA Time constant [s] The short term time constant (TC) in seconds. Float number where 

. Factory default is 1.

LTA Time constant [s] The long term time constant (TC) in seconds. Float number where 

. Factory default is 5.

Trigger On Ratio The STA/LTA at which a trigger is written to the Store. Float number, 
where 0 < Trigger Off ratio < Trigger On ratio. Factory default is 5.

Trigger Off Ratio The STA/LTA at which a trigger ends. Float number, where 0 < 
Trigger Off ratio < Trigger On ratio. Factory default is 1.

Maximum Duration [s] A duration in seconds at which to end a trigger that has not yet 
reached the Trigger Off Ratio. Float number from 0.001 to 3600. 
Factory default is 3600.

Latch LTA Freeze the LTA at the value it had when the trigger started. Options 
are enabled , not enabled . Factory default is not enabled.

Function buttons See Table H-12 on page 191 for a description of the Apply, 
Commit, Reset, and Previous buttons.

0.000001

1
2π TC⋅
------------------⎝ ⎠

⎛ ⎞

sampleRate
------------------------------- 0.499999< <

0.000001

1
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H.14  Upgrade
For Taurus firmware version 2.x and higher, there is a firmware Upgrade page that pro-
vides options as listed in Table H-36. See also Section G.2 “Upgrading Taurus from 
Version 2.00.xx or higher” on page 172. You must be logged in as central to use 
this page.

Table H-35  Power page options

Parameter/Widget Description

Battery Low [mV] Battery low voltage threshold in millivolts. Integer from 9000 to 
36000. Factory default is 10500. See also Section 4.3.3.2 “Bypass 
the Battery Low/High voltage disconnect settings on startup” on 
page 39.
This field will accept values slightly outside the recommended range.

Ensure that the value you have entered is between 9000 and 
36000.

Hysteresis Low [mV] Battery Low turn-on level in millivolts. Integer within the range 
Battery High and Battery Low. Factory default is 11800.

Delay Low [ms] Battery low reaction delay factor in milliseconds. Integer from 0 to 
300. Factory default is 30.

Battery High [mV] Battery high voltage threshold in millivolts. Integer from 9000 to 
36000. Factory default is 36000.
This field will accept values slightly outside the recommended range.

Ensure that the value you have entered is between 9000 and 
36000.

Hysteresis High [mV] Battery High turn-on level in millivolts. Integer within the range 
Battery High and Battery Low. Factory default is 35000.

Delay High [ms] Battery high reaction delay factor in milliseconds. Integer from 0 to 
300. Factory default is 2.

Function buttons See Table H-12 on page 191 for a description of the Apply, Commit, 
Reset, and Previous buttons.

Table H-36  Upgrade page options

Parameter/Widget Description

Browse This option is only available from a browser. Browse your file system 
for a Taurus upgrade file (taurus-release-x.tgz).

Upload This option is only available from a browser. Transfer the selected 
taurus-release-x.tgz to the Taurus.

Install Install the selected Taurus version and run it in test mode.

Delete Delete the installation files for the selected Taurus version.

Commit Set the currently running firmware as default.

Revert Reboot the Taurus and run the default version of the firmware.

Active Version A read-only indicator of the currently running version of the firmware.

Default Version A read-only indicator of the default version of the firmware.
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H.15  Log In/Log Off
The Log In/Log Off pages provide options for you to log in to the Taurus with different 
levels of user access, and to change passwords (Table H-37 and Table H-38). See also 
Chapter 6 “Configuring Taurus User Access”.

H.15.1   Change Password

The Log In > Change Password page provides options for you to set a new password 
for any of the user accounts (Table H-39).

Table H-37  Log In page options

Parameter/Widget Description

UserId User account to log in under. Options are user, tech, central. 

Password The password for the specified UserID. Factory defaults are user, 
tech, and central.

Log In as account Log in using the display without having to enter the Password (but 
choose the correct UserID from the drop-down list first). It is available 
if the Taurus has been configured for Quick Login.

Log In Log in using the specified UserId and Password.

Reset Clears all existing entries on the current page.

Change Password This link opens the Change Password page (see Section H.15.1).

Table H-38  Log Off page options

Parameter/Widget Description

Log Off Click Log Off to exit the current session. To exit this page without 
logging off, choose any other page option from the main menu. You 
can continue working in the current session.

Table H-39  Change Password page options

Parameter/Widget Description

UserId A text field to enter the UserID for which to change password.

Current Password A text field to enter the current password for the specified UserId.

New Password A text field to enter the new password. The password must be at least 
4 alphanumeric characters long. It is case-sensitive.

Verify New 
Password

A text field to retype New Password, as confirmation.

Change Password Saves the New Password and logs you in to that account.

Reset Click to clear all field entries (applicable only if you have not yet 
clicked Change Password).
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H.16  Shutdown
The Shutdown page provides options for you to safely shut down the Taurus Controller 
(Table H-40). See also Section 3.3 “Starting up and shutting down the Taurus” on 
page 19.

Table H-40  Shutdown page options

Widget Description

Turn Off Display Use this option to turn off Interactive mode without waiting for the UI 
timeout, for example to conserve power once you have finished using the 
display. The Taurus continues to record data in its configured running 
mode (either Buffered or Communications).

If you use Turn Off Display in a browser, do not refresh the old 
browser window after the Controller has been restarted as this will 
resubmit the turn off display command.

Restart Use this option to restart the Controller (referred to as the PPC on the 
Shutdown page), for example to activate any committed configuration 
changes that require a reboot to take effect. The Digitizer continues to 
run and buffer data during a restart so no data are lost.

If you use Restart in a browser, do not refresh the old browser win-
dow after the Controller has been restarted as this will resubmit the 
restart command.

Shutdown Use this option before you remove or insert recording media, or before 
you disconnect the power. It powers down the Controller gracefully while 
the Taurus continues to buffer data.

If you use Shutdown in a browser, do not refresh the old browser 
window after the Controller has been restarted as this will resubmit 
the shutdown command.
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